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 Computing is an exciting, learner-centred 
course specifically developed in accordance with 
the new Standards-based curriculum by the National 
Council for Curriculum and Assessment (NaCCA). The 
course provides a solid foundation for the development 
of Computing skills in everyday life. This prepares 
learners to be active and successful citizens in the 
workplace, once they leave school.

 Computing Primary provides a broad 
perspective on the necessary knowledge and practical 
skills related to using a variety of technologies in 
everyday life. The book guides development in areas 
such as Information Communication Skills (ICT) 
literacy, effective communication using digital tools, 
internet usage, ethical use of ICT tools and basic 
programming and database skills. 

Avai lable 
digi ta l ly !

Each Learner’s Book 
comes with a FREE 
digital edition of the 
book. The code for the 
digital edition appears on 
the inside front cover of 
the book and provides 
access for one year.

 

Important features of  Computing Primary 6 
Learner’s Book:
•	 Careful development of theoretical and practical 

activities in the use of a computer for 
	 -	 presentation
	 -	 word processing
•	 Clear screenshots and step-by-step instructions on 

how to complete computing tasks 
•	 Complete coverage of the core curriculum 

competencies such as problem-solving, innovation, 
collaboration, global citizenship, personal 
development and digital literacy

•	 Plenty of activities so that learners can apply the 
skills they have acquired

•	 Regular assessments, with marks, that can be done 
on a weekly, fortnightly or monthly basis.

Features of  Computing Primary 6 
Teacher’s Guide:
•	 Clear teaching guidelines, including planning notes, 

for all the content in the curriculum
•	 Downloadable content with all the files needed for 

learners to complete the activities available from 
Cambridge GO at https://www.cambridge.org/go/, 
plus

	 -	 additional PowerPoint files introducing topics 
	 -	 printable worksheets for enrichment activities 
•	 Memoranda for activities that can be used  

for continuous assessment during the year
•	 Extension activities to challenge learners who have 

quickly grasped the skills taught in each topic
•	 Guidance for teachers in low-resourced schools.

, your guarantee of success!
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How to use this Teacher’s Guide
This Teacher’s Guide provides basic and practical ways to teach key tasks required by the Computing 
Curriculum for Primary Schools. It closely follows the curriculum requirements and outcomes, tying to the 
strands, sub-strands and performance indicators. Additional resources are available from Cambridge GO 
with additional printable worksheets and PowerPoint presentations that can be used on a projector in your 
classroom or printed out. The downloadable content accompanying the Teacher's Guide is available from 
Cambridge GO at https://www.cambridge.org/go/. Also included is additional content specifically for the 
teacher – an e-book providing guidance on how to Integrate ICT in the classroom and a handy reference of 
key concepts in Computing and the fourth Industrial Revolution.

In this Teacher’s Guide for Basic 4, you can expect to find teaching skills that focus on high levels of 
engagement for learners through active learning styles, such as teach-backs, learner group presentations, 
learner self-assessment and peer-assessment activities, including many opportunities for small group or 
pair discussions and evaluations with constructive feedback to each other. Many of these pedagogical 
approaches require the teacher to act as a facilitator who skilfully guides the learning process by employing 
targeted questions at appropriate times to encourage learners to think deeply on the more difficult or 
complex concepts and content. The scaffolding provided in the worksheets and activities is underpinned by 
Bloom’s taxonomy. Additional 21st-century pedagogical approaches, such as the ‘flipped classroom’, ‘CLIL’ 
and ‘task study’, have not been explored as methodologies in this book, but are ideas that teachers might 
wish to explore to enhance learner engagement and understanding of the concepts and content provided in 
the Learner’s Book.

In the Learner’s Book, the ‘Contents page’ section indicates the number of strands and the main topics in 
each strand. The ‘Introduction’ at the beginning of each strand lists the information covered in that strand. The 
‘Revision’ section at the end of each strand comprises a ‘Check your progress’ section that covers questions 
relating to the whole strand. These could be used in a variety of ways that might assist in task preparation.

Tasks
Tasks provide a guide to teachers on how a concept or activity required by the curriculum could be taught. 
These will prove invaluable for teachers new to the subject. Tasks are numbered for each strand, starting 
from number 1. Teachers will need to adjust the amount of time they could spend on each strand based on 
the number of tasks per academic year. Some content, concepts or practical tasks may require slightly more 
time than might be available in a task and it is left to the discretion and professionalism of the teacher to 
allocate how much time they believe learners of different abilities may require to master the more difficult 
content and concepts.

The ‘Content standard’ states the specific skills that learners should master and is linked to the 
corresponding sub-strand. Each sub-strand and its related ‘Content standard’ is accompanied by a set of 
indicators, which are different for each task.

Each ‘Indicator’ is linked to ‘Performance indicators’ for all the ability groups that teachers may have to cater 
for in each teaching group. Differentiation is considered at the level of the expected outcomes expressed in 
the performance indicators for each task as follows: 
•	 ‘ALL’ refers to the majority of learners, and the expected skills will be commensurate with the lower levels 

in Bloom’s taxonomy, such as recall and comprehension.
•	 ‘SOME’ refers to the more able learners or, in some cases, the less able learners, depending on what the 

performance indicator stipulates. Learners in this group should be able to do slightly more or less than the 
majority of learners and be able to analyse or interpret the more difficult concepts and content.

•	 ‘FEW’ refers to the most able learners who could be expected to do the higher-order thinking skills 
according to Bloom’s taxonomy, such as evaluating and synthesis.

The ‘Core competencies’ indicate the broad areas of the curriculum that are considered in each task. They lend 
themselves to broad interpretation in the way teachers facilitate the learning and the way learners engage 
in their learning process. Tasks tend to incorporate high levels of creativity, innovativeness, communication 
and collaboration from learners. It includes content that fosters a healthy cultural identity yet highlights the 
importance of subscribing to a global citizenship. The 21st-century pedagogies prescribed encourage learners 
to be confident leaders and focus on personal development within the context of digital literacy.
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The key words are a very important component for learners who are not mother tongue English 
speakers. The methodology uses a variety of creative ways to familiarise learners with the key words for each 
task, mostly in the ‘Phase 1: Start of task’ section.

Resources for use during a task can be found in the section 'Downloadable content'. Resources may 
include worksheets, presentations to be used, self-assessment criteria or peer-assessment criteria, evaluation 
criteria, etc.

The ‘Phase 1: Start of task’ section should not last longer than five to eight minutes. There are many 
creative ways to start a task, and this section is merely a guide for teachers to introduce their learners to 
each new topic.

The ‘Phase 2: Main’ section is merely a guide for teachers to use in their tasks. Teachers might have to 
adjust some aspects because much will depend on the ability of the learners in each class and their pace of 
learning. This section of a task should last approximately 20 minutes in a 30 minute task.

The ‘Phase 3: End of task’ section can be used to reflect on the learning in each task or for consolidation 
of key concepts learned. Teachers may wish to try some of their own creative ‘End of task’ ideas and use the 
suggested ideas as a guide. This section should typically last approximately five to eight minutes.

Low-resource schools
The ‘Low-resource school’ section caters for schools where electronic devices are not available. Teachers 
in such situations should prepare in an entirely different way from the ways suggested in most of the tasks 
in this book. However, there are numerous parts of tasks that do not require learners to be working on a 
computer. Teachers might be able to use the following ideas: 
•	 Prepare flash cards with key words by placing a picture on one card and its definition on another card. 

Hand one card to each learner randomly and ask learners to find their match.
•	 Ask learners to explain or describe in their own words their understanding of their key word.
•	 Create or provide classroom posters for your display boards. Use these for reference during explanations.
•	 Create ‘Find the matching words’ activities by using the key words lists.
•	 Create ‘Fill in the missing words’ worksheets.
•	 Draw information-rich sketches on a board, developing a discussion or explanation while you draw. Use 

the Learner’s Book as a point of reference.
•	 Ask learners to do the activities in the Learner’s Book or the Teacher’s Guide that do not require the use of a 

computer.
•	 Arrange learners in groups to work through questions in the Learner’s Book or Teacher’s Guide.

Extension activities
The ‘Extension activity’ section serves as differentiation materials to challenge the more able learners in a 
class. Teachers might wish to use the extension activities as follows: 
•	 with the moreable learners only
•	 in pairs where a more able learner works together with a less able learner
•	 in mixed ability groups that present their answers as a group to the rest of the class for all ability learners 

individually, at the discretion of the teacher.

Answers
The ‘Answers’ section provides possible answers to the activities and questions in the Learner’s Book, and 
to the worksheets available for download from Cambridge GO. These are by no means exhaustive and any 
other reasonable answers should be considered by the teacher.

There are several links to websites and YouTube videos, and learners are encouraged to create their own 
digital resources as a means to prepare our ‘digital natives’ for their future world of work. It would be wise to 
adopt an open mind to the use of mobile phones and electronic devices to enhance the learning process.

We hope you enjoy using this Teacher’s Guide as much as we did in producing it.
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Strand 1: Introduction to computing

Introduction
In this strand, you can expect to explore a range of topics in four sub-strands:
•	 Generations of computers and the parts of a computer and other gadgets: types of output devices; 

differences between analogue and digital devices; the characters on a keyboard; further features of 
the Microsoft Windows interface building on those explored in Basic 4 and Basic 5; a summary of all 
the generations of computers.

•	 Introduction to the Microsoft Windows interface: a more in-depth exposition of the features of the 
Windows interface. Lessons include tasks for learners to personalise the desktop background and 
use the recycle bin, the pop-up menu, the File Explorer window, location of the hard drives, the 
navigation pane, frequent folders section, and the recent files sections.

•	 Data, sources and usage: identifying types of data, such as, integers, float, double and characters; 
exploring additional sources of data, including email, Skype, SMS, etc; managing users of the 
desktop, including presenting data in different forms. 

•	 Technology in the community (communication): identify and demonstrate the use of various 
communications technologies in the community.

Sub-strand 1: Computers and their parts

Task 1 of 32

Sub-strand 1: Generations of computers and parts of a computer and other gadgets

Content standard: B6.1.1.1 Identify parts of a 
computer, technology tools, and history of computers.

Indicator: B6.1.1.1.1 
Learn about the generations of computers.

Performance indicator: 
ALL learners will be able to learn about 
the generations of computers, including 
supercomputers and mainframe computers.

SOME learners will be able to learn about the 
generations of computers, including minicomputers, 
microprocessors, and mobile phones.

FEW learners will be able to learn about the 
generations of computers.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: supercomputers, mainframe computers, minicomputers, microprocessors, mobile phones, 
generations of computers

In this task: 
The teacher should refer to the Learner’s Book for information and pictures of the different generations 
of computers. Divide learners into groups of three to make posters of the different generations of 
computers for the classroom displays.

Learners should refer to the Learner’s Book and use the internet to find more information to make 
colourful posters about the different generations of computers for the classroom displays.
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Strand 1: Introduction to computing

Resources required� Learner’s Book pages 1–4

Phase 1: Start of task
Explain the task for the day. Learners should be in groups of three to make colourful posters of the different 
generations of computers. Each group should be given one generation of computers as the subject of their poster.

Phase 2: Main
Refer to the Learner’s Book for more information about the different generations of computers. Posters 
should be placed on the classroom display board.

Phase 3: End of task
Learners should go around to all the displays and evaluate them by sticking a grade on each one, using 
sticky notes with smiley faces. The posters with the most smiley faces should be discussed as to why they are 
so popular.

Refer to Activity 1.1 on page 4 of the Learner’s Book relating to the generations of computers. Ask the 
more able learners to do this task.

Extension activity

Answers to Activity 1.1 Choose a device� Learner's Book page 4

Answers may vary.
1.	 The most useful would be the tablet because it is WiFi enabled and can be carried easily as it is not 

very heavy.
2.	 It is easier to make notes when off-site or on a train. / Kplorm could write his report and upload it to 

the office if he is within a WiFi service area. / Kplorm could connect to the internet via his smartphone 
to upload his reports if there is no WiFi connection.

Task 2 of 32

Sub-strand 1: Generations of computers and parts of a computer and other gadgets

Content standard: B6.1.1.1 Identify parts of 
a computer, technology tools and history of 
computers.

Indicator: B6.1.1.1.2
Identify components of a computer system: 
hardware, software and liveware.

Performance indicator: 
ALL learners will be able to identify some 
computer hardware.

SOME learners will be able to identify most parts 
of a computer system, and software.

FEW learners will be able to identify all the 
computer hardware parts, software, and liveware.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: mouse, keyboard, monitor, central processing unit and its components, memory, hard disk 
drive, CD-ROM, speakers and peripherals, applications software, bespoke software, utility software, liveware
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Sub-strand 1: Computers and their parts

In this task: 
The teacher should give learners access to Presentation Task 2_B6.1.1.1.2 Components of a Computer 
System.pptx to edit and improve.

Learners should edit and improve the existing presentation which is available for download from 
Cambridge GO.

Resources required� Learner’s Book pages 5–9

Downloadable content
•	 Presentation Task 2_B6.1.1.1.2 Components of a computer system.pptx 

Phase 1: Start of task
Show learners the beginning of Presentation Task 2_B6.1.1.1.2 Components of a computer system.pptx, 
which is available for download from Cambridge GO. Point out how the main parts are hyperlinked to the 
relevant sections in the same PowerPoint file. Explain that they should add pictures of their own and short 
explanations of each item.

Phase 2: Main
Learners should improve and edit the current version of Presentation Task 2_B6.1.1.1.2 Components of a 
computer system.pptx.

Phase 3: End of task
Select one or two of the best presentations to show the class and ask learners how they could improve their 
presentations next time.

Ask the more able learners to do Activity 1.2 on page 5 of the Learner’s Book. Remind other learners of 
the acronyms for hardware and software covered in Basic 5.

Extension activity

Answers to Activity 1.2 Revise computer terms� Learner's Book pages 5–6

1.	 RAM: random access memory 
CPU: central processing unit 
HDD: hard disk drive 
SSD: solid state drive 
OS: operating system

2.	 hardware components: motherboard, CPU, RAM, power supply, hard drive, solid state drive, ROM, 
video card, sound card 
hardware devices: printer, keyboard, mouse, scanner, monitor

3.	 Answers will vary.

Answers to Activity 1.3 List and describe applications� Learner's Book page 7

Answers will vary.
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Strand 1: Introduction to computing

Answers to Activity 1.4 Distinguish between hardware and software 
� Learner's Book page 8

Device Software or 
hardware?

Input, output, or 
both?

Storage or com-
munication?

Solid state drive (SSD) Hardware Storage

Mouse Hardware Input

Keyboard Hardware Input

Hard disk drive (HDD) Hardware Storage

Screen/monitor Hardware Output unless 
touch screen

Central processing unit (CPU) Hardware

Operating system Software

Pen drive (flash drive) Hardware Both

Bar code reader Hardware Input

Motherboard Hardware

Random access memory (RAM) Hardware Storage

Video card Hardware

Printer Hardware Output Output

Word processor Software

Scanner Hardware Input

Webcam Hardware Input

Microphone Hardware Input

Task 3 of 32

Sub-strand 1: Generations of computers and parts of a computer and other gadgets

Content standard: B6.1.1.1 Identify parts of 
a computer, technology tools, and history of 
computers.

Indicator: B6.1.1.1.3
Identify the left and right mouse buttons, holding 
the mouse, performing single, double and triple 
clicking, dragging object, and using scroll wheel.
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Sub-strand 1: Computers and their parts

Performance indicator: 
ALL learners will be able to identify the left and 
right mouse buttons, holding the mouse.

SOME learners will be able to identify performing 
single, double, and triple clicking, dragging object, 
and using scroll wheel.

FEW learners will be able to identify the left and 
the right mouse buttons, holding the mouse, 
performing single, double, and triple clicking, 
dragging object, and using scroll wheel.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: mouse, left mouse button, right mouse button, single click, double click, triple click, scroll 
wheel, dragging object 

In this task: 
The teacher should refer to the Learner’s Book for information and pictures to create either short leaflets 
or short videos about how to use a mouse.

Learners should create either a short information leaflet or a short video explaining how to use a mouse.

Resources required� Learner’s Book pages 9–10

Phase 1: Start of task
Ask three learners to share with the class how they usually use a mouse.

Phase 2: Main
•	 Explain to learners all the ways that a mouse can be used.
•	 Divide the class into small groups and ask them to create a short guide with pictures or drawings of each of 

the ways a mouse could be used. They could produce a leaflet.
•	 Alternatively, suggest that some learners could record short videos demonstrating and explaining how to 

use the mouse in the various ways you have explained. They could work in pairs or small groups.

Phase 3: End of task
Learners should share their videos and give one another a score out of 3 where 1 = needs improvement; 2 = 
satisfactory; and 3 = good.

Ask the more able learners to do Activity 1.5 on page 10 of the Learner’s Book.

Extension activity

Answers to Activity 1.5 Make a poster� Learner's Book page 10

Learners’ posters showing beginners how to use a mouse will vary. They will get peer feedback and make 
changes if necessary before the posters are printed.
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Strand 1: Introduction to computing

Task 4 of 32

Sub-strand 1: Generations of computers and parts of a computer and other gadgets

Content standard: B6.1.1.1 Identify parts of 
a computer, technology tools, and history of 
computers.

Indicator: B6.1.1.1.2 
Demonstrate the proper use of keyboarding 
techniques.

Performance indicator: 
ALL learners will be able to demonstrate the 
proper use of some keyboarding techniques.

SOME learners will be able to demonstrate the 
proper use of most keyboarding techniques.

FEW learners will be able to demonstrate the 
proper use of keyboarding techniques.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: QWERTY; numeric keys; word processor; slash keys; tab key, function keys; caps lock, esc, 
PrtScn, Home and End keys; PgDn and PgUp keys; Enter key; home row keys; Backspace and Delete keys; 
Shift, Ctrl and Alt keys

In this task: 
The teacher should refer to the Learner’s Book for pictures of keyboarding techniques and to the video 
tutorial for a demonstration of keyboarding techniques.

Learners should refer to the Learner’s Book and use the video tutorial for keyboarding techniques.

Resources required� Learner’s Book pages 10–12

Downloadable content
•	 Worksheet Task 4_B6. 1.1.1.4 Keyboarding techniques.pdf

Phase 1: Start of task
Provide the worksheet for learners to access.

Phase 2: Main
Learners complete Worksheet Task 4_B6. 1.1.1.4 Keyboarding techniques.pdf.

Phase 3: End of task
Recap the meanings of the key words.

Task 5 of 32

Sub-strand 1: Generations of computers and parts of a computer and other gadgets

Content standard: B6.1.1.1 Identify parts of 
a computer, technology tools, and history of 
computers.

Indicator: B6.1.1.1.5
Summarise the generation of computers (second 
generation of computers).
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Sub-strand 1: Computers and their parts

Performance indicator: 
ALL learners will be able to summarise the 
generation of computers (second generation of 
computers).

SOME learners will be able to summarise the 
generation of computers (second generation of 
computers).

FEW learners will be able to summarise the 
generation of computers (second generation of 
computers).

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: first generation computers, second generation computers, third generation computers

In this task: 
The teacher should refer to the Learner’s Book for information about the generations of computers 
and divide the learners into small groups. Each group should be assigned one of the generations of 
computers. 

Learners should refer to the Learner’s Book for information about the generations of computers. They 
should compile quiz questions on their allocated topic. They should write the answers on the reverse of 
the page and hand it in for the quiz in the next task. 

Learners should prepare for the quiz, which will be held during the next task.

Resources required� Learner’s Book pages 10–14

Phase 1: Start of task
Divide learners into small groups and assign one of the generations of computers as a topic for each group. 
Many groups can have the same topic.

Phase 2: Main
Learners must write up ten quiz questions and answers on their topic and hand them to you for the quiz in 
the next task.

Phase 3: End of task
Recap the meanings of the key words.

Ask the more able learners to attempt Activity 1.6 on page 14 of the Learner’s Book.

Extension activity
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Strand 1: Introduction to computing

Answers to Activity 1.6 Computer generations� Learner's Book page 14

1.	 Transistors: Second
VLSI: Fourth
Vacuum tubes: First
ULSI: Fifth
Integrated circuits: Third

2.	 First
3.	 Ultra large scale integration P

Task 6 of 32

Sub-strand 1: Generations of computers and parts of a computer and other gadgets

Content standard: B6.1.1.1 Identify parts of 
a computer, technology tools and history of 
computers.

Indicator: B6.1.1.1.5
Summarise the generation of computers (second 
generation of computers).

Performance indicator: 
ALL learners will be able to summarise the 
generation of computers (second generation of 
computers).

SOME learners will be able to summarise the 
generation of computers (second generation of 
computers).

FEW learners will be able to summarise the 
generation of computers (second generation of 
computers).

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: first generation computers, second generation computers, third generation computers

In this task: 
The teacher should give each learner a quiz sheet to number and write down their answers as she calls 
out the quiz questions the learners prepared in the previous task. The teacher should aim to do as many 
questions as possible, allowing enough time to go over the correct answers after each question.

Learners should answer and correct each incorrect answer as they proceed through the quiz task.

Resources required� Learner’s Book pages 10–14

Phase 1: Start of task
Provide the quiz sheet for learners.

Phase 2: Main
•	 Give each learner a quiz sheet to number and write down their answers as you call out the quiz questions 

they prepared in the previous task. Aim to do as many questions as possible allowing enough time to go 
over the correct answers after each question.

•	 Learners should answer and correct each incorrect answer as they proceed throughout the quiz task.
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Sub-strand 1: Computers and their parts

Phase 3: End of task
Recap the meanings of the key words.

Task 7 of 32

Sub-strand 2: Introduction to the MS Windows interface

Content standard: B6.1.2.1 Demonstrate the use 
of the desktop background as well as working with 
folders.

Indicator: B6.1.2.1.1-10 Explore the use of the 
desktop background, changing theme colours and 
the user account.

Performance indicator: 
ALL learners will be able to explore the use of the 
desktop background, changing theme colours. 

SOME learners will be able to explore the use 
of the desktop background, changing the user 
account.

FEW learners will be able to explore the use of the 
desktop background, changing theme colours, 
and the user account

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: File Explorer, folder, file, clipboard

In this task: 
The teacher should divide the class into ten different groups and allocate one topic to each group 
to prepare a presentation to share with everyone through Prezi or PowerPoint. After watching the 
presentations, the learners complete the worksheet tasks for each of the next ten tasks in Sub-strand 2.

Learners should refer to the Learner’s Book and use the worksheet to create presentations on Prezi or 
PowerPoint to share with the whole class. All learners carry out the tasks on each worksheet for the next 
ten tasks.

Resources required� Learner’s Book pages 15–17

Downloadable content
•	 Presentation self-assessment sheet.pdf

Phase 1: Start of task
Explain the procedure for the next ten tasks. Learners should be allocated topics and placed into ten groups. 
They will prepare their presentation during this task and group 1 will start presenting in the next task, Group 
2 in the following task, and so on until all ten groups have completed their presentations. Learners must 
complete the worksheet for each task and the group that presented must also complete Presentation self-
assessment sheet.pdf.

Phase 2: Main
•	 Learners work in their groups to prepare their PowerPoint presentations or Prezis. They must aim to 

complete their preparation before the next task so that everyone can listen and complete their worksheet 
tasks after each presentation. 
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•	 Assign a topic to each group as follows:

Group Topic Week for 
task

1 Explore the use of the desktop background, changing the theme colours and 
user account.

1

2 Demonstrate the use of the Recycle Bin or Trash Can. 2

3 Perform permanent delete or empty Trash Can and restoring files or icons in 
the Recycle Bin.

3

4 Explore the use of copy, paste, delete tools, the moving of folders by using 
the desktop pop-up menu.

4

5 Illustrate the use of the File Explorer window and locations on the computer 
through the File Explorer.

5

6 Locate the hard drives and other removable storage icons in the File Explorer. 6

7 Use the File Explorer Ribbon (Home tab only), that is, the Clipboard and 
organise Tools of the Home tab of  File Explorer, as well as the Open New 
Window and Close tools of the File menu of File Explorer.

7

8 Demonstrate the use of the navigation pane of File Explorer to access 
different locations on the computer from the navigation pane.

8

9 Demonstrate the use of Frequent Folders section of File Explorer to access 
frequently used locations on the computer.

9

10 Demonstrate the use of Recent File section of File Explorer to access recently 
used files of the computer.

10

Phase 3: End of task
You should check that all groups are ready for the next presentation. Upload to a master PowerPoint and 
share with the class or ensure that everyone has access to the Prezi account to upload their presentations.

Task 8 of 32

Sub-strand 2: Introduction to the MS Windows interface

Content standard: B6.1.2.1 Demonstrate the use 
of desktop background as well as working with 
folders.

Indicator: B6.1.2.1.1
Explore the use of the desktop background 
changing theme colours and user account.

Performance indicator: 
ALL learners will be able to explore the use of the 
desktop background changing theme colours. 

SOME learners will be able to explore the use of the 
desktop background changing the user account.

FEW learners will be able to explore the use of the 
desktop background changing theme colours and 
user account.

Core competencies:
1.	 Creativity and Innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy
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Sub-strand 1: Computers and their parts

Key words: classic, icons, taskbar, background, user account, themes

In this task: 
The teacher should set up the room so that Group 1 can do their presentation and the rest of the class 
can watch and then everyone, including Group 1 members, should carry out the tasks on the worksheet.

Learners should refer to the Learner’s Book and use the worksheet to carry out the tasks after watching 
the presentation by Group 1. Group 1 must complete Presentation self-assessment sheet.pdf.

Resources required� Learner’s Book pages 15–17

Downloadable content
•	 Worksheet Task 8_B6.1.2.1.1 Desktop background tasks.pdf
•	 Presentation self-assessment sheet.pdf

Phase 1: Start of task
Set up the class so that Group 1 can do their presentation for the whole class. Everyone must watch and then 
complete their worksheets.

Phase 2: Main
Learners watch Group 1’s presentation and complete their worksheet tasks. 

Phase 3: End of task
You should check that Group 2 is ready for the next task’s presentation. Group 1 must complete Presentation 
self-assessment sheet.pdf.

Answers to Task 8 worksheet
Task 8.1

Key words Meaning

personalise Add something that you like, e.g. a background image of your favourite flower or car.

customise Change from the original to something else according to a specific requirement.

edit Make changes and corrections on your computer or in another way.

icons Small pictures that represent actions, apps, logos, etc.

taskbar A panel on the computer’s interface that has lots of icons for accessing the various 
features of a software package.

MS Windows 
interface

It’s similar to a cover page of a magazine that displays icons of the features you have 
in that software package.

wallpaper The standard background images for interfaces.

settings A button that gives you access to editing, personalising, and customising your 
computer.

start menu It displays access to the icons to use for editing the various features on your 
computer.
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Sub-strand 2: Introduction to the Microsoft Windows interface

Task 9 of 32

Sub-strand 2: Introduction to the MS Windows interface

Content standard: B6.1.2.1 Demonstrate the use of 
desktop background as well as working with folders.

Indicator: B6.1.2.1.2
Demonstrate the use of the Recycle Bin or Trash Can.

Performance indicator: 
ALL learners will be able to demonstrate the use of 
the Recycle Bin or Trash Can.

SOME learners will be able to demonstrate the use 
of the Recycle Bin or Trash Can.

FEW learners will be able to demonstrate the use 
of the Recycle Bin or Trash Can.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: delete, recover, drag and drop

In this task: 
The teacher should set up the room so that Group 2 can do their presentation and the rest of the class 
can watch and then everyone, including Group 2 members, should carry out the tasks on the worksheet.

Learners should refer to the Learner’s Book and use the worksheet to carry out the tasks after watching 
the presentation by Group 2. Group 2 must complete Presentation self-assessment sheet.pdf.

Resources required� Learner’s Book page 17

Downloadable content
•	 Worksheet Task 9_B6.1.2.1.2 Recycle Bin.pdf
•	 Presentation self-assessment sheet.pdf

Phase 1: Start of task
Set up the class so that Group 2 can do their presentation for the whole class. Everyone must watch and then 
complete their worksheets.

Phase 2: Main
Learners watch Group 2’s presentation and complete their worksheet tasks. 

Phase 3: End of task
You should check that Group 3 is ready for the next presentation. Group 2 must complete Presentation self-
assessment sheet.pdf.

Task 10 of 32

Sub-strand 2: Introduction to the MS Windows interface

Content standard: B6.1.2.1 Demonstrate the use of 
desktop background as well as working with folders.

Indicator: B6.1.2.1.3
Perform permanent delete or Empty Trash Can.
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Sub-strand 2: Introduction to the Microsoft Windows interface

Performance indicator: 
ALL learners will be able to perform permanent 
delete or Empty Trash Can.

SOME learners will be able to perform permanent 
delete or Empty Trash Can.

FEW learners will be able to perform permanent 
delete or Empty Trash Can.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: permanent delete, empty trash can, restore

In this task: 
The teacher should set up the room so that Group 3 can do their presentation and the rest of the class 
can watch and then everyone, including Group 3 members, should carry out the tasks on the worksheet.

Learners should refer to the Learner’s Book and use the worksheet to carry out the tasks after watching 
the presentation by Group 3. Group 3 must complete Presentation self-assessment sheet.pdf.

Resources required� Learner’s Book page 17

Downloadable content
•	 Worksheet Task 10_B6.1.2.1.3 Empty Recycle Bin.pdf
•	 Presentation self-assessment sheet.pdf

Phase 1: Start of task
Set up the class so that Group 3 can do their presentation for the whole class. Everyone must watch and then 
complete their worksheets.

Phase 2: Main
Learners watch Group 3’s presentation and complete their worksheet tasks. 

Phase 3: End of task
You should check that Group 4 is ready for the next presentation. Group 3 must complete Presentation self-
assessment sheet.pdf.

Answers to Task 10 worksheet
Task 10.1
•	 Recycle Bin or Trash Can: A place where files or objects are temporarily moved to until you empty the 

recycle bin
•	 Delete files: Remove files and place in the Recycle Bin or Trash Can
•	 Restore files: Retrieve files that you have deleted and restore them to their original place
•	 Empty Recycle Bin: Permanently delete files or items from your computer

Task 10.3
When you empty the Recycle Bin or Trash Can, you permanently remove all the deleted files and objects 
from your computer.

Task 10.4
1.	 False
2.	 True



14

Strand 1: Introduction to computing

Task 11 of 32

Sub-strand 2: Introduction to the MS Windows interface

Content standard: B6.1.2.1 Demonstrate the use 
of desktop background as well as working with 
folders.

Indicator: B6.1.2.1.4
Explore the use of copy, paste, delete tools, the 
moving of folders by using the desktop pop-up menu.

Performance indicator: 
ALL learners will be able to explore the use of 
copy, paste, delete tools.

SOME learners will be able to explore the use of 
copy, paste tools and the moving of folders by 
using the desktop pop-up menu.

FEW learners will be able to explore the use of 
copy, paste, delete tools, the moving of folders by 
using the desktop pop-up menu.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: copy, paste, delete, cut, pop-up

In this task: 
The teacher should set up the room so that Group 4 can do their presentation and the rest of the class 
can watch and then everyone, including Group 4 members, should carry out the tasks on the worksheet.

Learners should refer to the Learner’s Book and use the worksheet to carry out the tasks after watching 
the presentation by Group 4. Group 4 must complete Presentation self-assessment sheet.pdf.

Resources required� Learner’s Book page 19

Downloadable content
•	 Worksheet Task 11_B6.1.2.1.4 Desktop Pop-Up Menu Copy, Paste, Delete tools.pdf
•	 Presentation self-assessment sheet.pdf

Phase 1: Start of task
Set up the class so that Group 4 can do their presentation for the whole class. Everyone must watch and then 
complete their worksheets.

Phase 2: Main
Learners watch Group 4’s presentation and complete their worksheet tasks. 

Phase 3: End of task
You should check that Group 5 is ready for the next presentation. Group 4 must complete Presentation self-
assessment sheet.pdf.

Answers to Task 11 worksheet
Task 11.1 
•	 Copy: A file or object that you have highlighted and right-clicked on, then selected the copy option
•	 Paste: A file or object that you have copied. You can then place the cursor in the place where you wish to 

place the copied file and select the paste option.
•	 Delete: A file or object that you have highlighted and clicked on the delete button to remove it from its place
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•	 Cut: A file that has been highlighted and removed to be placed in another place on the computer
•	 Move: A file that has been removed from one place and placed in another place on the computer

Task 11.4
If you cut a file or a folder, it does not disappear, but instead becomes transparent. When you paste that file/
folder, it is moved to the new location and disappears from the original location.

Task 12 of 32

Sub-strand 2: Introduction to the MS Windows interface

Content standard: B6.1.2.1 Demonstrate 
the use of desktop background as well as 
working with folders.

Indicator: B6.1.2.1.5
Illustrate the use of the File Explorer window and 
locations on the computer through the file explorer.

Performance indicator: 
ALL learners will be able to illustrate the use 
of the File Explorer window.

SOME learners will be able to illustrate the use 
of the File Explorer window and locations of 
most of the computer through the File Explorer.

FEW learners will be able to illustrate the use 
of the File Explorer window and locations on 
the computer through the File Explorer.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: File Explorer, folder, file, clipboard

In this task: 
The teacher should set up the room so that Group 5 can do their presentation and the rest of the class 
can watch and then everyone, including Group 5 members, should carry out the tasks on the worksheet.

Learners should refer to the Learner’s Book and use the worksheet to carry out the tasks after watching 
the presentation by Group 5. Group 5 must complete Presentation self-assessment sheet.pdf.

Resources required� Learner’s Book pages 18–19

Downloadable content
•	 Worksheet Task 12_B6.1.2.1.5 File Explorer locations on the computer.pdf
•	 Presentation Self-Assessment Sheet.pdf 

Phase 1: Start of task
Set up the class so that Group 5 can do their presentation for the whole class. Everyone must watch and then 
complete their worksheets.

Phase 2: Main
Learners watch Group 5’s presentation and complete their worksheet tasks. 

Phase 3: End of task
You should check that Group 6 is ready for the next presentation. Group 5 must complete Presentation self-
assessment sheet.pdf.



16

Strand 1: Introduction to computing

Answers to Task 12 worksheet
Task 12.2

File path

Desktop

Removable storage disc

Home ribbon

File Explorer Pop-up menu

C: drive

Task 12.4
The Downloads folder contains all the items that you have downloaded from websites or email attachments, 
whereas the Documents folder contains all the documents that you have worked on and not yet saved 
in any particular folder using Save As. Your computer will probably have an auto-save option that will 
automatically save the document that you are working on every three minutes or at whatever rate you have 
set the auto-save function. 
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Task 13 of 32

Sub-strand 2: Introduction to the MS Windows interface

Content standard: B6.1.2.1 Demonstrate the use 
of desktop background as well as working with 
folders.

Indicator: B6.1.2.1.6
Locate the hard drives and other removable 
storage icons in the File Explorer.

Performance indicator: 
ALL learners will be able to locate the removable 
storage icons in the File Explorer.

SOME learners will be able to locate the hard drives 
in the File Explorer.

FEW learners will be able to locate the hard drives and 
other removable storage icons in the File Explorer.

Core competencies:
1. 	 Creativity and innovation
2. 	 Communication and collaboration
3. 	 Cultural identity and global citizenship
4. 	 Personal development and leadership
5. 	 Digital literacy

Key words: removable storage devices, hard drive, icons, File Explorer

In this task: 
The teacher should set up the room so that Group 6 can do their presentation and the rest of the class 
can watch and then everyone, including Group 6 members, should carry out the tasks on the worksheet.

Learners should refer to the Learner’s Book and use the worksheet to carry out the tasks after watching 
the presentation by Group 6. Group 6 must complete Presentation self-assessment sheet.pdf.

Resources required� Learner’s Book page 20

Downloadable content
•	 Worksheet Task 13_B6.1.2.1.6 File Explorer hard drives and other drives.pdf
•	 Presentation self-assessment sheet.pdf

Phase 1: Start of task
Set up the class so that Group 6 can do their presentation for the whole class. Everyone must watch and then 
complete their worksheets.

Phase 2: Main
Learners watch Group 6’s presentation and complete their worksheet tasks. 

Phase 3: End of task
You should check that Group 7 is ready for the next presentation. Group 6 must complete Presentation self-
assessment sheet.pdf.

Task 14 of 32

Sub-strand 2: Introduction to the MS Windows interface

Content standard: B6.1.2.1 Demonstrate 
the use of desktop background as well as 
working with folders.

Indicator: B6.1.2.1.7
Use the File Explorer ribbon.
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Performance indicator: 
ALL learners will be able to use the File 
Explorer Ribbon, i.e. the clipboard.

SOME learners will be able to use the File 
Explorer Ribbon, including the clipboard, 
and organise tools of the Home tab of the 
File menu.

FEW learners will be able to use the File 
Explorer Ribbon, including the Open New 
Window and Close tools of the File menu.

Core competenci es:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: File Explorer ribbon, Clipboard, open new window, File menu

In this task: 
The teacher should set up the room so that Group 7 can do their presentation and the rest of the class 
can watch and then everyone, including Group 7 members, should carry out the tasks on the worksheet.

Learners should refer to the Learner’s Book and use the worksheet to carry out the tasks after watching 
the presentation by Group 7. Group 7 must complete Presentation self-assessment sheet.pdf.

Resources required� Learner’s Book pages 20–22

Downloadable content
•	 Worksheet Task 14_B6.1.2.1.7 Use the File Explorer Ribbon.pdf
•	 Presentation self-assessment sheet.pdf

Phase 1: Start of task
Set up the class so that Group 7 can do their presentation for the whole class. Everyone must watch and then 
complete their worksheets.

Phase 2: Main
Learners watch Group 7’s presentation and complete their worksheet tasks. 

Phase 3: End of task
You should check that Group 8 is ready for the next presentation. Group 7 must complete Presentation self-
assessment sheet.pdf

Task 15 of 32

Sub-strand 2: Introduction to the MS Windows interface

Content standard: B6.1.2.1 Demonstrate the use 
of desktop background as well as working with 
folders.

Indicator: B6.1.2.1.8
Demonstrate the use of the Navigation pane of the 
File Explorer to access different locations on the 
computer.
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Performance indicator: 
ALL learners will be able to demonstrate the use of 
the Navigation pane of the File Explorer.

SOME learners will be able to demonstrate the 
use of the Navigation pane of the File Explorer to 
access different locations on the computer.

FEW learners will be able to demonstrate the 
use of the Navigation pane of the File Explorer to 
access many different locations on the computer.

Core competencies:
1.	 Creativity and Innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: Navigation pane, locations on the computer, folders, files

In this task: 
The teacher should set up the room so that Group 8 can do their presentation and the rest of the class 
can watch and then everyone, including Group 8 members, should carry out the tasks on the worksheet.

Learners should refer to the Learner’s Book and use the worksheet to carry out the tasks after watching 
the presentation by Group 8. Group 8 must complete Presentation self-assessment sheet.pdf.

Resources required� Learner’s Book page 21

Downloadable content
•	 Worksheet Task 15_B6.1.2.1.8 File Explorer navigation pane.pdf
•	 Presentation self-assessment sheet.pdf

Phase 1: Start of task
Set up the class so that Group 8 can do their presentation for the whole class. Everyone must watch and then 
complete their worksheets.

Phase 2: Main
Learners watch Group 8’s presentation and complete their worksheet tasks. 

Phase 3: End of task
You should check that Group 9 is ready for the next presentation. Group 8 must complete Presentation self-
assessment sheet.pdf.

Task 16 of 32

Sub-strand 2: Introduction to the MS Windows interface

Content standard: B6.1.2.1 Demonstrate the use 
of desktop background as well as working with 
folders.

Indicator: B6.1.2.1.9
Demonstrate the use of Frequent Folders section 
of the File Explorer to access frequently used 
locations on the computer.
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Performance indicator: 
ALL learners will be able to demonstrate the use 
of Frequent Folders section of the File Explorer to 
access some of the frequently used locations on 
the computer.

SOME learners will be able to demonstrate the use 
of Frequent Folders section of the File Explorer to 
access most of the frequently used locations on 
the computer.

FEW learners will be able to demonstrate the use 
of Frequent Folders section of the File Explorer to 
access frequently used locations on the computer.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: frequently used files

In this task: 
The teacher should set up the room so that Group 9 can do their presentation and the rest of the class 
can watch and then everyone, including Group 9 members, should carry out the tasks on the worksheet.

Learners should refer to the Learner’s Book and use the worksheet to carry out the tasks after watching 
the presentation by Group 9. Group 9 must complete Presentation self-assessment sheet.pdf.

Resources required� Learner’s Book pages 21–22

Downloadable content
•	 Worksheet Task 16_B6.1.2.1.9 File Explorer’s Frequent folders.pdf
•	 Presentation self-assessment sheet.pdf

Phase 1: Start of task
Set up the class so that Group 9 can do their presentation for the whole class. Everyone must watch and then 
complete their worksheets.

Phase 2: Main
Learners watch Group 9’s presentation and complete their worksheet tasks. 

Phase 3: End of task
You should check that Group 10 is ready for the next presentation. Group 9 must complete Presentation self-
assessment sheet.pdf.

Task 17 of 32

Sub-strand 2: Introduction to the MS Windows interface

Content standard: B6.1.2.1 Demonstrate the use 
of desktop background as well as working with 
folders.

Indicator: B6.1.2.1.10
Demonstrate the use of Recent files section of the 
File Explorer to access frequently used files of the 
computer.
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Performance indicator: 
ALL learners will be able to demonstrate the use of 
some of the Recent files section of the File Explorer 
to access frequently used files on the computer.

SOME learners will be able to demonstrate the 
use of most of the Recent files section of the File 
Explorer to access frequently used files on the 
computer.

FEW learners will be able to demonstrate the use 
of Recent files section of the File Explorer to access 
frequently used files on the computer.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: recent files

In this task: 
The teacher should set up the room so that Group 10 can do their presentation and the rest of the class 
can watch and then everyone, including Group 10 members, should carry out the tasks on the worksheet.

Learners should refer to the Learner’s Book and use the worksheet to carry out the tasks after watching 
the presentation by Group 10. Group 10 must complete Presentation self-assessment sheet.pdf.

Resources required� Learner’s Book pages 21–22

Downloadable content
•	 Worksheet Task 17_B6.1.2.1.10 File Explorer’s Recent files.pdf
•	 Presentation self-assessment sheet.pdf

Phase 1: Start of task
Set up the class so that Group 10 can do their presentation for the whole class. Everyone must watch and 
then complete their worksheets.

Phase 2: Main
Learners watch Group 10’s presentation and complete their worksheet tasks. 

Phase 3: End of task
•	 Thank all the groups for their presentations and praise where it is due. Group 10 must complete the 

Presentation self-assessment sheet.
•	 Lead a discussion about what the most difficult aspects of the last ten tasks were and ask learners to make 

suggestions as to how they might improve next time.

Task 18 of 32

Sub-strand 3: Data, sources and usage

Content standard: B6.1.3.1 Demonstrate the use 
of data and identify sources of data.

Indicator: B6.1.3.1.1
Identify types of data (integers, double, 
characters, float, etc.).
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Performance indicator: 
ALL learners will be able to identify types of data 
(characters, float, etc.).

SOME learners will be able to identify types of 
data (integers, double, etc.).

FEW learners will be able to identify types of data 
(integers, double, characters, float, etc.).

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: integers, double, character, float, data types

In this task: 
The teacher should explain that, when programming in any language, you have to know what data 
types you are working with and how they are represented. 

Learners should refer to the Learner’s Book and use the worksheet to carry out the tasks. Learners 
should log in to an online tutorial website to practise using the different data types.

Resources required� Learner’s Book pages 22–24

Downloadable content
•	 Worksheet Task 18_B6.1.3.1.1 Identify types of data.pdf

Phase 1: Start of task
•	 Start by explaining that, when programming in C++, you have to use variables and you must specify the 

data type before assigning a value to the variable. 
•	 Click on the link that demonstrates why recognising the data type is necessary before you can do any 

programming.  
https://www.w3schools.com/cpp/cpp_variables.asp

Phase 2: Main
Use the Worksheet Task 18_B6.1.3.1.1 Identify types of data.pdf to guide the main part of the task.

Phase 3: End of task
Ask learners to share one thing they found too difficult to understand and one thing they did not know before.

Answers to Task 18 worksheet
Task 18.1

Data type Meaning

int Stores floating point numbers, with decimals, such as 19.99 or -19.99.

double Stores values with two states: True or False.

char Stores single characters, such as ‘a’ or ‘B’. Char values are surrounded by single quotes.

string Stores integers (whole numbers), without decimals, such as 123 or -123.

bool Stores text, such as “Hello World”. String values are surrounded by double quotes.
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Task 18.3
1.	 123.5897543
2.	 Congratulations, you have just started learning about programming.
3.	 736
4.	 Yes or No
5.	 0.5

Which data is better to use? Float or double? Give reasons for your choice.

Extension activity

Sub-strand 3: Data, sources and usage

Task 19 of 32

Sub-strand 3: Data, sources and usage

Content standard: B6.1.3.1 Demonstrate the 
use of data and identify sources of data.

Indicator: B6.1.3.1.2
Identify more sources of information (internet, emailing, 
Skype, SMS).

Performance indicator: 
ALL learners will be able to identify more 
sources of information (internet, emailing).

SOME learners will be able to identify more 
sources of information (Skype, SMS).

FEW learners will be able to identify more 
sources of information (internet, emailing, 
Skype, SMS).

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: internet, emailing, VoIP, SMS

In this task: 
The teacher should explain that learners will carry out their tasks by editing the existing PowerPoint 
presentation.

Learners should refer to the Learner’s Book and use the presentation to carry out the tasks. 

Learners should screenshot evidence of having carried out their tasks in the presentation itself.

Resources required� Learner’s Book pages 24–25

Downloadable content
•	 Presentation Task 19_B6.1.3.1.2 Identifying more sources of data.pdf

Phase 1: Start of task
Begin by explaining that learners should edit the presentation which is available for download from 
Cambridge GO. They will have to screenshot evidence that they have carried out the tasks requested.
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Phase 2: Main
Learners edit Presentation Task 19_B6.1.3.1.2 Identifying more sources of data.pdf. It includes using the 
internet to find information, save it, and use it to make a presentation slide about VoIP. They have to SMS 
a friend to inform them that they are sending them an email attachment with information on VoIP. They 
should screenshot their evidence of having carried out all these tasks in the presentation itself.

Phase 3: End of task
Learners must list one new skill they learnt in the lesson and one thing they would still like to learn more 
about in the future.

Task 20 of 32

Sub-strand 3: Data, sources and usage

Content standard: B6.1.3.1 Demonstrate the use 
of data and identify sources of data.

Indicator: B6.1.3.1.3
Demonstrate sending and receiving information 
from other gadgets e.g. Bluetooth, infrared, radio, 
fax, telephone calls, SMS, etc.

Performance indicator: 
ALL learners will be able to demonstrate sending 
and receiving information from other gadgets e.g. 
Bluetooth, infrared, etc.

SOME learners will be able to demonstrate 
sending and receiving information from other 
gadgets e.g. Bluetooth, infrared, radio, fax, etc.

FEW learners will be able to demonstrate sending 
and receiving information from other gadgets e.g. 
Bluetooth, infrared, radio, fax, telephone calls, 
SMS, etc.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: Bluetooth, infrared, radio, fax, telephone calls, SMS

In this task: 
The teacher should explain that learners will carry out their tasks by editing the existing PowerPoint 
presentation.

Learners should refer to the Learner’s Book and use the presentation to carry out the tasks. 

Learners should screenshot evidence of having carried out their tasks in the presentation itself.

Resources required� Learner’s Book pages 25–27

Downloadable content
•	 Presentation Task 20_B6.1.3.1.3 Demonstrate sending and receiving information from other gadgets.pdf

Phase 1: Start of task
Begin by explaining that learners should edit the presentation found in the downloadable content. They will 
have to screenshot evidence that they have carried out the tasks requested.
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Phase 2: Main
Learners edit Presentation Task 20_B6.1.3.1.3 Demonstrate sending and receiving information from 
other gadgets.pdf. It includes using Bluetooth to share a favourite song with a friend and sending an SMS, 
etc. They should screenshot their evidence of having carried out all these tasks in the presentation itself.

Phase 3: End of task
Recap the meanings of the key words.

Task 21 of 32

Sub-strand 3: Data, sources and usage

Content standard: B6.1.3.1 Demonstrate the use 
of data and identify sources of data.

Indicator: B6.1.3.1.4
Demonstrate basic manipulations on sample data, 
e.g. arranging data in a matrix table, sorting, and 
calculations.

Performance indicator: 
ALL learners will be able to demonstrate basic 
manipulations on sample data, e.g. sorting.

SOME learners will be able to demonstrate basic 
manipulations on sample data, e.g. sorting, and 
calculations.

FEW learners will be able to demonstrate basic 
manipulations on sample data, e.g. arranging 
data in a matrix table, sorting, and calculations.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: arrange data in a matrix, sorting data, calculations on data

In this task: 
The teacher should explain that learners will log in to Khan Academy to carry out basic manipulations 
on data, such as arranging data in a matrix table, sorting data, and carrying out calculations on data.

Learners should refer to the Learner’s Book and log in to Khan Academy to carry out basic 
manipulations on data, such as arranging data in a matrix table, sorting data, and carrying out 
calculations on data.

Resources required� Learner’s Book pages 28–32

Phase 1: Start of task
Begin by explaining that learners should log in to Khan Academy at this link:  
https://www.khanacademy.org/math/precalculus/x9e81a4f98389efdf:matrices/x9e81a4f98389efdf:mat-
intro/v/introduction-to-the-matrix

Phase 2: Main
Learners should screenshot evidence of their working or results to show their teacher throughout this online 
tutorial. It is better that learners sign up for their own accounts so that the account can keep track of the 
work they have already done. 

Phase 3: End of task
Recap the meanings of the key words.
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1.	 Learners can use this link to explore ways of sorting data.  
https://www.youtube.com/watch?v=Ep5q1cUhQas

2.	 Learners can use this link on how to carry out calculations on data. 
https://www.youtube.com/watch?v=1naiWCWfSt4

3.	 Ask the more able learners to attempt Activity 1.7 on page 24 of the Learner’s Book.

Extension activity

Answers to Activity 1.7 Identify data types� Learner's Book page 24

alphabetically, by price, by AutoNumber, by yes/no answers (Any reasonable response)

Task 22 of 32

Sub-strand 3: Data, sources and usage

Content standard: B6.1.3.1 Demonstrate the 
use of data and identify sources of data.

Indicator: B6.1.3.1.5
Demonstrate how to manage users of the desktop.

Performance indicator: 
ALL learners will be able to demonstrate how 
to manage users of the desktop.

SOME learners will be able to demonstrate 
how to manage users of the desktop.

FEW learners will be able to demonstrate 
how to manage users of the desktop.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: user accounts on Desktop, administrator account, standard user account, family member 
user account

In this task: 
The teacher should explain the reasons children should be supervised online, hence the need for 
managing user accounts on the desktop. Refer learners to the Learner’s Book page 16 for more 
information on this topic.

Learners should complete the worksheet tasks.

Resources required� Learner’s Book pages 16–17

Downloadable content
•	 Worksheet Task 22_B6.1.3.1.5 Managing user accounts on the desktop.pdf

Phase 1: Start of task
Begin by explaining that learners can learn how to manage users on the desktop by watching the short video 
at this link. 
https://www.youtube.com/watch?v=g6DWReo465E
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Phase 2: Main
Learners should answer the questions on Worksheet Task 22_B6.1.3.1.5 Managing user accounts on the 
desktop.pdf.

Phase 3: End of task
Recap the meanings of the key words.

Answers to Task 22 worksheet
Task 22.2
1.	 Children need supervised access.
2.	 Children need supervision in case they inadvertently access harmful materials, online criminals or adult-

only materials. Children should also not be allowed to spend too much time on their electronic gadgets 
because it could be harmful to their health. They could suffer eye strain, and neck and back aches.

2.	 Parents should supervise their children’s online activity to ensure they do not come to any harm from 
the materials they are able access on their computers. Parents should also limit the amount of time that 
their children spend on their computers to ensure they keep a healthy balance between their online and 
offline activities.

Task 23 of 32

Sub-strand 3: Data, sources and usage

Content standard: B6.1.3.1 Demonstrate the use 
of data and identify sources of data.

Indicator: B6.1.3.1.6
Demonstrate how to collect data.

Performance indicator: 
ALL learners will be able to demonstrate how to 
collect data.

SOME learners will be able to demonstrate how to 
collect data.

FEW learners will be able to demonstrate how to 
collect data.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: questionnaire, survey, interview

In this task: 
The teacher should read aloud the section in the Learner’s Book on collecting data and then allow 
learners to work through the worksheet.

Learners should complete the worksheet tasks and refer to the Learner’s Book for the section on 
collecting data.

Resources required� Learner’s Book page 27

Downloadable content
•	 Presentation Task 23_B6.1.3.1.6 Collecting data.pptx

Phase 1: Start of task
Use the presentation from slide 2 to slide 4.
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Phase 2: Main
Continue using the presentation to guide you through the whole task.

Phase 3: End of task
Ask learners to complete their questionnaires, surveys, and interviews before their next task and to bring the 
data that they collect with them to the next lesson.

Task 24 of 32

Sub-strand 3: Data, sources and usage

Content standard: B6.1.3.1 Demonstrate the use 
of data and identify sources of data.

Indicator: B6.1.3.1.7
Demonstrate the use of tools for collecting data.

Performance indicator: 
ALL learners will be able to demonstrate the use of 
some tools for collecting data.

SOME learners will be able to demonstrate the use 
of more tools for collecting data.

FEW learners will be able to demonstrate the use 
of tools for collecting data.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: case studies, interviews, checklists

In this task: 
The teacher should show the video on using tools for collecting data and then allow learners to work 
through the worksheet.

Learners should complete the worksheet tasks and refer to the video for ways to collect data.

Resources required� Learner’s Book page  29

Phase 1: Start of task
To get an idea of the tools that can be used to collect data, use this video link.
https://www.youtube.com/watch?v=abxXMhYW04o

Phase 2: Main
Learners make summary notes from the Learner’s Book on the section about using tools for collecting data. 
They compile a set of three questions from their notes and supply the answers for their questions as well.

Phase 3: End of task
Ask volunteers to share one of their most difficult questions with the class. See if anyone else can answer 
their question and check if they got it right. Do as many questions and answers as possible.

Ask the more able learners to attempt Activity 1.8 on page 27 of the Learner’s Book.

Extension activity
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Answers to Activity 1.8 Understand data collection� Learner's Book page 27

1.	 Discussion should include methods of communication such as: infrared, Bluetooth, radio, fax, 
telephone, SMS.

Task 25 of 32

Sub-strand 3: Data, sources and usage

Content standard: B6.1.3.1 Demonstrate the use 
of data and identify sources of data.

Indicator: B6.1.3.1.8
Demonstrate data interpretation by computing 
data to gain required information (finding grand 
sum or grand total using electronic spreadsheet).

Performance indicator: 
ALL learners will be able to demonstrate data 
interpretation by computing some data to gain 
required information.

SOME learners will be able to demonstrate data 
interpretation by computing data to gain most of 
the required information.

FEW learners will be able to demonstrate data 
interpretation by computing data to gain required 
information.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: electronic spreadsheet, grand sum, grand total, data interpretation

In this task: 
The teacher should show the short video about interpreting data. Allow learners to work through the 
activities in the Learner’s Book.

Learners should refer to the Learner’s Book on the section on interpreting data.

Resources required� Learner’s Book pages 32–33

Phase 1: Start of task
To get an idea of how to interpret data, use this video link.  
https://www.youtube.com/watch?v=abxXMhYW04o

Phase 2: Main
Learners make summary notes from the Learner’s Book on the section about interpreting data to gain the 
required information. They work through the examples in the Learner’s Book. They compile a set of three 
questions from their notes and supply the answers for their questions as well.

Phase 3: End of task
Ask volunteers to share one of their most difficult questions with the class. See if anyone else can answer 
their question and check if they got it right. Do as many questions and answers as possible.



30

Strand 1: Introduction to computing

Ask the more able learners to attempt Activity 1.9 on page 28 of the Learner’s Book.

Extension activity

Answers to Activity 1.9 Calculate ages from dates of birth� Learner's Book page 28

A B C

1 Name Date of birth Age

2  Khrobo 06-Jun-96 23

3  Adofo 30-Apr-86 34

4  Ami 30-Nov-55 64

5  Oko 30-Mar-10 10

6 Learner’s name Learner’s birth date Learner’s age

Task 26 of 32

Sub-strand 3: Data, sources and usage

Content standard: B6.1.3.1 Demonstrate the use 
of data and identify sources of data.

Indicator: B6.1.3.1.9
Demonstrate data presentation in different forms.

Performance indicator: 
ALL learners will be able to demonstrate data 
presentation in different forms.

SOME learners will be able to demonstrate data 
presentation in different forms.

FEW learners will be able to demonstrate data 
presentation in different forms.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: tables, charts, spreadsheet, pictures, maps, infographics

In this task: 
The teacher should allow learners to be guided by the tasks in the worksheet and the spreadsheet, both 
found in the downloadable content. 

Learners should use the worksheet and spreadsheet, both found in the downloadable content, to guide 
them through this task.

Resources required� Learner’s Book pages 33–34

Downloadable content
•	 Task 26_B6.1.3.1.9 Sample data.pdf
•	 Worksheet Task 26_B6.1.3.1.9 Demonstrate data presentation in different forms.pdf
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Phase 1: Start of task
Open Task 26_B6.1.3.1.9 Sample data and Worksheet Task 26_B6.1.3.1.9 Demonstrate data 
presentation in different forms.pdf to begin your task.

Phase 2: Main
Allow learners to work through the tasks.

Phase 3: End of task
•	 Recap the meanings of the key words.
•	 Ask learners which data form they prefer and to give their reasons.

Ask the more able learners to attempt Activity 1.10 on pages 29–32 of the Learner’s Book.

Extension activity

Answers to Activity 1.10 Create a database table� Learner's Book pages 29–32

A database has been planned with headings and data types from data collected during the discussion in 
Activity 1.9.

Task 26.1
Eye colour could be blue, brown, or a combination of blue and brown. 

Task 26.2
1.	 Chart showing expenses only

Electri
city

Water
Gas

Enterta
inment

Tuitio
n

Savings

Income 1

Expenses

Income 2
Other

Housin
g

Grocery

Car p
ayment

Insu
rance

Home phone

Cell p
hone

Cable TV

Intern
et

GHC -

GHC 1,000.00

GHC 2,000.00

GHC 3,000.00

GHC 4,000.00

GHC 5,000.00

GHC 6,000.00

2.	 Example pie chart 
Expenses compared to Income

Total Expenses Total Income
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Task 27 of 32

Sub-strand 3: Data, sources and usage

Content standard: B6.1.3.1 Demonstrate the use 
of data and identify sources of data.

Indicator: B6.1.3.1.10
Demonstrate how to store data.

Performance indicator: 
ALL learners will be able to demonstrate how to 
store data. 

SOME learners will be able to demonstrate how to 
store data.

FEW learners will be able to demonstrate how to 
store data.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: handwriting, phone recording, magnetic tapes, optical disc, etc.

In this task: 
The teacher should allow learners to create posters for the classroom display boards on the different 
data storage formats available. 

Learners should create posters for the classroom displays about storing data in different formats.

Resources required� Learner’s Book pages 33–38

Phase 1: Start of task
Brainstorm ways that data can be stored in different formats. Possible answers: handwriting, phone 
recording, magnetic tapes, optical disc.

Phase 2: Main
Allow learners to research more information on data storage formats and to add to the list of key words. They 
should also use the Learner’s Book on the section on how to store data.

Phase 3: End of task
Learners should place their posters on the classroom display boards and their classmates should go around 
and give them a smiley face if they liked them.

Task 28 of 32

Sub-strand 3: Data, sources and usage

Content standard: B6.1.3.1 Demonstrate the use 
of data and identify sources of data.

Indicator: B6.1.3.1.11
Manipulate data to gain required output, e.g. 
finding sum, mean, grand totals, maximum, 
minimum, mode, division, multiplication, etc.
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Performance indicator: 
ALL learners will be able to manipulate data to 
gain required output.

SOME learners will be able to manipulate data to 
gain required output.

FEW learners will be able to manipulate data to 
gain required output.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: sum, mean, grand totals, maximum, minimum, mode, division, multiplication

In this task: 
The teacher should recap the ways to do statistical calculations using a calculator and then allow 
learners to carry out the same calculations in a spreadsheet.

Learners should complete the worksheet tasks using the spreadsheet.

Answers to Activity 1.11 Work with data in a spreadsheet� Learner's Book page 33

Learners use this activity to practise sizing columns and making headings fit column sizes using text 
wrapping. They also work with ranges and enter a formula in the cell where the result is to appear.

Answers to Activity 1.12 Interpret data in a chart� Learner's Book page 34

Learners practise identifying chart elements so that they can read the chart correctly and make sense of 
the data it represents. 

Answers to Activity 1.13 se functions and ranges� Learner's Book page 38

Learners need to use the correct functions with carefully selected ranges, then check one another's work 
for accuracy.

Resources required� Learner’s Book pages 36–38

Downloadable content
•	 Max Min Mean Mode worksheet and answer sheet.pdf
•	 Worksheet Task 28_B6.1.3.1.11 Manipulate data to gain the required output.pdf

Phase 1: Start of task
Let the learners complete the worksheet tasks. 

Phase 2: Main
Learners should use the worksheet to answer the questions.

Phase 3: End of task
Recap the meanings of the key words.
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Answers to Task 28 worksheet
Task 28.2 

  Data

  13

  6

  24

  18

  33

  5

  13

  48

  9

  11

  36

  28

  15

  6

  13

2.

SUM =SUM(B2:B16) 278

MEAN =B17/15 18.53

GRAND TOTAL =B17 278

MODE =MODE.MULT(B2:B16) 13

MAXIMUM =MAX(B2:B16) 48

MINIMUM =MIN(B2:B16) 5

Divide grand total by 7 =B19/7 40

Multiply first two numbers =B2+B3 19



35

Sub-strand 4: Technology in the community

Sub-strand 4: Technology in the community

Task 29 of 32

Sub-strand 4: Technology in the community

Content standard: B6.1.4.1 Demonstrate the use 
of technology in the community.

Indicator: B6.1.4.1.1
Define communication.

Performance indicator: 
ALL learners will be able to provide a limited 
definition of communication.

SOME learners will be able to provide a reasonable 
definition of communication.

FEW learners will be able to provide a definitive 
definition of communication.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: human-to-human communication, human-to-device communication, device-to-device 
communication

In this task: 
The teacher should explain the key words briefly and pose the debate topic: Real communication can 
only occur between humans. Divide the class into two groups: one group must AGREE and the other must 
DISAGREE with the statement. 

Learners should do some research about the various types of communication relating to the key words.

Resources required� Learner’s Book page 39

Phase 1: Start of task
Begin by explaining that learners should watch this short video at this link.  
https://www.youtube.com/watch?v=wroLk1ETVeM

Answers to Activity 1.14 Communicate effectively� Learner's Book page 40

Learners use this activity to discuss and understand the steps in the process of communication. 

Phase 2: Main
Learners should write out a justification of their point of view by giving several examples of how 
communications between humans is more real or less real than communications between devices.

Phase 3: End of task
In pairs of opposing views, learners should swap their written points of view and they should discuss and 
feedback whose argument is more convincing.

Task 30 of 32

Sub-strand 4: Technology in the community
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Content standard: B6.1.4.1 Demonstrate the use 
of technology in the community.

Indicator: B6.1.4.1.2
Identify three more technological tools for 
communication in the community.

Performance indicator: 
ALL learners will be able to identify one more 
technological tool for communication in the 
community.

SOME learners will be able to identify two more 
technological tools for communication in the 
community.

FEW learners will be able to identify three more 
technological tools for communication in the 
community.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: Artificial Intelligence (AI), holograms, robotics, virtual reality, augmented reality, Internet of 
Things (IoT)

In this task: 
The teacher should discuss the key words and do research on the topic of the various technological tools 
for communications in the community.

Learners should do research on the topic of the various technological tools for communication in the 
community and complete the worksheet.

Resources required� Learner’s Book pages 40–41

Downloadable content
•	 Worksheet Task 30_B6.1.4.1.2 Identify more technological tools for communications.pdf

Phase 1: Start of task
Learners should research various types of technological tools for communications in the community to 
complete the tasks on the worksheet.

Phase 2: Main
Complete the worksheet.

Phase 3: End of task
In pairs, learners should discuss and give each other constructive feedback, focusing on discussions around 
the importance of technology in communication.

Task 31 of 32

Sub-strand 4: Technology in the community

Content standard: B6.1.4.1 Demonstrate the use 
of technology in the community.

Indicator: B6.1.4.1.3
Demonstrate communication with others.
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Performance indicator: 
ALL learners will be able to demonstrate a limited 
level of communication with others.

SOME learners will be able to demonstrate a 
reasonable level of communication with others.

FEW learners will be able to demonstrate 
communication with others.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: TV, radio, phone call, satellite, Lego games, wearable tech, Fitbit watches, robots doing 
amazing things, driverless cars, robotic vacuum cleaners, drones delivering shopping and fast food, 
smart watches, smart phones, Xbox

In this task: 
The teacher should explain that learners should develop and carry out a short role play showing how 
they can use technology to communicate with one another.

Learners should work in small groups to develop a short role play showing how they could use 
technology to communicate.

Resources required� Learner’s Book page 39

Downloadable content
•	 Worksheet Task 31_B6.1.4.1.3 Demonstrate communicating with others.pdf

Phase 1: Start of task
Provide learners with the different starter ideas to prepare short one-liners to string together to make up 
quick role plays for each group. Divide the learners into small groups of about five to six in a group.

Phase 2: Main
Use the ideas in the worksheet to suggest opening lines for each learner to contribute to their group’s role 
play, which should last about two minutes. The worksheet also has ideas for the types of tools that learners 
can use in the role plays.

Phase 3: End of task
Decide on which role play was the best in terms of its futuristic content.

Task 32 of 32

Sub-strand 4: Technology in the community

Content standard: B6.1.4.1 Demonstrate the use 
of technology in the community.

Indicator: B6.1.4.1.4
Identify three more important aspects of 
technology in communication.
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Performance indicator: 
ALL learners will be able to identify one 
more important aspect of technology in 
communication.

SOME learners will be able to identify two 
more important aspects of technology in 
communication.

FEW learners will be able to identify three 
more important aspects of technology in 
communication.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: TV, radio, phone call, satellite, Lego games, wearable tech, Fitbit watches, robots doing 
amazing things, driverless cars, robotic vacuum cleaners, drones delivering shopping and fast food, 
smart watches, smart phones, Xbox, sensors

In this task: 
The teacher should explain that learners should create a three-slide presentation, showcasing three 
important aspects of using technology in communications. The worksheet has more guidance as to what 
each slide should contain.

Learners should create three slides in a presentation showcasing three important aspects of using 
technology in communications based on the requirements in the worksheet.

Resources required� Learner’s Book pages 40–41

Downloadable content
•	 Worksheet Task 32_B6.1.4.1.4 Importance of technology in communications.pdf

Phase 1: Start of task
Use the worksheet for guidance in this task. Learners may use the internet to research more information on 
the importance of using technology in communications.

Phase 2: Main
Learners should create three slides, selecting from the suggestions in the worksheet. 

Phase 3: End of task
Ask learners what technology they believe is the most important in communications and to give their 
reasons.

Answers to Task 32 worksheet
These answers aren’t exhaustive.
In agriculture: ensuring food security, saving the environment, managing very large crops
In industry: handling very large projects, too big for humans, too dangerous for humans, requiring long 
working hours
In medicine: scanning and precision guiding surgeons in complex operations, at the forefront of data 
analysis
In flight training: using simulators to train pilots, etc.
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Answers to Activity 1.15 Discuss ITC in the community� Learner's Book page 42

Learners are given a chart to determine how often people in a particular community use ICT to access 
information, if at all. Point out that the red bar represents the percentage of people who never use ICT. 
For example, 80% of people never use Internet banking.
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Tick one of the columns below to show how well you think you can carry out each task.

Task

I use the keyboard 
correctly.

I know what an integer is.

I can create a new user 
account.

I understand different 
ways to transmit data.

I can collect data from a 
conversation.

I know the difference 
between data and 
information.

I know how the process of 
communication works.

I can explain internet, 
telephone, radio, TV and 
satellite communication.

Check your progress
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Strand 2: Presentations

Introduction
In this strand, you can expect to extend learners’ capabilities in using Microsoft PowerPoint as a 
presentation software package and explore the additional tabs in PowerPoint.

The varied pedagogical approaches in this strand include teacher demonstrations, independent 
learner worksheets, peer- and self-assessment criteria and collaborative working styles, and serve to 
extend both teacher and learner capabilities as follows:
•	 Use of active learning styles where learners observe teacher demonstrations and emulate them 

when creating their own presentations.
•	 Use of metacognitive learning styles are enhanced by the use of evaluation criteria that outline 

learner expectations clearly before they begin a task and allow learners the opportunity to revise 
their ways of learning constantly in order to achieve their expected outcomes.

•	 Teachers can align the assessment criteria in the curriculum at the time of creating them, so that 
national standards are achieved at the outset instead of by trial and error.

•	 Collaborative working styles benefit the less able learners to ask questions in a smaller, closer and 
safer group, thereby helping to develop their confidence.

Sub-strand 1: Introduction to Microsoft PowerPoint

Task 1 of 4

Sub-strand 1: Introduction to MS PowerPoint (tabs and ribbons of MS PowerPoint)

Content standard: B6.2.1.1 Demonstrate how to 
use MS PowerPoint.

Indicator: B6.2.1.1.1 Demonstrate how to use the 
File Menu, the Insert and Design ribbon from B5.

Performance indicator: 
ALL learners will be able to show the use of 
Cipboard, Slides, Fonts and Paragraph in the 
groups on the  Home tab.

SOME learners will be able to show the use of 
editing in the group on the the Home tab.

FEW learners will be able to show the use of 
Clipboard, Slides, Fonts, Paragraph and Editing in 
the groups on te Home tab.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: Ribbon, clipboard, font, paragraph, editing, Home tab, formatting, icon, save, repeat, open 
files, undo, quick access bar, menu bar

In this task: 
The teacher should refer to the Learner’s Book to revise the use of the commands in each group  in the  
File menu, and the Insert and Design tabs.

Learners should use the worksheet to guide them in creating a five-slide presentation. Refer to the 
Learner’s Book section on presentations.
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Resources required� Learner's Course Book pages 46–49

Downloadable content
•	 Presentation Task 1_B6.2.1.1.1 File Menu, Insert and Design tabs.pptx

Phase 1: Start of task
Play the game ‘Hot seat’ with the key words. Ask for a volunteer to sit in the ‘hot seat’ at the front of the class, 
facing the learners but with their back to the board. The teacher writes the key word on the board so the hot 
seat learner cannot see the word. Learners must explain what the word means but cannot say the word or 
spell it. Once the correct word has been guessed, a new volunteer should have a turn to sit in the hot seat and 
a new word goes on the board.

Phase 2: Main
•	 Demonstrate by revising how to create a multi-slide presentation. Use Presentation Task 1_B6.2.1.1.1 

File Menu, Insert and Design tabs.pptx. 
•	 Allow learners to create their five-slide presentations according to the criteria in the presentation.

Phase 3: End of task
Ask learners to write down two difficulties they experienced in creating their slide shows. Let them swap their 
experiences with a classmate. Allow discussion to help them solve any problems relating to their slide show 
creation.

Task 2 of 4

Sub-Strand 1: Introduction to MS PowerPoint (Tabs and ribbons of MS PowerPoint)

Content standard: B6.2.1.1 Demonstrate how to 
use MS PowerPoint.

Indicator: B6.2.1.1.2 Demonstrate how to use the 
icons in the Text group on the Insert tab.

Performance indicator: 
ALL learners will be able to show the use of the 
icons in the Text group on the Insert tab.

SOME learners will be able to show the use of the 
icons in the Text group on the Insert tab, including 
inserting currency symbols.

FEW learners will be able to show the use of the 
icons in the Text group on the Insert tab, including 
inserting currency symbols and changing the 
colours in WordArt.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: WordArt, currency symbol

In this task: 
The teacher should use Presentation Task 2_B6.2.1.1.2 Using icons in the Insert tab.pptx in this task.

Learners should use the presentation and the Learner’s Book to demonstrate how they use the icons 
in the Text group on the Insert tab, including inserting currency symbols and changing the colours in 
WordArt.
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Resources required� Learner’s Book page 48

Downloadable content
•	 Presentation Task 2_B6.2.1.1.2 Using Icons in the Text group on the Insert tab.pptx

Phase 1: Start of task
Ask learners to brainstorm words relating to presentations that could be used to create a Wordle or word 
cloud for a classroom decoration. Use an online Wordle creator for the words and create one that can be 
printed and displayed in the classroom.

Phase 2: Main
Use Presentation Task 2_B6.2.1.1.2 Using Icons in the Text group on the Insert tab.pptx and allow 
learners to demonstrate how they use the icons in the Text group on the Insert tab, including inserting 
currency symbols and changing the colours in WordArt titles.

Phase 3: End of Task
Check learners’ answers to the questions posed on the last few slides of the presentation. 

Ask the more able learners to attempt Activity 2.2 in the Learner’s Book.

Extension activity

Answers to Activity 2.1 Check your PowerPoint skills� Learner's Book page 46

This is a revision activity to help learners build on the skills they already have. 

Answers to Activity 2.2 Create and save a presentation� Learner's Book page 47

Presentations will vary because learners have choices. They should have:
•	 created a presentation with four slides
•	 slide 1 = Title is PowerPoint instructions using WordArt
•	 slide 2 = how to use a template
•	 slide 3 = how to insert headers & footers
•	 slide 4 = how to use file menu to print six slides on one page
•	 saved the presentation as ‘Instructions version 1
•	 emailed the presentation to a friend.

Task 3 of 4

Sub-strand 1: Introduction to MS PowerPoint (tabs and ribbons of MS PowerPoint)

Content standard: B6.2.1.1 Demonstrate how to 
use MS PowerPoint.

Indicator: B6.2.1.1.2 Be able to give a five-slide 
presentation in MS PowerPoint using the tools of 
the tabs studied.
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Performance indicator: 
ALL learners will be able to give a three-slide 
presentation in PowerPoint using the tools of the 
tabs studied.

SOME learners will be able to give a four-slide 
presentation in PowerPoint using the tools of the 
tabs studied.

FEW learners will be able to give a five-slide 
presentation in PowerPoint using the tools of the 
tabs studied.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: speaker’s notes, kiosk mode

In this task: 
The teacher should use Presentation Task 3_B6.2.1.1.3 Presenting your presentation.pptx so they 
can give a five-slide presentation in PowerPoint using the commands in the tabs studied.

Learners should finalise their presentations in the first part of the task before they present and give 
feedback to other presenters during the rest of the task.

Resources required� Learner’s Book page 50–52

Downloadable content
•	 Presentation Task 3_B6.2.1.1.3 Presenting your presentation.pptx

Phase 1: Start of task
Write this question on the board and divide learners into small groups: How can you give your presentation in 
the best possible way? Discuss in small groups.

Phase 2: Main
•	 Refer learners to the presentation methods on pages 51–55 of the Learner’s Book. They can go through the 

various possibilities when doing their presentation to an audience.
•	 Learners should be given an opportunity to present to the whole class and be given a time limit.

Phase 3: End of task
Learners should listen attentively while other learners are doing their presentations. They should give constructive 
and positive feedback to encourage learners to feel confident in presenting their work to the whole class.

Ask the less able learners to attempt Activity 2.3 and the more able learners to do Activity 2.4 in the 
Learner’s Book.

Extension activity

Answers to Activity 2.3 Insert icons in a slide� Learner's Book page 49

•	 A fifth slide has been added headed: Examples of Icons. It will contain a bulleted list of ten icons and 
show which icon group each is from.

•	 Presentation file saved as Instructions version 2.
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Answers to Activity 2.4 Add animations and transitions� Learner's Book page 51

•	 Animations and transitions have been added to slides.
•	 Presentation file saved as Instructions version 3.

Task 4 of 4

Sub-strand 1: Introduction to MS PowerPoint (Tabs and ribbons of MS PowerPoint)

Content standard: B6.2.1.1 Demonstrate how to 
use MS PowerPoint.

Indicator: B6.2.1.1.2 Be able to give a five-
slide presentation in MS PowerPoint using the 
commands in the tabs studied.

Performance indicator: 
ALL learners will be able to give a three-slide 
presentation in PowerPoint using the commands 
in the tabs studied.

SOME learners will be able to give a four-slide 
presentation in PowerPoint using the command in 
the tabs studied.

FEW learners will be able to give a five-slide 
presentation in PowerPoint using the commands 
in the tabs studied.

Core competencies:
Creativity and innovation
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: speaker’s notes, kiosk mode, slides

In this task: 
The teacher should allow learners to complete their presentations to the whole class and to improve on 
any aspect they were given feedback on.

Learners should finalise their presentations within the first part of the task before they present and give 
feedback to other presenters during the rest of the task.

Resources required� Learner’s Book page 50–53

Phase 1: Start of task
You should lead a discussion on what the main points in the feedback were from the previous task.

Phase 2: Main
Continue allowing learners to present to the whole class, within a time limit.

Phase 3: End of task
Learners should listen attentively while other learners are doing the presentations for the whole class. 
They should give constructive and positive feedback to encourage learners to feel confident in presenting 
their work to the whole class.
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Ask the more able learners to attempt Activity 2.5 in the Learner’s Book.

Extension activity

Answers to Activity 2.5 Prepare your slide show� Learner's Book page 54

•	 Timings have been rehearsed and set at a reasonable reading rate.
•	 Presentation has been set up to show as Browsed at a kiosk.
•	 Presentation file saved as Instructions version 4.
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•	 Plan→ Design → Create → Rehearse → Present
•	 I know what it says, so I read it quite quickly, but others seeing it for the first time would read it more 

slowly than I do.
•	 It would print one copy of all the slides as they are, and waste a lot of coloured ink.
•	 The presentation will carry on running until someone presses the Esc button.
•	 It is an image made up of basic geometric shapes, like curves, lines, etc. / A vector graphic is an 

image that can be made larger without affecting the quality of the image.
•	 It could be shown continuously in the shop window so passers-by can watch it when the shop is 

shut.

Check your progress
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Strand 3: Word processing

Introduction
This strand is a continuation of the word processing knowledge from previous learning and it is 
assumed that learners will be familiar with the use of its Home tab and groups. In this Teacher’s Guide, 
learners will explore how to use the additional tabs and groups of a word processor, such as the Insert, 
Design and Layout tabs.

Sub-strand 1: Introduction to Microsoft Word

Task 1 of 4

Sub-strand 1: Introduction to word processing (tabs and ribbons of word processing)

Content standard: B6.3.1.1 Illustrate the use 
of word processing application.

Indicator: B6.3.1.1.1 Demonstrate how to use the File 
menu, Insert, Design and Layout tabs from B5.

Performance indicator: 
ALL learners will be able to use the File 
menu, Insert tab. 

SOME learners will be able to use the Design 
and Layout tabs. 

FEW learners will be able to use the File 
menu, Insert, Design and Layout tabs.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: File menu, layout tab, page orientation, landscape, portrait, text alignment, justified, font 
type, font size, page margin, line spacing, insert table, columns

In this task: 
The teacher should demonstrate, using the Learner’s Book, so that learners use the File menu, Insert, Design 
and Layout tabs to complete Worksheet Task 1_B6.3.1.1.1 Word processing document production.pdf.

Learners should complete Worksheet Task 1_Word processing document production.pdf.

Resources required� Learner’s Book pages 59–67

Downloadable content
•	 Worksheet Task 1_B6.3.1.1.1 Starter activity.pdf
•	 Worksheet Task 1_B6.3.1.1.1 Word processing document production.pdf

Phase 1: Start of task
Use key words to describe the images in Worksheet Task 1_ B6.3.1.1.1 Starter activity.pdf. 

Phase 2: Main
•	 Demonstrate how to use the word processing document production by referring to the Learner’s Book. 
•	 Guide learners to carry out the instructions in Worksheet Task 1_Word processing document production.pdf. 
•	 In Task 1, you will only have time for instruction points 1–10. Leave instruction points 10–20 for Task 2.
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Phase 3: End of task
Ask learners to screenshot their evidence of having carried out all the instructions on the worksheet and to 
review and feedback to each other in pairs.

Ask the more able learners to attempt Activity 3.1 in the Learner’s Book.

Extension activity

Answers to Task 1 worksheet: Starter activity

1.	 Layout tab
2.	 Font size 
3.	 File menu 
4.	 Columns 
5.	 Design tab 
6.	 Line spacing 
7.	 Portrait orientation 
8.	 Page margin 
9.	 Landscape orientation 
10.	 Justified alignment 
11.	 Font types

Answers to Activity 3.1 Use the File menu� Learner's Book page 62

•	 Learners should have created a presentation that demonstrates five or more commands from the File 
menu.

•	 Learners will open the File menu and then find the shortcut keys for some of the items in the menu. 
This is revision from Basic 5. They may remember the shortcut keys. Otherwise they can search on the 
internet for shortcut keys for items in the File menu.

•	 They can use a word processor to create the handout, or do this on paper if a word processor is 
unavailable. The handout should contain several of the File menu shortcuts.

Task 2 of 4

Sub-strand 1: Introduction to word processing (tabs and ribbons of word processing)

Content standard: B6.3.1.1 Illustrate the use 
of word processing application.

Indicator: B6.3.1.1.1 Demonstrate the use of the File 
menu, Insert, Design and Layout tabs from B5.

Performance indicator: 
ALL learners will be able to use the File 
menu, Insert tab. 

SOME learners will be able to use the Design 
and Layout tabs. 

FEW learners will be able to use the File 
menu, Insert, Design and Layout tabs.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy
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Key words: File menu, Layout tab, page orientation, landscape, portrait, text alignment, justified, font 
type, font size, page margin, line spacing, insert table, columns

In this task: 
The teacher should allow learners to continue where they left off in the previous task.

Learners should complete Worksheet Task 1_B6.3.1.1.1 Word processing document  
production.pdf, continuing from where they left off in the previous task.

Resources required� Learner’s Book pages 59–67

Downloadable content
•	 Worksheet Task 1_B6.3.1.1.1 Word processing document production.pdf

Phase 1: Start of task
Use the key words in the table below to play the game, ‘Hot seat’. Rules: Ask for a volunteer learner to sit on 
a chair at the front of the classroom, facing the learners. Behind the volunteer learner, write a key word on 
the board so that the volunteer learner cannot see it. Ask the rest of the learners to explain the word to her/
him without spelling it or mentioning the actual word. Once the volunteer guesses the correct word, select 
another learner to sit in the Hot seat and repeat until all the key words have been explained and guessed.

Key word Meaning

Spell check Automatically checks the words against those in the computer’s dictionary and 
displays as a red squiggly line under the misspelt words.

Header Faded out section at the top of a page where you can write your name, date, and page 
numbers in a document.

Footer Faded out section at the bottom of a page where you can write your name, date, and 
page numbers in a document.

Indent Push the beginning of your text inwards from the margin by a few centimetres.

Word count Gives the number of words you have used in a page or file.

Save Saves your document or file in the last place you saved it or opened it from.

Save As Saves your document or file in a different place from Save. This allows you to choose 
the exact folder you want to save your file in.

Columns Newspapers usually display their text in columns to make it easier on the eye for 
reading purposes.

Phase 2: Main
•	 Continue where you left off in the previous task. Try to cover points 10–20 for Task 2.
•	 Demonstrate how to use the word processing features by referring to the Learner’s Book.
•	 Guide learners to carry out the instructions in Worksheet Task 1_B6.3.1.1.1 Word processing document 

production.pdf. 

Phase 3: End of task
Ask learners to self-assess their evidence of carrying out all the instructions on the worksheet and answer the 
following questions:
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Sub-strand 1: Introduction to Microsoft Word

•	 How much do you feel you have learnt in this task?
•	 Did you complete all the tasks in the worksheet?
•	 How would you do anything different next time?

Ask the more able learners to attempt Activity 3.2 in the Learner’s Book. You may wish to group a few 
less able learners with more able learners in each group to attempt Activity 3.2.

Extension activity

Answers to Activity 3.2 Create a calendar� Learner's Book page 63–64

Learners should have all 12 months with the correct month names and dates saved.

Task 3 of 4

Sub-strand 1: Introduction to word processing (tabs and ribbons of word processing)

Content standard: B6.3.1.1 Illustrate the use of 
word processing application.

Indicator: B6.3.1.1.2 Demonstrate how to use the 
icons in the Text group of the Insert tab.

Performance indicator: 
ALL learners will be able to use some of the 
commands in the Text group on the Insert tab.

SOME learners will be able to use a few of the 
commands in the Text group on the Insert tab.

FEW learners will be able to use all of the 
commands in the Text group on the Insert tab..

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: WordArt, signature line, text from file, object, quick parts

In this task: 
The teacher should demonstrate, using the Learner’s Book information, so that learners use the Insert, 
Design, and Layout tabs to complete the task on the last slide of Presentation Task 3_B6.3.1.1.2 Text 
icons in Insert tab.pptx.

Learners should complete the task on the last slide of Presentation Task 3_B6.3.1.1.2 Text icons in 
Insert tab.pptx.

Resources required� Learner’s Book page 63

Downloadable content
•	 Presentation Task 3_B6.3.1.1.2 Text icons in Insert tab.pptx

Phase 1: Start of task
•	 Ask learners to discuss the differences between the Text group in the Insert tab of a PowerPoint 

presentation and that of a word processor.
•	 Use slide 2 of Presentation Task 3_B6.3.1.1.2 Text icons in Insert tab.pptx to show them possible answers.
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Phase 2: Main
Demonstrate the features in the Text group of the Insert tab by using Presentation Task 3_B6.3.1.1.2 Text 
icons in Insert tab.pptx and referring learners to the Learner’s Book pages 67–68.

Phase 3: End of task
Ask learners to share their document with a classmate for peer review and feedback.

Arrange learners in groups of mixed ability so that learners collaborate to produce the best possible 
answers for Activity 3.3 in the Learner’s Book.

Extension activity

Answers to Activity 3.3 Illustrate your calendar's cover� Learner's Book page 65

•	 Learners will have inserted a front cover to their own design using illustrations, one of which must be 
an online picture. 

•	 They will have a second page with four pictures, depicting spring, summer, autumn and winter, and will 
have drawn a squiggly line around each of the images.

Task 4 of 4

Sub-strand 1: Introduction to word processing (tabs and ribbons of word processing)

Content standard: B6.3.1.1 Illustrate the use of 
word processing application.

Indicator: B6.3.1.1.3
Use the attributes of the tabs studied in a 
paragraph.

Performance indicator: 
ALL learners will be able to create a document 
using a word processing application.

SOME learners will be able to format the text in a 
word processing application.

FEW learners will be able to create a document 
and format text in a document using a word 
processing application.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: digital signature, format, align

In this task: 
The teacher should explain how to produce evidence of the creation of a word processed document and 
all the requested formatting of its text and images.

Learners should open the source files, select the most suitable software to produce the document, and 
follow the instructions in Worksheet Task 4_B6.3.1.1.3 Create a document and format text.pdf.
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Resources required� Learner’s Book pages 65–68

Downloadable content
•	 Worksheet Task 4_B6.3.1.1.3 Create a document and format text.pdf
•	 Hospital letter and form.pdf

Phase 1: Start of task
Demonstrate which files learners should access and how they should screenshot their evidence when 
creating their document and formatting the text according to the instructions on the worksheet.

Phase 2: Main
Learners should work in pairs and discuss how they can answer and work through the instructions in 
Worksheet Task 4_B6.3.1.1.3 Create a document and format text.pdf.

Phase 3: End of task
Ask learners to write down a list of three things that went well and three things they still need to improve on. 
Lead a brief discussion on possible solutions.

Ask the more able learners to explain to the less able learners how they arrived at their answers for 
Activity 3.4 in the Learner’s Book.

Extension activity

Answers to Activity 3.4 Add a watermark� Learner's Book page 66

Learners will have added a watermark, inserted a border around the whole page, and deleted the 
squiggly lines from around each picture.

Answers to Activity 3.5 Create a poster� Learner's Book page 67

Learners will have added a watermark, inserted a border around the whole page, and deleted the 
squiggly lines from around each picture.
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1.	 A page break marks the end of one page and the start of the next. It is used when you want to 
start a new page with the text that follows.

2.	 Column breaks / Section breaks
3.	 Save: Ctrl+S
4.	 Portrait has the short side of the paper at the top. Landscape has the long side of the paper at the 

top.
5.	 A plain text file contains text that has been formatted, such as bold, underlined or italic.
6.	 Click on the Insert tab, select and highlight the icon from the folders where you have saved your 

icon on your computer and then select insert or double-click on the icon.

Check your progress
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Strand 5: Programming and databases

Introduction
In this strand, you can expect to introduce Microsoft Access as a database software package and 
explore the databases, spreadsheets, and programming languages.

Sub-strand 1: Introduction to databases, algorithms and 
programming languages

Task 1 of 20

Sub-strand 1: Introduction to databases, algorithms, and programming languages (e.g. MS Excel, 
Scratch, VB.Net, etc.)

Content standard: B6.5.1.1 Demonstrate how to 
manipulate databases.

Indicator: B6.5.1.1.1 Describe databases.

Performance indicator: 
ALL learners will be able to identify the features of 
a database.

SOME learners will be able to identify the types of 
databases that exist.

FEW learners will be able to identify the features of 
a database and the types of databases that exist.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: database, table, field, record, design view, datasheet view, data type, text, currency, date 
and time, AutoNumber, yes/no.

In this task: 
The teacher should describe what a database is, the importance of databases and examples of 
databases in daily use.

Learners should complete the questions in Worksheet Task 1_ B6.5.1.1.1 Describing  
databases_1.pdf.

Resources required� Learner’s Book pages 72

Downloadable content
•	 Worksheet Task 1_B6.5.1.1.1 Describing databases_1.pdf

Phase 1: Start of task
Write this statement on the board. Ask learners to discuss the statement in depth and in a structured way: 
The idea of a database is new and it is only used by database experts in the computer field.
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Phase 2: Main
•	 Allow learners to complete as many of the questions as they can on the worksheet after watching the short 

video. 
https://www.youtube.com/watch?time_continue=25&v=BUE-XJEHp7g

•	 Learners could also refer to the Learner’s Book on databases for more information on how to set up a database.

Phase 3: End of task
Word Boggle Game
Learners write down as many words about databases as possible in three minutes. Ask one learner to call out 
their words and all learners with the same words should cross those words off their lists. Ask another learner 
who still has words left to call out all their words. Again, learners must cross those words off their list. Repeat 
this until everyone’s list is crossed off. The learner with most correct words is the winner.

Ask the more able learners to work alongside a less able learner when attempting to do Activity 5.1 in 
the Learner’s Book.

Extension activity

Answers to Task 1 worksheet
Task 1.1
1.	 A database can be defined as a collection of structured or organised data.
2.	 Any three of the following: distributed database, centralised database, end-user database, commercial 

database, operational database, relational database.
3.	 Databases are important in everyday life, and can be used to sort and classify information in useful 

ways. Used by organisations such as government departments, academic institutions and commercial 
entities, databases allow users to discover information that can improve people’s lives or lead to 
competitive advantage in business.

4.	 FALSE

Task 1.2
•	 drawer in filing cabinet
•	 bigger filing cabinet
•	 filing cabinet old style
•	 database records
•	 records and fields in database

Task 1.3
Divide the items in your wardrobe into fields. These could be types of clothing, material they are made from, 
usage (e.g. sportswear, formalwear, traditional wear), colour. Each item then becomes a record and you can 
filter these records by field, e.g. view all yellow items.

Answers to Activity 5.1 Revise data types� Learner's Book page 72

1.	 Any three from: short text / number / AutoNumber / long text / date & time / currency / Boolean  
(Yes/No)
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2.	 a)	 iii
b)	 ii
c)	 i
d)	 v
e)	 iv
f)	 v

Task 2 of 20

Sub-strand 1: Introduction to databases, algorithms, and programming languages (e.g. MS Excel, 
Scratch, VB.Net, etc.)

Content standard: B6.5.1.1.1 Demonstrate how to 
manipulate databases.

Indicator: B6.5.1.1.2 Identify databases and data 
structures.

Performance indicator: 
ALL learners will be able to identify databases and 
data structures.

SOME learners will be able to identify data structures.

FEW learners will be able to identify databases and 
data structures.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: database, table, field, record, design view, datasheet view, data type, text, currency, date 
and time, AutoNumber, yes/no.

In this task: 
The teacher should use the Learner’s Book to explain the importance and uses of a database, using the 
excerpt in the worksheet.

Learners should complete the last questions in Worksheet Task 2_ B6.5.1.1.2 Describing databases_2.pdf.

Resources required� Learner’s Book pages 73–74

Downloadable content
•	 Worksheet Task 2_B6.5.1.1.2 Describing databases_2.pdf

Phase 1: Start of task
Play the ‘Hot seat’ game with the key words. Ask a volunteer learner to sit at the front of the class with their 
back to the board and facing the rest of the class. Behind them on the board, write one key word at a time. 
The learner in the Hot seat has to guess what that word is by listening to the descriptions that the other 
learners give. They should not spell the word nor should they mention the word. When the correct word is 
guessed, select another learner to sit in the Hot seat for the next key word. Repeat until all key words have 
been guessed.

Phase 2: Main
Use the excerpt taken from https://www.bbc.co.uk/bitesize/guides/zswnb9q/revision/1 on 27/10/2019.
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Database uses 
•	 Microsoft® Access is a popular database package but there are alternatives such as OpenOffice Base.
•	 Databases are widely used. Schools, hospitals, supermarkets, Facebook, Google and YouTube all make use 

of databases. Any company or organisation that stores large amounts of data almost certainly stores it in 
a database.

•	 The services and companies mentioned above use their databases to:
	- send letters or emails to employees, clients or customers
	- manage appointments
	- track the products customers buy
	- serve adverts based on what a user searches for
	- suggest related videos, depending on videos a user has already watched
	- know which friends two individuals have in common
	- keeps track of the most popular dishes on the canteen menu so that it always has enough to serve to 

students.

Databases vs. paper
•	 Databases can store huge amounts of data without taking up any space in the real world.
•	 It is much quicker to query or search a database than it is to riffle through hundreds or even thousands of 

paper records.
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Database password accepted.
Press OK to proceed.

Advantages of using a database
•	 It is easy to add to or amend existing records.
•	 Data can be sorted easily, e.g. date first registered.
•	 Other applications can import data, for example mail-merge templates make use of databases to send 

personalised letters to customers.
•	 Multiple people can access a database at the same time.
•	 Security can be better than paper files, e.g. using a password to view or edit a file.

Allow learners to complete as many of the questions as they can on the worksheet after watching the short 
video from YouTube at:  
https://www.youtube.com/watch?time_continue=25&v=BUE-XJEHp7g

Phase 3: End of task
Ask learners to self-assess their work by going over the answers with them.
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Ask the more able learners to attempt Activity 5.2 in the Learner’s Book. Discuss the answers to 
Activity 5.2 and how they are reached with the class.

Extension activity

Answers to Task 2 worksheet
Task 2.1
1.	 d
2.	 b
3.	 f
4.	 e
5.	 c
6.	 a

Task 2.2
1.	 Flat-file: A single table or list of items about one business, e.g. a list of all the items in a storeroom.
2.	 Relational: A database with two or more tables that are linked, such as products table and customers 

details table linked by common primary keys.
3.	 Online: A search is a collection of links holding online information stored on web servers all over the 

internet.
4.	 Back-end: A large business that stores the list of stock and lists of customers’ details on their servers, 

such as supermarket or airline websites.
5.	 Mobile: Lists of contact details on a mobile phone.
6.	 Centralised: All the database details are stored in the main branch’s databases and authorised staff 

have to go through the centralised database to operate their business transactions, for example for 
large banks.

Task 2.3
Learners’ answers will vary.

Answers to Activity 5.2 Study a database table� Learner's Book page 74

1.	 Item or In stock
2.	 Make
3.	 Number = Auto number 

Electric = Boolean or Yes/No 
In stock = Boolean or Yes/No 
Gears = Number 
Make = Short text 
Item = Short text

4.	 8 
5.	 3 

Task 3 of 20

Sub-strand 1: Introduction to databases, algorithms, and programming languages (e.g. MS Excel, 
Scratch, VB.Net, etc.)
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Content standard: B6.5.1.1.2 Demonstrate how to 
manipulate databases.

Indicator: B6.5.1.1.2 Identify databases and data 
structures.

Performance indicator: 
ALL learners will be able to identify databases. 

SOME learners will be able to identify data 
structures.

FEW learners will be able to identify databases 
and data structures.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: flat-file database, relational database, field, row, currency data type, yes/no data type, text 
data type, number data type

In this task: 
The teacher should use the Learner’s Book to explain and describe the different types of databases and 
data types.

Learners should complete Worksheet Task 3_B6.5.1.1.2 Identify databases features.pdf.

Resources required� Learner’s Book pages 72–74

Downloadable content
•	 Worksheet Task 3_ B6.5.1.1.2 Identify databases features.pdf

Phase 1: Start of task
List examples of databases found everywhere in life, such as a wardrobe, a refrigerator, a grocery store, etc.

Phase 2: Main
Refer to the Learner’s Book to for more information to complete the worksheet.

Phase 3: End of task
Word Boggle Game
Learners write down as many words about databases as possible in three minutes. Ask one learner to call 
out their words and all learners with the same words should cross those words off their lists. The next learner 
who still has words left must call out all their words, and again learners must cross those words off their lists. 
Repeat until everyone’s list is crossed off. The learner with most correct words is the winner.

Task 4 of 20

Sub-strand 1: Introduction to databases, algorithms, and programming languages (e.g. MS Excel, 
Scratch, VB.Net, etc.)

Content standard: B6.5.1.1 Demonstrate how to 
manipulate databases.

Indicator: B6.5.1.1.3 Explain fundamental 
database concepts.
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Performance indicator: 
ALL learners will be able to explain some 
fundamental database concepts.

SOME learners will be able to explain most 
fundamental database concepts.

FEW learners will be able to explain all the 
fundamental database concepts.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: flat-file database, relational database, currency, test, number, date and time, yes/no

In this task: 
The teacher should use the Learner’s Book to explain the different types of data, such as currency, text, 
number, date and time, yes/no, etc.

Learners should create group presentations about the different types of data.

Resources required� Learner’s Book pages 74–76

Downloadable content
•	 Worksheet Task 4_B6.5.1.1.3 Explain fundamental database concepts.pdf

Phase 1: Start of task
Refer to the Learner’s Book to explain the different types of data, such as, currency, text, number, date and 
time, yes/no, etc.

Phase 2: Main
•	 Divide learners into groups. Each group must prepare a short presentation on the fundamental key words 

in databases for the next task. Give learners the evaluation criteria for their presentations ahead of time.

Presentation evaluation criteria Yes ✓ No ✗

The content for each fundamental database concept must be correct.

There should be at least five fundamental database words.

There should be pictures on each slide.

The presentation must not be longer than three minutes.

Each group member must explain one database concept.

•	 Allow learners to prepare their presentations during this task and to be ready for presenting and 
evaluating other groups’ presentations during the next task.

Phase 3: End of task
Check that each group is ready for the next task’s presenting and evaluating.
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Ask the more able learners to work together with a few less able learners to attempt Activity 5.3 in the 
Learner’s Book.

Extension activity

Answers to Task 4 worksheet
Task 4.1 

First name Last name Date of 
birth Age Job role Hours Pay rate Total 

weekly pay Tax Net pay

Barry Fromeastenders 2003/04/09 16 Bar Staff 40  GHC 6.00  GHC 240.00  GHC 42.00  GHC 198.00 

Steve Reich 2003/02/02 16 Bar Staff 40  GHC 6.00  GHC 240.00  GHC 42.00  GHC 198.00 

Laxman Siveramakrishnan 2002/10/12 17 Backstage 40  GHC 6.00  GHC 240.00  GHC 42.00  GHC 198.00 

Suzanne Rhinestone 2002/02/24 17 Bar Staff 40  GHC 6.00  GHC 240.00  GHC 42.00  GHC 198.00 

Casper Milktoast 2001/12/12 18 Backstage 40  GHC 8.00  GHC 320.00  GHC 56.00  GHC 264.00 

Anglina Jellie 1999/09/09 20 Office Manager 40  GHC 8.00  GHC 320.00  GHC 56.00  GHC 264.00 

Terrie Toolratchett 1998/08/02 21 Cleaners 40  GHC 8.00  GHC 320.00  GHC 56.00  GHC 264.00 

Kevin Greystoke 1996/01/07 23 Cleaners 40  GHC 9.00  GHC 360.00  GHC 63.00  GHC 297.00 

column fieldfield name

number data 
type field currency data 

type field
text field

table

data item 
in a record

record

row

Answers to Activity 5.3 Apply database concepts� Learner's Book page 77

Answers may vary.
1.	 First name; Last name; Street address; Town; Postcode; Age; Sport type; Goals scored/Games won; 

Coach; Number of games played; Kit 
2–4.	Answers may vary. This is an example table. 

Member Sport Coach

Member number * Sport number * Coach number *

First name Member number ** Member number **

Last name Sport number **

Street address Last name

Town First name

Postcode Phone number

Phone number
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Sport

Won

Coach number **

Sport number **

The key to the table:
* Means the field is a primary key (e.g. in the Member table, the primary key is Member number)
** Means the field is a foreign key in another table (e.g. Member number is a foreign key in both the Sport 

table and the Coach table)

5.	 The key field in each table should be marked in some way.
6.	 Foreign fields: The more able learners may also have highlighted the foreign fields (the key fields 

from other tables) in some way. This is not essential for this level.

Task 5 of 20

Sub-strand 1: Introduction to databases, algorithms, and programming languages (e.g. MS Excel, 
Scratch, VB.Net, etc.)

Content standard: B6.5.1.1 Demonstrate how to 
manipulate databases.

Indicator: B6.5.1.1.3 Explain fundamental 
database concepts.

Performance indicator: 
ALL learners will be able to describe some types of 
database and data types.

SOME learners will be able to describe most types 
of database and data types.

FEW learners will be able to describe all types of 
database and data types.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: flat-file database, relational database, currency, test, number, date and time, yes/no

In this task: 
The teacher should ensure that groups do their presentations during this task.

Learners should present their group presentations about the different fundamental database concepts.

Resources required� Learner’s Book pages 76–79

Phase 1: Start of task
Allow learners to do their presentations in this task.

Phase 2: Main
Groups should be presenting in this task. Each group has only three minutes to present and two minutes for 
evaluations. Learners use the same evaluation criteria as in Task 4.
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Presentation evaluation criteria Yes ✓ No ✗

The content for each fundamental database concept must be correct.

There should at least five fundamental database words.

There should be pictures on each slide.

The presentation must not be longer than three minutes.

Each group member must explain one database concept.

Phase 3: End of task
Discuss the overall quality of the learners’ efforts and correct any misunderstandings about databases and 
the different data types.

Task 6 of 20

Sub-strand 1: Introduction to databases, algorithms, and programming languages (e.g. MS Excel, 
Scratch, VB.Net, etc.)

Content standard: B6.5.1.1 Demonstrate how to 
manipulate databases.

Indicator: B6.5.1.1.3 Explain fundamental 
database concepts.

Performance indicator: 
ALL learners will be able to describe some types of 
database and data types.

SOME learners will be able to describe most types 
of database and data types.

FEW learners will be able to describe all types of 
database and data types.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: flat-file database, relational database, currency, test, number, date and time, yes/no

In this task: 
The teacher should allow learners to continue doing their group presentations during this task.

Learners should present their group presentations about the different fundamental database concepts.

Resources required� Learner’s Book pages 76–79

Phase 1: Start of task
Allow learners to do their presentations in this task.

Phase 2: Main
Groups should be presenting in this task. Each group has only three minutes to present and two minutes for 
evaluations. They use the same evaluation criteria as in the previous task.
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Presentation evaluation criteria Yes ✓ No ✗

The content for each fundamental database concept must be correct.

There should at least five fundamental database words.

There should be pictures on each slide.

The presentation must not be longer than three minutes.

Each group member must explain one database concept.

Phase 3: End of task
Discuss overall quality of the learners’ efforts and correct any misunderstandings about databases and the 
different data types.

Task 7 of 20

Sub Strand 1: Introduction to databases, algorithms, and programming languages (e.g. MS Excel, 
Scratch, VB.Net, etc.)

Content standard: B6.5.1.1 Demonstrate how to 
manipulate databases.

Indicator: B6.5.1.1.5 Describe the basics of the 
relational data model.

Performance indicator: 
ALL learners will be able to describe some basics 
of the relational data model.

SOME learners will be able to describe most of the 
basics of the relational data model.

FEW learners will be able to describe all the basics 
of the relational data model.

Core competencies:
1. 	 Creativity and innovation
2. 	 Communication and collaboration
3. 	 Cultural identity and global citizenship
4. 	 Personal development and leadership
5. 	 Digital literacy

Key words: relational database, key fields, data redundancy, linking 

In this task: 
The teacher should explain how to link data in two separate tables by using key fields.

Learners should complete Worksheet Task 7_B6.5.1.1.5 Relational databases.pdf.

Resources required� Learner’s Book pages 78–79

Downloadable content
•	 Worksheet Task 7_B6.5.1.1.5 Relational databases.pdf

Phase 1: Start of task
Consider the family tree in Task 7.1 of Worksheet Task 7_B6.5.1.1.5 Relational databases.pdf and then 
answer the questions.
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Phase 2: Main
•	 Using the Learner’s Book section of relational databases, explain how separate tables can be linked by 

using a common linking field, a key field.
•	 Learners should complete Worksheet Task 7_B6.5.1.1.5 Relational databases.pdf.

Phase 3: End of task
Recap the meaning of the key words: relationship, key field, field, record.

Arrange learners to work in pairs to complete Activity 5.4 in the Learner’s Book. 

Extension activity

Answers to Task 7 worksheet
Task 7.1 
1.	 Ekua
2.	 Dofi
3.	 His surname is the same as his father's.

Task 7.2
1. 	 Orders, Order Details and Products
2.	 orderID, productID, quantity, lineNumber
3.	 orderID
4.	 productId
5.	 field
6.	 CustomerID then productID 

Answers to Activity 5.4 Write a query� Learner's Book page 81

1.	 Completed as an example.
2.	 Country = Qatar AND AmountSpent > 200000.00
3.	 TravellerType = Business AND Favourite = Victoria Falls
4.	 Gender = Female AND AmountSpent >= 250000.00
5.	 Short text and number (Accept the answer if they chose Currency).
6.	 Any three from the data types and uses that they have learnt.

Task 8 of 20

Sub-strand 1: Introduction to databases, algorithms, and programming languages (e.g. MS Excel, 
Scratch, VB.Net, etc.)

Content standard: B6.5.1.1 Demonstrate how to 
manipulate databases.

Indicator: B6.5.1.1.6 Identify the basics of logical 
database design.
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Performance indicator: 
ALL learners will be able to identify some of the 
basics of logical database design.

SOME learners will be able identify most of the 
basics of logical database design.

FEW learners will be able to identify the basics of 
logical database design.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: relational database, key fields, data redundancy, linking 

In this task: 
The teacher should explain how using a logical database design is important for linking data in the 
separate tables and extracting sensible information from a database.

Learners should complete Worksheet Task 8_B6.5.1.1.6 Logical database design.pdf.

Resources required� Learner’s Book pages 79–81

Downloadable content
•	 Worksheet Task 8_B6.5.1.1.6 Logical database design.pdf

Phase 1: Start of task
Learners work in pairs and create a Wordle (word cloud) using as many of the key words about databases as 
possible. They then join another pair in the class and compare their Wordles and briefly discuss the words.

Phase 2: Main
•	 Using the Learner’s Book section of relational databases, explain how designing a database logically 

in separate tables that can be linked by using key fields is important to be able to extract sensible 
information from the database. 

•	 Learners should complete Worksheet Task 8_B6.5.1.1.6 Logical database design.pdf. 

Phase 3: End of task
Recap the meaning of the key words: relationship, key field, field, record.

Task 9 of 20

Sub-strand 1: Introduction to databases, algorithms, and programming languages (e.g. MS Excel, 
Scratch, VB.Net, etc.)

Content standard: B6.5.1.1 Demonstrate how to 
manipulate databases.

Indicator: B6.5.1.1.7 Illustrate the basics of 
relational algebra.

Performance indicator: 
ALL learners will be able to identify some of the 
basics of relational algebra.

SOME learners will be able identify most of the 
basics of relational algebra. 

FEW learners will be able to identify the basics of 
relational algebra.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy
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Key words: select, union, rename, project, set different, Cartesian product

In this task: 
The teacher should read and explain each algebraic operation as learners complete the worksheet. Refer 
to the article in the downloadable content: What is Relational Algebra?

Learners should complete Worksheet Task 9_B6.5.1.1.7 Basics of relational algebra.pdf.

Resources required� Learner’s Book pages 78–79

Downloadable content
•	 Worksheet Task 9_B6.5.1.1.7 Basics of relational algebra.pdf
•	 Article_ What is Relational Algebra.pdf

Phase 1: Start of task
Read the first few paragraphs of the article, ‘What is Relational Algebra?’ to the class.

Phase 2: Main
•	 Read and explain each algebraic operation as learners complete their worksheets. Refer to the Article_ 

What is Relational Algebra.pdf from the downloadable content and the relevant section in the Learner’s 
Book for more information. 

•	 Learners should complete Worksheet Task 9_B6.5.1.1.7 Basics of relational algebra.pdf.

Phase 3: End of task
Recap the meaning of the key words: select, union, rename, project, set different, Cartesian product

Task 10 of 20

Sub-strand 1: Introduction to databases, algorithms, and programming languages (e.g. MS Excel, 
Scratch, VB.Net, etc.)

Content standard: B6.5.1.1 Demonstrate 
how to manipulate databases.

Indicator: B6.5.1.1.8 Operate basic SQL: querying and 
manipulating data.

Performance indicator: 
ALL learners will be able to operate some 
basic SQL: querying and manipulating data.

SOME learners will be able to operate most 
basic SQL: querying and manipulating data.

FEW learners will be able to operate the 
basic SQL: querying and manipulating data.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: create database, select, update

In this task: 
The teacher should use the online tutorials in Khan Academy on SQL to query and manipulate data.

Learners should complete the tasks online on the Khan Academy portal to gain practical experience in 
manipulating data through SQL queries.
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Resources required� Learner’s Book pages 79–81

Phase 1: Start of task
Ensure that all learners will be able to access the online Khan Academy portal (see link below) and be ready 
to learn how to manipulate data in a database by using SQL queries. 
https://www.khanacademy.org/computing/computer-programming/sql/sql-basics/pt/querying-the-table

Phase 2: Main
Support learners who are struggling as required.

Phase 3: End of task
Learners should screenshot their results from the challenges set out in the exercises and show their teacher.

Sub-strand 2: Introduction to electronic spreadsheets

Task 11 of 20

Sub-strand 2: Introduction to electronic spreadsheet (tabs and ribbons manipulation)

Content standard: B6.5.1.1 Demonstrate how to 
use spreadsheets.

Indicator: B6.5.3.1.1 Demonstrate how to use the 
groups on the Home tab.  

Performance indicator: 
ALL learners will be able to demonstrate how to 
use some of the groups on the Home tab.

SOME learners will be able to demonstrate how to 
use most of the groups on the Home tab.

FEW learners will be able to demonstrate how to 
use the groups on the Home tab.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: clipboard, styles, font, alignment, cells, editing, ideas, number

In this task: 
The teacher should demonstrate where to locate the Excel Home tab so that learners can explore it and 
prepare to do presentations to their peers in the next two tasks, based on the given set of evaluation 
criteria.

Learners should work through the worksheet and refer to the Learner’s Book in the section on the Home 
tab. Learners will be preparing to do group presentations during the next two tasks.

Resources required� Learner’s Book page 83

Downloadable content
•	 Worksheet Task 11_B6.5.3.1.1 MS Excel Home tab.pdf

Phase 1: Start of task
Explain that learners will learn about the groups on the Home tab of Excel and must prepare to do group 
presentations during the next two tasks, using the given evaluation criteria included in the worksheet.
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Phase 2: Main
•	 Demonstrate what some of the groups on the Home tab can do and allow learners to work through 

Worksheet Task 11_B6.5.3.1.1 MS Excel Home tab.pdf in order to prepare for their group presentations.
•	 Divide the class into eight groups and explain what the evaluation criteria mean and how they will be 

awarded points for their group presentations.

Phase 3: End of task
Check that all learners are ready to present during the next task because everyone will be evaluating their 
peer groups during the group presentations.

Task 12 of 20

Sub-strand 2: Introduction to electronic spreadsheet (tabs and ribbons manipulation)

Content standard: B6.5.1.1 Demonstrate how to 
use spreadsheets.

Indicator: B6.5.3.1.1 Demonstrate how to use the 
group on the Home tab.

Performance indicator: 
ALL learners will be able to demonstrate how to 
use some of the groups on the Home tab.

SOME learners will be able to demonstrate how to 
use most of the groups on the Home tab.

FEW learners will be able to demonstrate how to 
use the groups on the Home tab.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: clipboard, styles, font, alignment, cells, editing, ideas, number

In this task: 
The teacher should allow learners to do their group presentations and evaluations when they are not 
presenting in their groups.

Learners should do their group presentations and evaluations when they are not presenting in their groups.

Resources required� Learner’s Book pages 84–86

Downloadable content
•	 Worksheet Tasks 12–13_B6.5.3.1.1 Evaluation Sheet_MS Excel presentation.pdf

Phase 1: Start of task
Ensure that all groups are ready to do their group presentations and that everyone has their evaluation 
sheets ready.

Phase 2: Main
Allow learners to conduct their group presentations. The groups not presenting must evaluate each group’s 
presentation using Worksheet Task 12_B6.5.3.1.1 Evaluation sheet_MS Excel presentation.pdf.

Phase 3: End of task
Check that the learners who have not yet presented are ready to present during the next task. 
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Task 13 of 20

Sub-strand 2: Introduction to electronic spreadsheet (tabs and ribbons manipulation)

Content standard: B6.5.1.1 Demonstrate 
how to use spreadsheets.

Indicator: B6.5.3.1.1 Demonstrate how to use the tabs 
under the Home tab. 

Performance indicator: 
ALL learners will be able to demonstrate how 
to use some of the groups on the Home tab.

SOME learners will be able to demonstrate 
how to use most of groups on the Home tab.

FEW learners will be able to demonstrate 
how to use the groups on the Home tab,

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: clipboard, styles, font, alignment, cells, editing, ideas, number

In this task: 
The teacher should allow learners to do their group presentations and evaluations when they are not 
presenting in their groups.

Learners should do their group presentations and evaluations when they are not presenting in their groups.

Resources required� Learner’s Book pages 83–86

Downloadable content
•	 Worksheet Tasks 12–13_B6.5.3.1.1 Evaluation Sheet_MS Excel presentation.pdf

Phase 1: Start of task
Ensure that all groups are ready to do their group presentations and that everyone has their evaluation 
sheets from Task 12 ready.

Phase 2: Main
Allow learners to conduct their group presentations. The groups not presenting must evaluate each group’s 
presentation using the same worksheets for Task 12: Worksheet Task 12_B6.5.3.1.1 Evaluation sheet_MS 
Excel presentation.pdf.

Phase 3: End of Task
Recap the meanings of some of the key words. 

Task 14 of 20

Sub-strand 2: Introduction to electronic spreadsheet (tabs and ribbons manipulation)

Content standard: B6.5.1.1 Demonstrate how to 
use spreadsheets.

Indicator: B6.5.3.1.2 Create basic workbooks in 
MS Excel. 
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Performance indicator: 
ALL learners will be able to create one basic 
worksheet in Excel.

SOME learners will be able to create basic 
worksheets in Excel.

FEW learners will be able to create basic 
worksheets in Excel.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: workbook, average, range, subtract

In this task: 
The teacher should demonstrate how to create a basic workbook in Excel, using the worksheet guidance 
notes and the section in the Learner’s Book on how to create basic worksheets.

Learners should use the worksheet guidance notes and the section in the Learner’s Book on how to 
create basic worksheets.

Resources required� Learner’s Book pages 86–87

Downloadable content
•	 Worksheet Task 14_B6.5.3.1.2 Create MS Excel workbooks.pdf

Phase 1: Start of task
•	 Ask learners to do these simple arithmetic calculations in pairs. 

Find the average of 26, 45, 73 and 16 (Answer = 40) 
Find the range of 87, 35, 29, 97 (Answer =: 68)

•	 Ask learners to describe the steps they took to do these calculations.  
(Answer: To calculate the average, you must add up all the numbers and then divide by the amount of 
numbers you added together. 
Answer: To calculate the range, you must subtract the lowest number from the highest number.)

Phase 2: Main
•	 Allow learners to watch the first part of the video (follow the link below) or refer to the Learner’s Book 

section on performing calculations in Excel.  
https://youtube.com/watch?v=9Ye45qRwOcY

•	 Learners complete Worksheet Task 14_B6.5.3.1.2 Create MS Excel workbooks.pdf.

Phase 3: End of task
Check answers at the end of the task. Ask learners to indicate whether they got it right and if not, where they 
thought they went wrong and how they could do the calculations correctly next time.

Group learners into mixed ability groups and ask them to attempt Activity 5.5 in the Learner’s Book. 

Extension activity
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Answers to Task 14 worksheet
Task 14.1  

A

1

2

3

4

5

6

7

8

B C D E F G H I J K L M N

Accra monthly temperatures
AverageJAN FEB MAR APR MAY JUN JUL AUG SEP OCT NOV DEC

93

Range

18

99 100 100 98 91 84 82 87 91 97 94 95

Task 14.2
You would add all the temperature together and then divide by 12 (the number of months in the year). You 
should get an answer of 93.

Task 14.3
1.	

A

1

2

3

4

5

6

7

8

B C D E F G H I J K L M N O

Accra Monthly Temperatures

=AVERAGE(B4:M4)

JAN FEB MAR APR MAY JUN JUL AUG SEP OCT NOV DEC

99 100 100 98 91 84 82 87 91 97 94 95

2. 	 A

1

2

3

5

6

7

B C D E F G H I J K L M N O P Q

Accra Monthly Temperatures
JAN FEB MAR APR MAY JUN JUL AUG SEP OCT NOV DEC

99 100 100 98 91 84 82 87 91 97 94 95 934

Average

Range

A

1

2

3

4

5

6

8

B C D E F G H I J K L M N O

Accra Monthly Temperatures

=AVERAGE(B4:M4)

=100–82

JAN FEB MAR APR MAY JUN JUL AUG SEP OCT NOV DEC

99 100 100 98 91 84 82 87 91 97 94 95

7



74

Strand 5: Programming and databases

A

1

2

3

4

5

6

18

17

16

15

14

13

12

11

10

9

8

B C D E F G H I J K L M N

Accra Monthly Temperatures
AverageJAN FEB MAR APR MAY JUN JUL AUG SEP OCT NOV DEC

93

Range

18

99 100 100 98 91 84 82 87 91 97 94 95

7

Answers to Activity 5.5 Revise the clipboard and fonts� Learner's Book page 84

Feature Button or action

Put a copy of the selection on the clipboard. Click the copy button

Select the content with the format you like. Drag mouse over the content to select it.

Apply a single line under your text. Select the content then click on the button U

Remove the selection and put it on the clipboard 
so that you can use it somewhere else.

Select the content. Click on the scissors.

Colour the background of cells to make them 
stand out.

Select the cell in a table and then use the button 
with the jug pouring a colour. Or, select the drop-
down menu under the pouring jug and click the 
colour you want.

Make the text a bit smaller. Highlight the text, use the drop-down menu in 
the Font size box and click on the size wanted. Or, 
select the text then use the shortcut key, (Ctrl+]).

Centre the content horizontally. Click the Centre text button in the Paragraph group.

Task 15 of 20

Sub-strand 2: Introduction to Electronic Spreadsheet (Tabs and Ribbons Manipulation)

Content standard: B6.5.1.1 Demonstrate how to 
use spreadsheets.

Indicator: B6.5.3.1.3 Perform calculations in an 
MS Excel worksheet. 
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Performance indicator: 
ALL learners will be able to perform addition 
calculations in an Excel worksheet. 

SOME learners will be able to perform addition 
and subtraction calculations in an Excel 
worksheet. 

FEW learners will be able to perform addition, 
subtraction, and multiplication calculations in an 
Excel worksheet.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: workbook, addition, sum, subtract, multiply, divide

In this task: 
The teacher should demonstrate how to perform calculations in an Excel worksheet, using the worksheet 
guidance notes and the section in the Learner’s Book on how to perform calculations in an MS Excel 
worksheet.

Learners should use the worksheet guidance notes and the section in the Learner’s Book on how to 
perform calculations in an Excel worksheet.

Resources required� Learner’s Book pages 86–87

Downloadable content
•	 Worksheet Task 15_B6.5.3.1.3 Perform calculations in MS Excel.xlsx.

Phase 1: Start of task
•	 Give learners access to the spreadsheet Worksheet Task 15_B6.5.3.1.3 Perform calculations in  

MS Excel.xlsx. 
•	 Explain what learners need to do and that their scores will be shown automatically once they have 

completed working in the spreadsheet itself. Learners can progress at their own pace.

Phase 2: Main
•	 Allow learners to watch the video or refer to the Learner’s Book section on performing calculations in Excel 

to see how to carry out the calculations in the worksheet. 
https://www.youtube.com/watch?v=BY8nX0CLIpU

•	 Learners complete Worksheet Task 15_B6.5.3.1.3 Perform calculations in MS Excel.xlsx.

Phase 3: End of task
Check answers at the end of the task. Ask learners to indicate whether they got it right and if not, where they 
thought they went wrong and how they could do the calculations correctly next time.

Ask learners to attempt Activity 5.6 in the Learner’s Book and to share their answers with their peers in 
their groups. 

Extension activity
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Answers to Activity 5.6 Create a worksheet� Learner's Book page 85

The completed spreadsheet for this activity should look like exactly the spreadsheet example in the 
Learner’s Book. Learners must name their saved spreadsheet Fried Plantains.

Task 16 of 20

Sub-strand 2: Introduction to electronic spreadsheet (tabs and ribbons manipulation)

Content standard: B6.5.1.1 Demonstrate how to 
use spreadsheets.

Indicator: 
B6.5.3.1.4 Modify an MS Excel worksheet. 
B6.5.3.1.5 Modify the appearance of data within a 
worksheet.

Performance indicator: 
ALL learners will be able to modify an Excel 
worksheet and the appearance of some data 
within a worksheet.

SOME learners will be able to modify an Excel 
worksheet and the appearance of most data 
within a worksheet.

FEW learners will be able to modify an Excel 
worksheet and the appearance of data within a 
worksheet.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: delete, cut, insert, hide, format, align, replace

In this task: 
The teacher should demonstrate how to do a few modifications in an Excel worksheet. Divide the class 
into seven groups to prepare for teach-backs on how to modify an Excel spreadsheet, using the groups on 
the Home tab. Evaluation criteria will be given as well.

Learners should prepare their assigned topic for the teach-back tasks over the next two tasks.

Resources required� Learner’s Book page 85

Downloadable content
•	 Worksheet Task 16_B6.5.3.1.5 Evaluation sheet_Modify MS Excel worksheets.pdf

Phase 1: Start of task
Divide the class into seven groups. Assign one topic to each group: Clipboard, Font, Alignment, Number, 
Styles, Cells, Editing.

Phase 2: Main
•	 Allow learners to research how to carry out the tasks for their topic by referring to the Learner’s Book and 

to use any YouTube online videos or resources they find.
•	 Ensure that learners have access to all the resources they need to prepare properly for their teach-backs 

over the next two tasks.
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•	 Give them a copy of the Worksheet Task 16_B6.5.3.1.5 Evaluation sheet_Modify MS Excel  
worksheets.pdf. Remind learners to think about the evaluation criteria as they are preparing for their 
teach-backs. They will be awarded ONE point for each criterion that is fully met.

Phase 3: End of task
Ensure all learners are fully prepared for their teach-backs during the next two tasks.

Task 17 of 20

Sub-strand 2: Introduction to electronic spreadsheet (tabs and ribbons manipulation)

Content standard: B6.5.1.1 Demonstrate how to 
use spreadsheets.

Indicator: 
B6.5.3.1.4 Modify an MS Excel worksheet. 
B6.5.3.1.5 Modify the appearance of data within a 
worksheet.

Performance indicator: 
ALL learners will be able to modify an Excel 
worksheet and the appearance of some data 
within a worksheet.

SOME learners will be able to modify an Excel 
worksheet and the appearance of most data 
within a worksheet.

FEW learners will be able to modify an Excel 
worksheet and the appearance of data within a 
worksheet.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: delete, cut, insert, hide, format, align, replace

In this task: 
The teacher should ensure the classroom is ready for learners to deliver their teach-backs during this 
task.

Learners should deliver their teach-backs during this task and, when they are not delivering, they should 
be evaluating the other groups who are delivering.

Resources required� Learner’s Book page 85

Downloadable content
•	 Worksheet Task 16_B6.5.3.1.5 Evaluation sheet_Modify MS Excel worksheets.pdf

Phase 1: Start of task
Ensure that the first three or four groups are ready to do their teach-backs during this task.

Phase 2: Main
•	 Allow the first three or four groups to do their teach-backs during this task.
•	 Remind learners to use Worksheet Task 16_B6.5.3.1.5 Evaluation sheet_Modify MS Excel worksheets.

pdf to evaluate each group as they are delivering their teach-backs.
•	 They should award one point for each criterion that is fully met.
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Phase 3: End of task
Ensure that the last three or four groups of learners are also fully prepared for their teach-backs during the 
next task.

Task 18 of 20

Sub-strand 2: Introduction to electronic spreadsheet (tabs and ribbons manipulation)

Content standard: B6.5.1.1 Demonstrate how to 
use spreadsheet.pdf

Indicator: 
B6.5.3.1.4 Modify an MS Excel worksheet. 
B6.5.3.1.5 Modify the appearance of data within a 
worksheet.

Performance indicator: 
ALL learners will be able to modify an Excel 
worksheet and the appearance of some data 
within a worksheet.

SOME learners will be able to modify an Excel 
worksheet and the appearance of most data 
within a worksheet.

FEW learners will be able to modify an Excel 
worksheet and the appearance of data within a 
worksheet.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: delete, cut, insert, hide, format, align, replace

In this task: 
The teacher should ensure the classroom is ready for learners to deliver their teach-backs during this 
task.

Learners should deliver their teach-backs during this task and, when they are not delivering, they should 
be evaluating the other groups who are delivering.

Resources required� Learner’s Book pages 83–88

Downloadable content
•	 Worksheet Task 16_B6.5.3.1.5 Evaluation sheet_Modify MS Excel worksheets.pdf

Phase 1: Start of task
Ensure that the last three or four groups are ready to do their teach-backs during this task.

Phase 2: Main
•	 Allow the last three or four groups of learners to do their teach-backs during this task.
•	 Remind learners to evaluate each group as they are delivering their teach-backs.
•	 They should award ONE point for each criterion that is fully met. They continue to do their evaluations on 

Worksheet Task 16_B6.5.3.1.5 Evaluation sheet_Modify MS Excel worksheets.pdf.
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Phase 3: End of task
Praise the learners for their efforts and ask them to reflect on how they believe their teach-backs could have 
been improved.

Task 19 of 20

Sub-strand 2: Introduction to electronic spreadsheet (tabs and ribbons manipulation)

Content standard: B6.5.1.1 Demonstrate how to 
use spreadsheets.

Indicator: B6.5.3.1.6 Manage MS Excel worksheets.

Performance indicator: 
ALL learners will be able to manage Excel 
worksheets by renaming.

SOME learners will be able to manage Excel 
worksheets by storing in folders.

FEW learners will be able to manage Excel 
worksheets by renaming and storing in folders.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: rename

In this task: 
The teacher should demonstrate how to rename worksheets and store them in folders.

Learners should create short videos or movies using Windows tools, such as Photos, to create short 
movies or use their mobile phones to create short videos on how to manage Excel worksheets.

Resources required� Learner’s Book pages 83–86

Downloadable content
•	 Worksheet Task 19_B6.5.3.1.6 Assessment_Manage MS Excel workbook video.pdf

Phase 1: Start of task
Learners should work in pairs or groups of three to create short videos or movies on how to rename 
worksheets and to store in folders for retrieval later.

Phase 2: Main
•	 Suggest that learners could create videos using their mobile phones but would need to prepare a script 

about what they were going to say while demonstrating.
•	 If learners choose to create movies, they could use Windows Photos and save some pictures to drag and 

drop onto the storyboard. Remind them to create a title for the movie and to end it with credits. 
•	 Give them copies of Worksheet Task 19_B6.5.3.1.6 Assessment_Manage MS Excel workbook video.pdf 

so that they know how their videos will be evaluated. 

Phase 3: End of task
Praise the learners for their efforts and ask them to reflect on how they believe their video or movie could be 
improved.
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Task 20 of 20

Sub-strand 2: Introduction to electronic spreadsheet (tabs and ribbons manipulation)

Content standard: B6.5.1.1 Demonstrate how to 
use spreadsheets.

Indicator: B6.5.3.1.7 Print the content of an MS 
Excel worksheet.

Performance indicator: 
ALL learners will be able to print the content of an 
Excel worksheet. 

SOME learners will be able to print the content of 
an Excel worksheet. 

FEW learners will be able to print the content of an 
Excel worksheet. 

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: print preview, page setup, grid

In this task: 
The teacher should demonstrate how to prepare an Excel worksheet for printing by using the Print 
command in the Page Setup tab.

Learners should watch the presentation demonstration and refer to their Learner’s Book in order to 
prepare their worksheets for printing as an Excel worksheet.

Resources required� Learner’s Book pages 83–86

Downloadable content
•	 Presentation Task 20_B6.5.3.1.7 Print MS Excel worksheet.pptx
•	 Worksheet Task 14_B6.5.3.1.2 Create MS Excel workbooks.pdf

Phase 1: Start of task
Demonstrate, using the Presentation Task 20_B6.5.3.1.7 Print MS Excel worksheet.pptx.

Phase 2: Main
•	 Learners should open their spreadsheets from Worksheet Task 14_B6.5.3.1.2 Create MS Excel  

workbooks.pdf and prepare it for printing.
•	 They should hand their printed Excel worksheets to you.

Phase 3: End of task
Ask learners to use all the key words in the task on spreadsheets to create a Wordle or word cloud.

Arrange learners into small mixed ability groups of three or four so that they can work collaboratively 
on Activity 5.7 in the Learner’s Book. 

Extension activity
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Answers to Activity 5.7 Format a worksheet� Learner's Book pages 85–86

Learners’ worksheets should look like the example on page 86 of the Learner’s Book.

Answers to Activity 5.8 Use formulas in a spreadsheet � Learner's Book page 87

Learners adjust and copy the formula they used in Activity 5.7. 

Answers to Activity 5.9 Print a spreadsheet � Learner's Book page 88

Learners check the orientation, change the margins, then preview and print their spreadsheets. 
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1.	 a)	 Database: An organised collection of data
b)	 Table: A collection of records holding data arranged in fields
c)	 Query: A question asked to find information from table(s) of data in a database
d)	 Sort: To re-arrange data in a table e.g. sorting the table by date, numbers or alphabetically
e)	 Field: One piece of data in a database table. Fields are stored in columns in the table.
f)	 Record: All the data about one person or thing held in a database row
g)	 Primary key: A unique field where data is of one kind. To query more than one table at the 

same time, in a relational database, every table must have a key field. 
h)	 Foreign key: A key field when it appears in a different table

2.	 =AVERAGE(F7.F27)

3.	 To wrap text in a spreadsheet means that instead of text overflowing into the next cell, you can 
make it stay in one cell only by wrapping it around, just as it does at the end of a row in a word 
processor.  
To wrap text, click in the cell to make it the active cell then, on the Home tab, click Alignment, then 
Wrap text.

Check your progress
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Strand 6: Internet and social media

Introduction
In this strand, you can expect to cover many different topics ranging from networks to web browsers 
and the World Wide Web.

Tasks in Strand 6 are covered in ten sub-strands as follows:
•	 Networks and how the internet works
•	 Web browsers and web pages, including home pages, favourites and hyperlinks
•	 Surfing the World Wide Web, including creating favourites, search engines and smart search engines
•	 Favourite place and search engines, including how to handle search results
•	 Using online forms, including working online, offline and downloading files and folders
•	 Customising your browser, including how to set default search engines, home pages, apps, add-ons 

and plug-ins
•	 Electronic mail including creating and using different email accounts
•	 Internet of Things (IoT), including its purpose, examples, components and the role of sensors in the 

IoT
•	 Digital literacy, including digital safety and describing personal and private information
•	 Digital literacy, including defining what a digital footprint is and the application of netiquette.

Sub-strand 1: Network overview

Task 1 of 47

Sub-strand 1: Network overview

Content standard: B6.6.1.1 Demonstrate 
how to network computers.

Indicator: B6.6.1.1.1 
Give examples of facilities the internet offers.

Performance indicator: 
ALL learners will be able to give some 
examples of facilities the internet offers.

SOME learners will be able to give many 
examples of facilities the internet offers.

FEW learners will be able to give a lot of 
examples of facilities the internet offers.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: email, www, ftp, smtp, https, VoIP, http, protocols

In this task: 
The teacher should refer to the Learner’s Book for information and definitions of the different types of 
facilities offered by the internet (protocols) and assist learners to answer the worksheet questions.

Learners should refer to the Learner’s Book and use the internet to find more information to answer the 
questions in the worksheet.



84

Strand 6: Internet and social media

Resources required� Learner’s Book page 92

Downloadable content
•	 Worksheet Task 1_B6.6.1.1.1 Internet facilities (protocols).pdf

Phase 1: Start of task
In pairs, discuss: True or False: You can find information about everything on the internet.

Phase 2: Main
•	 Refer to the Learner’s Book for more information about the different facilities offered by internet protocols, 

such as email, web addresses, secure web addresses, voice over internet protocol (VoIP), and file transfer 
protocol (FTP).

•	 Learners complete Worksheet Task 1_B6.6.1.1.1 Internet facilities (protocols).pdf.

Phase 3: End of task
Learners share their newspaper headlines with the class and discuss which ones are the most appropriate.

Answers to Task 1 worksheet
Task 1.1
Answers will vary.

Task 1.2
1.	 ftp: File transfer protocol issued for transferring large files.
2.	 http: Web page addresses start with http and they transfer web pages from the servers where they are 

stored to clients requesting information in those web pages.
3.	 IP: All devices on the internet have a unique IP (internet protocol) address from which they can send and 

receive Information. 
4.	 SMTP or POP3: SMTP is used to send emails and POP3 is used to receive emails.
5.	 VoIP: Voice over Internet protocol allows voice conversations to go over the internet.
6.	 https: This protocol secures web addresses by using encryption.

Task 1.3
Answers will vary.

Task 2 of 47 

Sub-strand 1: Network overview

Content standard: B6.6.1.1 Demonstrate how to 
network computers.

Indicator: B6.6.1.1.2 Describe the types of 
information available on the internet.

Performance indicator: 
ALL learners will be able to describe some types of 
information available on the internet.

SOME learners will be able to describe most of the 
types of information available on the internet.

FEW learners will be able to describe many types 
of information available on the internet.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy
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Key words: educational, financial, entertainment, manufacturing, geographical, scientific, legal, 
governmental, transport, shopping

In this task: 
The teacher should refer to the Learner’s Book for information and definitions of the different types of 
facilities offered by internet protocols and assist learners to answer the worksheet questions.

Learners should refer to the Learner’s Book and use the internet to find more information to answer the 
questions in the worksheet.

Resources required� Learner’s Book page 93

Downloadable content
•	 Worksheet Task 2_B6.6.1.1.2 Types of information available on the internet.pdf 

Phase 1: Start of task
Divide the class into small groups or pairs. Give each group or pair of learners a flash card with a key word 
and Worksheet Task 2_B6.6.1.1.2 Types of information available on the internet.pdf. They should use 
the mind map to brainstorm all the different types of information they could find on their topic by using the 
internet (Worksheet Task 2.1).

Phase 2: Main
Learners refer to the Learner’s Book for more information about the different types of information found on 
the internet. 

Phase 3: End of task
In pairs, learners discuss whether they should trust all the information they find on the internet (Worksheet 
Task 2.3).

Learners can work in pairs to discuss the question in the extension activity (Task 2.3) on the worksheet.

Extension activity

Answers to Task 2 worksheet
Task 2.1
Answers will vary. 

Task 2.2
1.	 A computational search engine is a facility that uses the information from different websites to compute 

an answer to a question you pose in the computational search engine. An example is Wolfram Alpha. It 
can solve algebraic problems, chemical equations, find differences between things, etc.

2.	 According to some sources of information on the internet, there are cures for some types of cancer but 
there are not any cures for all types of cancers.

3.	 NASA experts say from 2040.
4.	 Yes, according to mediums who communicate with departed loved ones. 

Task 2.3 (Extension)
Anyone can publish information on the World Wide Web, therefore it should not be trusted too readily. There 
is a lot of fake news out there. 
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Task 3 of 47

Sub-strand 1: Network overview

Content standard: B6.6.1.1 Demonstrate how to 
network computers.

Indicator: B6.6.1.1.2 Identify data duplication.

Performance indicator: 
ALL learners will be able to identify some 
examples of data duplication.

SOME learners will be able to identify most 
examples of data duplication.

FEW learners will be able to identify data 
duplication.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: data duplication, data deduplication, storage

In this task: 
The teacher should refer to the Learner’s Book for information on data duplication and assist learners to 
answer the worksheet questions.

Learners should refer to the Learner’s Book and use the internet to find more information to answer the 
questions in the worksheet.

Resources required� Learner’s Book pages 93–94

Downloadable content
•	 Worksheet Task 3_B6.6.1.1.3 Identify data duplication.pdf

Phase 1: Start of task
Allow learners to do Task 3.1 of the worksheet. Discuss the answers with them before proceeding to Task 3.2.

Phase 2: Main
Refer to the Learner’s Book for more information about data duplication. Learners complete the tasks on 
Worksheet Task 3_B6.6.1.1.3 Identify data duplication.pdf.

Phase 3: End of task
In pairs, learners discuss the reasons, in computing terms, why it is important to identify duplicated data. 

Answers to Task 3 worksheet
Task 3.1
1.	 False
2.	 True
3.	 a)	 If a packet of sweets is in the cupboard, you cannot use it outside the cupboard at the same time; it 

is either in the cupboard or out the cupboard. 
b)	 If you have one item in your Pictures folder on the computer, you can still see a duplicate of the 

same files when it is outside the Pictures folder, for example in a document.
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Task 3.3
Suggested answer:
Having duplicate data could lead to data inaccuracies, for example if there are different addresses for the 
same person. Search engines will not know which version to list for you to read. 

Task 4 of 47

Sub-strand 1: Network overview

Content standard: B6.6.1.1 Demonstrate 
how to network computers.

Indicator: B6.6.1.1.4 Outline what one needs to connect 
to the internet.

Performance indicator: 
ALL learners will be able to outline some of 
what one needs to connect to the internet.

SOME learners will be able to outline most of 
what one needs to connect to the internet.

FEW learners will be able to outline what one 
needs to connect to the internet.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: Ethernet cabling, router, internet service provider (ISP), laptop, desktop computer, tablet, 
smart phone

In this task: 
The teacher should refer to the Learner’s Book for information and definitions of the different types of 
facilities offered by internet protocols and assist learners to answer the worksheet questions.

Learners should refer to the Learner’s Book and use the internet to find more information to answer the 
questions in the worksheet.

Resources required� Learner’s Book page 94

Downloadable content
•	 Worksheet Task 4_B6.6.1.1.4 Connect to the internet.pdf

Phase 1: Start of task
Ask learners to attempt Task 4.1 of the worksheet.

Phase 2: Main
Learners can refer to the Learner’s Book for more information on how to connect devices to the internet. They 
should complete the remaining tasks on Worksheet Task 4_B6.6.1.1.4 Connect to the internet.pdf. 

Phase 3: End of task
•	 Allow the learners to work in pairs and use their personal hotspot to share their internet connection (just to 

show how it’s done). 
•	 Discuss how far or close one should be for a Bluetooth connection to work and for a hotspot connection to 

work.
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Answers to Task 4 worksheet
Task 4.1
1.	 False
2.	 False
3.	 False
4.	 True

Task 4.2
Answers will vary.

Sub-strand 2: Web browsers and web pages

Task 5 of 47

Sub-strand 2: Web browsers and web pages

Content standard: B6.6.2.1 Demonstrate the use 
of a web browser.

Indicator: B6.6.2.1.4 Identify the address or links 
window.

Performance indicator: 
ALL learners will be able to identify part of the 
address or links window.

SOME learners will be able to identify most of the 
address or links window.

FEW learners will be able to identify the address or 
links window.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: uniform resource locator (URL), web address, web link, IP address

In this task: 
The teacher should refer to the Learner’s Book for information about web address structure and assist 
learners to answer the worksheet questions.

Learners should refer to the Learner’s Book and use the internet to find more information about web 
address structure to answer the questions in the worksheet.

Resources required� Learner’s Book pages 98–99

Downloadable content
•	 Worksheet Task 5_B6.6.1.1.5 Web addresses and links.pdf

Identify address or links window

Phase 1: Start of task
•	 Ask learners to complete Task 5.1 of Worksheet Task 5_B6.6.1.1.5 Web addresses and links.pdf.
•	 Briefly discuss how they will learn about the web addresses and links in this task.
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Phase 2: Main
•	 Learners use this link to Khan Academy’s video on how the internet works to get an idea about web addresses. 

https://www.khanacademy.org/computing/computer-science/internet-intro/internet-works-intro/v/the-
internet-ip-addresses-and-dns

•	 Ask learners to complete the questions on Worksheet Task 5_B6.6.1.1.5 Web addresses and links.pdf. 

Phase 3: End of task
Allow learners to complete as many tasks on the worksheet as possible.

Answers to Task 5 worksheet
Task 5.1
1. 	

https://www.ug.edu.gh

2.	 To type in the address of the website you want to visit.
3.	 It shows the address of the website you are on.

Task 6 of 47

Sub-strand 2: Web browsers and web pages

Content standard: B6.6.2.1 Demonstrate the use 
of a web browser.

Indicator: B6.6.2.1.2 Recognise the status bar and 
list its use.

Performance indicator: 
ALL learners will be able to recognise the status 
bar and list some of its uses.

SOME learners will be able to recognise the status 
bar and list most of its uses.

FEW learners will be able to recognise the status 
bar and list its use.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: status bar, customise, word count, page number

In this task: 
The teacher should refer to the Learner’s Book for information about recognising the status bar and 
assist learners to answer the worksheet questions.

Learners should refer to the Learner’s Book and use the internet to find more information about the 
status bar and to answer the questions in the worksheet.

Resources required� Learner’s Book page 95

Downloadable content
•	 Worksheet Task 6_B6.6.1.1.6 The status bar and its uses.pdf

Phase 1: Start of task
Ask learners to refer to the Learner’s Book section on the Status bar and to work through the tasks in the 
worksheet.
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Phase 2: Main
Learners should then follow the instructions in Worksheet Task 6_B6.6.1.1.6 The status bar and its  
uses.pdf for the remainder of this task.

Phase 3: End of task
Allow the learners to complete as many tasks in the worksheet as possible.

Allow learners to work in pairs or mixed ability small groups to complete Task 6.3 on Worksheet Task 
6_B6.6.1.1.6 The status bar and its uses.pdf.

Extension activity

Answers to Task 6 worksheet
Task 6.1
A status bar is a horizontal bar, usually at the bottom of the screen or window, that shows information about 
a document that is open or a program that is running

Task 6.2
The status bar can give the information about the number of words, cursor position and other elements such 
as the quick access toolbar.

Task 7 of 47

Sub-strand 2: Web browsers and web pages

Content standard: B6.6.2.1 Demonstrate the 
use of a web browser.

Indicator: B6.6.2.1.3 Illustrate using Help buttons.

Performance indicator: 
ALL learners will be able to illustrate using 
some Help buttons.

SOME learners will be able to illustrate using 
most Help buttons.

FEW learners will be able to illustrate using 
Help buttons.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: help button, apply theme, use the dictate button

In this task: 
The teacher should refer to the Learner’s Book for information about using the Help button and assist 
learners to answer the worksheet questions.

Learners should refer to the Learner’s Book and use the internet to find more information about using 
the Help button to answer the questions in the worksheet.
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Resources required� Learner’s Book pages 95–96

Downloadable content
•	 Worksheet Task 7_B6.6.1.1.7 Using the Help button.pdf 

Phase 1: Start of task
Ask learners to use their Learner’s Book in the section on using the Help button and to work through the tasks 
in the worksheet.

Phase 2: Main
Ask learners to complete the questions on Worksheet Task 7_B6.6.1.1.7 Using the Help button.pdf. 

Phase 3: End of task
Allow the learners to complete as many tasks on the worksheet as possible.

Ask the more able learners to attempt Activity 6.1 in the Learner’s Book.

Extension activity

Task 8 of 47

Sub-strand 2: Web browsers and web pages

Content standard: B6.6.2.1 Demonstrate the use 
of a web browser.

Indicator: B6.6.2.1.4 Recognise the Internet 
Explorer speed keys.

Performance indicator: 
ALL learners will be able to recognise some of the 
Internet Explorer speed keys.

SOME learners will be able to recognise most of 
the Internet Explorer speed keys.

FEW learners will be able to recognise the Internet 
Explorer speed keys.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: speed keys, shortcut keys, Internet Explorer, Search keys, Zoom keys

In this task: 
The teacher should refer to the Learner’s Book for information about Internet Explorer speed keys and 
assist learners to answer the worksheet questions.

Learners should refer to the Learner’s Book and use the internet to find more information about Internet 
Explorer speed keys to answer the questions in the worksheet.



92

Strand 6: Internet and social media

Resources required� Learner’s Book page 97

Downloadable content
•	 Worksheet Task 8_B6.6.2.1.4 Internet Explorer speed keys.pdf

Phase 1: Start of task
Ask learners to use their Learner’s Book section on Internet Explorer speed keys.

Phase 2: Main
Ask learners to complete the questions on Worksheet Task 8_B6.6.2.1.4 Internet Explorer speed keys.pdf.

Phase 3: End of task
Allow learners to complete as many tasks on the worksheet as possible.

Arrange learners into mixed ability groups so they can collaborate when they attempt to do Activity 6.2 
in the Learner’s Book.

Extension activity

Answers to Activity 6.1 Use the help in Word� Learner's Book page 96

Learners access the Help feature using either the list of articles or the search box to find out how to insert 
a watermark in a document.

Answers to Activity 6.2 Find shortcuts� Learner's Book page 97

1.	 Ctrl+F+N
2.	 Alt+Enter
3.	 Alt+Z 
4.	 Alt+A

Task 9 of 47

Sub-strand 2: Web browsers and web pages

Content standard: B6.6.2.1 Demonstrate the 
use of a web browser.

Indicator: B6.6.2.1.5 Recognise uniform resource 
locators (URLs).

Performance indicator: 
ALL learners will be able to recognise some 
uniform resource locators (URLs).

SOME learners will be able to recognise most 
uniform resource locators (URLs).

FEW learners will be able to recognise many 
uniform resource locators (URLs).

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy
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Key words: uniform resource locator (URL), properties, location

In this task: 
The teacher should refer to the Learner’s Book for information about uniform resource locators (URLs) 
and assist learners to answer the worksheet questions.

Learners should refer to the Learner’s Book and use the internet to find more information about uniform 
resource locators (URLs) to answer the questions in the worksheet.

Resources required� Learner’s Book pages 98–99

Downloadable content
•	 Worksheet Task 9_B6.6.2.1.5 Recognise uniform resource locators.pdf

Phase 1: Start of task
Ask learners to use the section on understanding uniform resource locators (URLs) in their Learner’s Books. 

Phase 2: Main
Ask learners to complete the questions on Worksheet Task 9_B6.6.2.1.5 Recognise uniform resource 
locators.pdf.

Phase 3: End of task
Allow the learners to complete as many tasks on the worksheet as possible.

You can let the more able learners complete the worksheet Task 9.3.

Extension activity

Answers to Task 9 worksheet
Task 9.1
1.	 This URL is used to point to the meaning of a URL property.
2.	 I would expect it to return information on a search for something related to the meaning and properties 

of URL.

Task 9.2
C

Task 9.3
The property of the URL in the second case points to where to find the image of the brown cat that will be in 
an unordered list.
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Task 10 of 47

Sub-strand 2: Web browsers and web pages

Content standard: B6.6.2.1 Demonstrate the use 
of a web browser.

Indicator: B6.6.2.1.6 Demonstrate how to return 
to a URL.

Performance indicator: 
ALL learners will be able to demonstrate how to 
return to a URL.

SOME learners will be able to demonstrate how to 
return to more URLs.

FEW learners will be able to demonstrate how to 
return to many URLs.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: open URLs, close URLs, return to URLs

In this task: 
The teacher should refer to the Learner’s Book for information about Internet Explorer speed keys and 
assist learners to answer the worksheet questions.

Learners should refer to the Learner’s Book and use the internet to find more information about Internet 
Explorer speed keys to answer the questions in the worksheet.

Resources required� Learner’s Book page 99

Downloadable content
•	 Worksheet Task 10_B6.6.2.1.4 Demonstrate how to return to a URL.pdf

Phase 1: Start of task
Ask learners to complete Task 10.1 on Worksheet Task 10_B6.6.2.1.4 Demonstrate how to return to a  
URL.pdf.

Phase 2: Main
Ask learners to complete the remaining tasks on the worksheet, using their mobile phone video recorders or 
tablets.

Phase 3: End of task
Learners share their short videos with one another other and give constructive feedback.

Arrange learners in pairs to collaborate and peer-review each other’s work in Activity 6.3 in the Learner’s 
Book.

Extension activity
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Answers to Activity 6.3 Navigate and search websites� Learner's Book page 100

The aim of this activity is to get learners searching within a site, rather than searching the internet as a whole. 

Task 11 of 47

Sub-strand 2: Web browsers and web pages

Content standard: B6.6.2.1 Demonstrate the 
use of a web browser.

Indicator: B6.6.2.1.7 Show how to find items on a page.

Performance indicator: 
ALL learners will be able to show how to find 
some items on a page.

SOME learners will be able to show how to 
find most items on a page.

FEW learners will be able to show how to find 
items on a page.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: horizontal navigation bar, vertical navigation bar, search box, drop-down lists, audio icons, 
video icons, marquees, hyperlinks, contact us, virtual assistants, FAQ

In this task: 
The teacher should refer to the Learner’s Book for information about how to find items on a page and 
assist learners to answer the worksheet questions.

Learners should refer to the Learner’s Book and use the internet to research how to find items on a page 
to answer the questions in the worksheet.

Resources required� Learner’s Book pages 99–100

Downloadable content
•	 Worksheet Task 11_B6.6.2.1.7 How to find items on a page.pdf

Phase 1: Start of task
Learners do Task 11.1 of the worksheet.

Phase 2: Main
Ask learners to complete Task 11.2 of Worksheet Task 11_B6.6.2.1.7 How to find items on a page.pdf.

Phase 3: End of task
Allow the learners to complete Task 11.3 of the worksheet.
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Sub-strand 3: Surfing the World Wide Web

Task 12 of 47

Sub-strand 3: Surfing the World Wide Web

Content standard: B6.6.3.1 Demonstrate surfing the 
World Wide Web.

Indicator: B6.6.3.1.1 Recognise URLs.

Performance indicator: 
ALL learners will be able to recognise some types of URLs.

SOME learners will be able to recognise most types of 
URLS.

FEW learners will be able to recognise many types of 
URLs.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: URL

In this task: 
The teacher should refer to the Learner’s Book for information about recognising URLs and assist 
learners to answer the worksheet questions.

Learners should refer to the Learner’s Book and use the internet to find more information about 
recognising URLs to answer the questions in the worksheet.

Resources required� Learner’s Book pages 98–99

Downloadable content
•	 Worksheet Task 12_B6.6.3.1.1 Recognise URLs.pdf

Phase 1: Start of task
Learners do Task 12.1 on the worksheet.

Phase 2: Main
Ask learners to complete the remaining questions on Worksheet Task 12_B6.6.3.1.1 Recognise URLs.pdf.

Phase 3: End of task
Allow the learners to complete Task 12.3 on the worksheet.

Answers to Task 12 worksheet
Task 12.1
1.	 Hyperlinks are typically underlined and in blue. When you click on the hyperlink, it will take you to 

another web page. 
2.	 The URL usually contains clues to the name of the website or to what type of website it is.

Task 12.2
1.	 https – tells us that it is a secure website that uses encryption.
2.	 http – tells us that this wiki has information stored on a network on the World Wide Web (www).
3.	 www – tells us that it is on the World Wide Web (www).
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4.	 .com – tells us that it is the website of a company, probably based in the USA. If it was in France, it would 
have had .co.fr

5.	 /Find-the-URL-of-a-Website – tells us that it is the section of the website where you can find the URL of a 
website.

6.	 /Find-the-URL-of-a-Website – tells us that there may be more than one webpage to this website or wiki.
7.	 wikihow – tells us the name of the company that maintains the website. 
8.	 wikihow.com – tells us that this website is a wiki and that means that information on it can be changed 

or updated/edited by any visitors to this website. 

Task 12.3
Use a search engine, such as Google or Yahoo, etc. 
Type in a key word, ‘professional football, Ghana’ and press enter.
On a football website, I would search for membership application details.
Possibly fill in an online application form.

Task 13 of 47

Sub-strand 3: Surfing the World Wide Web

Content standard: B6.6.3.1 Demonstrate surfing 
the World Wide Web.

Indicator: B6.6.3.1.2–5 Preparing for group 
presentations on demonstrating surfing the web.

Performance indicator: 
ALL learners will be able to demonstrate surfing 
the web.

SOME learners will be able to demonstrate surfing 
the web.

FEW learners will be able to demonstrate surfing 
the web.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: jump directory, surfing the web, return to a URL, show how to find items on a page

In this task: 
The teacher should refer to the Learner’s Book for information about surfing the web. Divide learners 
into groups to prepare a chart for a teach-back on their assigned topic.

Learners should prepare a chart to be used in a group teach-back in the next four tasks.

Resources required� Learner’s Book pages 97–100

Downloadable content
•	 Evaluation criteria_Teach Back Tasks 13–17_B6.6.3.1.2–5.pdf

Phase 1: Start of task
Divide learners into groups of three or four and assign a topic to each group. Some groups may have the 
same topic. Learners must prepare a chart that they will use to do a teach-back during the next four tasks.

Phase 2: Main
•	 Depending on the size of your class, you can assign one topic to two groups. 
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Groups Topic Task 

1 and 4 How to jump directory to URLs 1

2 and 5 How to return to a URL 2

3 and 6 How to find items on a page 3

7 and 8 How to print pages 4

•	 Learners must consider the procedure and the evaluation criteria for the teach-back, found in the 
downloadable content, during the next four tasks.

Evaluation criteria

Criteria Poor 
1 mark

Satisfactory
2 marks

Good
3 marks

Excellent
4 marks

Correct and accurate

Chart used to explain

All group members 
participated

Used images

Answered questions 
from class

Overall quality

Total score

Phase 3: End of task
Check that the groups doing their teach-backs in the next task are ready.

Task 14 of 47

Sub-strand 3: Surfing the World Wide Web

Content standard: B6.6.3.1 Demonstrate surfing 
the World Wide Web.

Indicator: B6.6.3.1.2 Illustrate how to jump 
directory to a URL.

Performance indicator: 
ALL learners will be able to demonstrate surfing 
some of the web.

SOME learners will be able to demonstrate surfing 
most of the web.

FEW learners will be able to demonstrate surfing 
the web.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy
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Key words: jump directory, surfing the web, return to a URL, show how to find items on a page

In this task: 
The teacher should allow all the groups presenting their teach-backs for their session during this task to 
do so.

Learners should participate in their teach-backs, while those not presenting should participate by 
listening and asking relevant questions.

Resources required� Learner’s Book pages 92–100

Downloadable content
•	 Evaluation criteria_Teach Back Tasks 13–17_B6.6.3.1.2–5.pdf

Phase 1: Start of task
Set up the classroom to enable the groups presenting to be able to do so. 

Phase 2: Main
Learners who are not presenting should be using the evaluation sheets which are available for download 
from Cambridge GO.

Phase 3: End of task
Ask learners who presented what they thought went well and what they would like to do better next time.

Task 15 of 47

Sub-strand 3: Surfing the World Wide Web

Content standard: B6.6.3.1 Demonstrate surfing 
the World Wide Web.

Indicator: B6.6.3.1.3 Demonstrate how to return 
to a URL.

Performance indicator: 
ALL learners will be able to demonstrate how to 
return to a URL.

SOME learners will be able to demonstrate how to 
return to some URLs.

FEW learners will be able to demonstrate how to 
return to most URLs.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: jump directory, surfing the web, return to a URL, show how to find items on a page

In this task: 
The teacher should allow all the groups presenting their teach-backs for this task to do so.

Learners should participate in their teach-backs, while those not presenting should participate by 
listening and asking relevant questions.
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Resources required� Learner’s Book page 99

Downloadable content
•	 Evaluation criteria_Teach Back Tasks 13–17_B6.6.3.1.2–5.pdf

Phase 1: Start of task
Set up the classroom to enable the groups presenting to be able to do so. 

Phase 2: Main
Learners who are not presenting should be using the evaluation sheets which are available for download 
from Cambridge GO.

Phase 3: End of task
Ask learners who presented what they thought went well and what they would they would like to do better 
next time.

Task 16 of 47

Sub-strand 3: Surfing the World Wide Web

Content standard: B6.6.3.1 Demonstrate surfing 
the World Wide Web.

Indicator: B6.6.3.1.4 Show how to find items on a 
page.

Performance indicator: 
ALL learners will be able to show how to find some 
items on a page.

SOME learners will be able to show how to find 
most items on a page.

FEW learners will be able to show how to find 
items on a page.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: jump directory, surfing the web, return to a URL, show how to find items on a page

In this task: 
The teacher should allow all the groups presenting their teach-backs for this task to do so.

Learners should participate in their teach-backs, while those not presenting should participate by 
listening and asking relevant questions.

Resources required� Learner’s Book pages 99–100

Downloadable content
•	 Evaluation criteria_Teach Back Tasks 13–17_B6.6.3.1.2–5.pdf

Phase 1: Start of task
Set up the classroom to enable the groups presenting to be able to do so. 

Phase 2: Main
Learners who are not presenting should be using the evaluation sheets which are available for download 
from Cambridge GO.



101

Sub-strand 4: Favourite places and search engines

Phase 3: End of task
Ask learners who presented what they thought went well and what they would like to do better next time.

Task 17 of 47

Sub-strand 3: Surfing the World Wide Web

Content standard: B6.6.3.1 Demonstrate surfing 
the World Wide Web.

Indicator: B6.6.3.1.5 Illustrate how to print pages.

Performance indicator: 
ALL learners will be able to illustrate how to print 
some pages

SOME learners will be able to Illustrate how to 
print most pages

FEW learners will be able to illustrate how to print 
pages

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: jump directory, surfing the web, return to a URL, show how to find items on a page

In this task: 
The teacher should allow all the groups presenting their teach-back for their session today to do so.

Learners should participate in their teach-back, while those not presenting should participate by 
listening and asking relevant questions.

Resources required� Learner’s Book page 101

Downloadable content
•	 Evaluation criteria_Teach Back Tasks 13–17_B6.6.3.1.2–5.pdf.

Phase 1: Start of task
Set up the classroom to enable the groups presenting to be able to do so. 

Phase 2: Main
Learners who are not presenting should be using the evaluation sheets which are available for download 
from Cambridge GO.

Phase 3: End of task
Ask learners who presented what they thought went well and what they would like to do better next time.

Sub-strand 4: Favourite places and search engines

Task 18 of 47

Sub-strand 4: Favourite places and search engines

Content standard: B6.6.4.1 Demonstrate surfing 
for information on the web.

Indicator: B6.6.4.1.1 Show how to create a 
Favourites link.
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Performance indicator: 
ALL learners will be able to show how to create a 
Favourites link.

SOME learners will be able to show how to create 
some Favourites links.

FEW learners will be able to show how to create 
many Favourites links.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: Favourites link, MP4, screen capture tool

In this task: 
The teacher should demonstrate to learners how to record their evidence of creating a Favourites link.

Learners should use their web browser’s keyboard shortcut to record all the moves they make on their 
computer to create their Favourites link.

Resources required� Learner’s Book page 102

Downloadable content
•	 How to create and remove a Favourites link.mp4

Phase 1: Start of task
Demonstrate to learners how to record their cursor moves and to record a video showing how they created a 
Favourites link. Use the video found in the downloadable content: How to create and remove a Favourites 
link.mp4.

Phase 2: Main
Allow learners to create their own videos using the Windows button + G on the keyboard to activate the 
screen capture tool. Ensure the microphone is also working so that learners can explain clearly how they are 
creating their Favourites link.

Phase 3: End of task
Let learners work in pairs to discuss what they thought went well and what they would like to do better next time.

Task 19 of 47

Sub-strand 4: Favourite places and search engines

Content standard: B6.6.4.1 Demonstrate surfing 
for information on the web.

Indicator: B6.6.4.1.1 Show how to delete a 
Favourites link.

Performance indicator: 
ALL learners will be able to show how to delete a 
Favourites link.

SOME learners will be able to show how to delete 
some Favourites links.

FEW learners will be able to show how to delete 
many Favourites links.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy
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Key words: Favourites link, MP4, screen capture tool

In this task: 
The teacher should demonstrate to learners how to record their evidence of deleting a Favourites link.

Learners should use their web browser’s keyboard shortcut to record all the moves they make on their 
computer to delete their Favourites link.

Resources required� Learner’s Book page 102

Downloadable content
•	 How to create and remove a Favourites link.mp4

Phase 1: Start of task
Demonstrate to learners how to record their cursor moves and to record a video showing how they deleted a 
Favourites link. Use the video found in the downloadable content: How to create and remove a Favourites 
link.mp4.

Phase 2: Main
Allow learners to create their own videos using the Windows button + G on the keyboard to activate the 
screen capture tool. Ensure the microphone is also working so that learners can explain clearly how they are 
deleting their Favourites link.

Phase 3: End of task
Let learners work in pairs to discuss what they thought went well and what they would like to do better next time.

Task 20 of 47

Sub-strand 4: Favourite places and search engines

Content standard: B6.6.4.1 Demonstrate surfing 
for information on the web.

Indicator: B6.6.4.1.3 Show how to create a 
Favourites folder.

Performance indicator: 
ALL learners will be able to show how to create a 
Favourites folder.

SOME learners will be able to show how to create 
some Favourites folder.

FEW learners will be able to show how to create 
many Favourites folder.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: Favourites link, MP4, screen capture tool

In this task: 
The teacher should demonstrate to learners how to record their evidence of creating a Favourites folder.

Learners should use their web browser’s short cut to record all the moves they make on their computer 
to create their Favourites folder.
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Resources required� Learner’s Book page 102

Phase 1: Start of task
Demonstrate to learners how to record their cursor moves and to record a video showing how they created a 
Favourites folder. 

Phase 2: Main
Allow learners to create their own videos using the Windows button + G on the keyboard to activate the 
screen capture tool. Ensure the microphone is also working so that learners can explain clearly how they are 
creating their Favourites folder.

Phase 3: End of task
Let learners work in pairs to discuss what they thought went well and what they would like to do better next 
time.

Task 21 of 47 

Sub-strand 4: Favourite places and search engines

Content standard: B6.6.4.1 Demonstrate surfing 
for information on the web.

Indicator: B6.6.4.1.4 Show how to use their links 
toolbar and Favourites places.

Performance indicator: 
ALL learners will be able to show how to use their 
links toolbar and Favourites places.

SOME learners will be able to show how to use 
their links toolbar and Favourites places.

FEW learners will be able to show how to use their 
links toolbar and Favourites places.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: Favourites link, MP4, screen capture tool

In this task: 
The teacher should demonstrate to learners how to record their evidence of creating a Favourites folder.

Learners should use their web browser’s keyboard shortcuts to record all the moves they make on their 
computer to show how they are using their links toolbar and Favourites places.

Resources required� Learner’s Book page 102

Phase 1: Start of task
Demonstrate to learners how to record their cursor moves and to record a video showing how they are using 
their links toolbar and Favourites places. 

Phase 2: Main
Allow learners to create their own videos using the Windows button + G on the keyboard to activate the 
screen capture tool. Ensure the microphone is also working so that learners can explain clearly how they are 
using their links toolbar and favourites places.

Phase 3: End of task
Let learners work in pairs to discuss what they thought went well and what they would like to do better next time.
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Sub-strand 5: Using online forms

Task 22 of 47

Sub-strand 5: Using online forms

Content standard: B6.6.5.1 Demonstrate the 
usage of forms.

Indicator: B6.6.5.1.1 Demonstrate the types and uses of 
form elements.

Performance indicator: 
ALL learners will be able to demonstrate the 
types and uses of some form elements.

SOME learners will be able to demonstrate 
the types and uses of most form elements.

FEW learners will be able to demonstrate the 
types and uses of form elements.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: online forms, drop-down list, tick box, sliders, tabs, buttons, text boxes, checkboxes, radio 
buttons, submit buttons, combo boxes

In this task: 
The teacher should explain that web forms are created using HTML and show learners the web form 
elements. If possible, let learners try it out for themselves using an online coding tutorial.

Learners should identify web form elements and fill out an online form that uses drop-down lists, combo 
boxes, text fields, etc.

Resources required� Learner’s Book pages 103–104

Downloadable content
•	 Worksheet Task 22_B6.5.1.1 Demonstrate types and uses of form elements.pdf

Phase 1: Start of task
•	 Prepare flash cards of the key words with the words on one side of the card and the meaning on the reverse 

of the flash card. Issue each learner with a flash card. Some learners will have the same key words. 
•	 Get all the learners with the same key word to come to the front of the class to try to explain in their own 

words what they think it means and let the rest of the class choose the explanation that best fits the 
correct meaning.

Phase 2: Main
•	 Learners do the tasks on Worksheet Task 22_B6.5.1.1 Demonstrate types and uses of form elements.

pdf. 
•	 Task 22.1 requires learners to use the link to log in to complete an online form.
•	 Task 22.2 requires learners to label the form correctly using the labels provided in the list.

Phase 3: End of task
Swap for peer-reviewing and feedback to each other in pairs.
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Answers to Task 22 worksheet
Task 22.2

Sign up for your A�er-School Club

Name

First Last

Registration

Email

Choose the day of the week you prefer

Monday

Choose Subject

English

Computer Coding

Extra Needs

Extra Needs

$

Date

Address

Street Address

Address Line 2

City State / Province / Region

CountryPostal / Zip Code

MM DD YYYY

1

Phone Number

Dollars Cents

Powered By

by SurveyMonkey

by SurveyMonkey

Submit

Check All That Apply
Male

Female

Maths

Science

text boxes

tick box

radio button

drop-down list

submit button

Task 23 of 47

Sub-strand 5: Using online forms

Content standard: B6.6.5.1 Demonstrate the 
usage of forms.

Indicator: B6.6.5.1.2 Demonstrate the filling of 
forms offline.

Performance indicator: 
ALL learners will be able to demonstrate the filling 
of some forms offline.

SOME learners will be able to demonstrate the 
filling of most forms offline.

FEW learners will be able to demonstrate the filling 
of forms offline.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy
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Sub-strand 5: Using online forms

Key words: online, offline, pdf

In this task: 
The teacher should refer to the Learner’s Book section on working online and offline.

Learners should complete the worksheet.

Resources required� Learner’s Book page 104

Downloadable content
•	 Field trip information_Form.pdf

Phase 1: Start of task
Ask learners to consider which of the following would be online and which would be offline:
•	 Filling in a paper form that arrived in the post and then returning it by post.
•	 Downloading a PDF form, signing it, and then scanning in the signed form and emailing it back to the 

person who sent it to you.
•	 Filling in a form on a website and pressing the submit button when you have filled it in.

Phase 2: Main
Send each learner a copy of Field trip information_Form.pdf via email. Ask learners to fill in the form 
using the Fill & Sign tool in the PDF software. Learners must save the completed form before emailing it to a 
classmate. They must cc you in the email.

Phase 3: End of task
Learners check that they have received a completed PDF form from a classmate and check that it was all 
filled in. Learners give feedback to their classmate.

Task 24 of 47

Sub-strand 5: Using online forms

Content standard: B6.6.5.1. Demonstrate 
the usage of forms.

Indicator: B6.6.5.1.3 Demonstrate the uploading of files 
(e.g. pictures, audio, pdf, etc.).

Performance indicator: 
ALL learners will be able to demonstrate 
uploading some types of files.

SOME learners will be able to demonstrate 
uploading most types of files.

FEW learners will be able to demonstrate 
uploading all types of files.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: uploading, images, audio, video, pdf

In this task: 
The teacher should explain that learners will need to upload different file types and store them 
appropriately for future use.

Learners should complete the worksheet.
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Resources required� Learner’s Book page 104

Downloadable content

Worksheet Task 24_B5.6.5.1.3 Demonstrate uploading of files.pdf

Phase 1: Start of task
Learners match the file extension to the types of files they are working with on the Task 24.1 worksheet.
Go through the correct answers with the class when they have all completed Task 24.1.

Phase 2: Main
Learners must create a single page PowerPoint advertisement about a new talent contest coming to the city 
during the school holidays. Your advert must show:
•	 A catchy title (animation)
•	 Venue
•	 Ticket prices
•	 Information about the types of talent and activities entrants can compete in
•	 Dates and opening times
•	 Video showing a few highlights
•	 Sound clip
•	 Company logo
•	 Pictures
•	 Contact details, such as email, telephone, mobile phone, fax, website, address.

Phase 3: End of task
Learners swap their presentations with a partner for peer-assessment. They use the assessment criteria to 
give each other constructive feedback.

Answers to Task 24 worksheet
Task 24.1

File extension File type

.jpeg image

.mp4 Video or movie

.docx Word processed document

.pdf PDF document

.png image

.html Web page

Task 25 of 47

Sub-strand 5: Using online forms

Content standard: B6.6.5.1. Demonstrate 
the usage of forms.

Indicator: B6.6.5.1.4 Illustrate retrieving text, pictures, 
sounds, and programs.
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Sub-strand 5: Using online forms

Performance indicator: 
ALL learners will be able to illustrate 
retrieving text and pictures.

SOME learners will be able to illustrate 
retrieving text, pictures and sounds. 

FEW learners will be able to illustrate 
retrieving text, pictures, sounds and 
programs.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: download, upload, images, audio, video, pdf

In this task: 
The teacher should explain that learners will need to download and upload different file types and store 
them appropriately for future use.

Learners should complete the worksheet.

Resources required� Learner’s Book page 104

Downloadable content
•	 Worksheet Task 25_B6.6.5.1.4. Illustrate retrieving text, pictures, sounds and programs.pdf

Phase 1: Start of task
Discuss what it means to retrieve something. Which of the following statements expresses the meaning of the 
word ‘retrieve’ most accurately?
•	 You thought you had lost your homework but found it later under your bed.
•	 You did not have information about what the illness tetanus was, so you looked it up in an encyclopaedia 

and found the relevant information.
•	 You saved a picture of your birthday party last year and had to search in your photo albums to find it.
•	 Your neighbour’s puppy fell into a big hole in the field and a passer-by was able to pull it out quickly, 

thereby saving its life.
•	 You looked up on Google to find a video about how to make a website
•	 You inserted an image from your pictures into a PowerPoint slide.

Phase 2: Main
•	 Assign learners to five different groups and let them complete Worksheet Task 25_B6.6.5.1.4. Illustrate 

retrieving, text, pictures, sounds and programs.pdf. 
•	 They then work on their own to create a one-slide fact file on ONE country.
•	 Award ONE point for each criterion achieved.

Self-assessment criteria Achieved Still needs to be done

Animated title

Background colour

Information about the country

A sound file of its national anthem
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Image of its traditional dances

Overall quality

Total Score 

Phase 3: End of task
Learners save their presentation file as a PDF file. In pairs, they discuss their self-assessment scores and the 
reasons they awarded them to themselves.

Task 26 of 47

Sub-strand 5: Using online forms

Content standard: B6.6.5.1. Demonstrate the 
usage of forms.

Indicator: B6.6.5.1.5 Discuss more about security 
issues on the form submission.

Performance indicator: 
ALL learners will be able to discuss a few security 
issues on the form submission.

SOME learners will be able to discuss some more 
security issues on the form submission.

FEW learners will be able to discuss security issues 
on the form submission.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: identity theft

In this task: 
The teacher should explain that learners will learn about the positive and negative aspects of disclosing 
personal details when filling in online forms.

Learners should complete the worksheet.

Resources required� Learner’s Book page 105

Downloadable content
•	 Worksheet Task 26_B6.6.5.1.5 Security issues with online form submission.pdf

Phase 1: Start of task
•	 Learners watch this YouTube video about identity theft. 

https://www.youtube.com/watch?v=CJ40tAm8cTE
•	 Then they chat about how important it is to keep their personal data safe when filling in forms online.

Phase 2: Main
•	 Learners access the link below as a whole class.  

https://www.theverge.com/2019/9/6/20802082/online-privacy-security-protection-guide-how-to-data-
identity-theft-harassment-apple-google-facebook (accessed 7/11/2019)

•	 Work through the questions with the class so that learners can ask any other questions they may have 
while making sense of the content.
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Phase 3: End of task
Learners complete Task 26.3 on Worksheet Task 26_B6.6.5.1.5 Security issues with online form 
submission.pdf.

Answers to Task 26 worksheet
Task 26.2
1.	 It is a method of confirming a user’s claimed identity by utilising something they know (password) and a 

second factor other than something they have or something they are.
2.	 Answers will vary.
3.	 Answers will vary.

Sub-strand 6: Customising your browser

Task 27 of 47

Sub-strand 6: Customising your browser

Content standard: B6.6.6.1. Show how to 
customise a browser.

Indicator: B6.6.6.1.1 Identify reasons for customising a 
browser.

Performance indicator: 
ALL learners will be able to identify some 
reasons for customising a browser.

SOME learners will be able to identify many 
reasons for customising a browser.

FEW learners will be able to identify reasons 
for customising a browser.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: quick access, customise, side-by-side browsing, beautifications

In this task: 
The teacher should explore with the class the reasons why it might be advantageous to customise a web 
browser.

Learners should complete the worksheet.

Resources required� Learner’s Book page 106

Downloadable content
•	 Worksheet Task 27_B6.6.6.1.1 Identify reasons for customising a web browser.pdf

Phase 1: Start of task
•	 Let learners consider the screenshot of a customised web browser found in the downloadable content 

Worksheet Task 27_B6.6.6.1.1 Identify reasons for customising a web browser.pdf.
•	 Then play the ‘Explanation’ game with the class. It starts like this: 

You say: I noticed that the web browser had many tabs, such as … which are very accessible for the user. 
That is interesting! Why do you think it could be interesting?

•	 Learners’ answers will vary. (Learners can refer to the Learner’s Book for help to answer your questions.)
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Phase 2: Main
Learners work through Tasks 27.2.and 27.3 on Worksheet Task 27_B6.6.6.1.1 Identify reasons for 
customising a web browser.pdf.

Phase 3: End of task
Let learners work in small groups and share the sentences they wrote in Task 27.4. 

Answers to Task 27 worksheet
Task 27.2
The user is doing research. 

Task 27.3
Suggested answer: It can create a feeling of unity and loyalty among staff. 

Task 27.4
Answers will vary. 

Task 28 of 47

Sub-strand 6: Customising your browser

Content standard: B6.6.6.1. Show how to 
customise a browser.

Indicator: B6.6.6.1.2 Illustrate how to set themes.

Performance indicator: 
ALL learners will be able to illustrate how to set 
some themes.

SOME learners will be able to illustrate how to set 
more themes.

FEW learners will be able to illustrate how to set 
themes.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: settings, customise, appearance, themes

In this task: 
The teacher should illustrate how they have changed their browser’s appearance by changing its 
existing theme.

Learners should complete the worksheet.

Resources required� Learner’s Book page 106

Downloadable content
•	 Worksheet Task 28_B6.6.6.1.2 Illustrate how to set themes.pdf

Phase 1: Start of task
•	 Learners do Task 28.1 on Worksheet Task 28_B6.6.6.1.2 Illustrate how to set themes.pdf.
•	 They can use the internet to look for and decide on an appropriate image or they can use an image from 

your personal collection of images.
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Phase 2: Main
Learners complete all the tasks on Worksheet Task 28_B6.6.6.1.2 Illustrate how to set themes.pdf.

Phase 3: End of task
Ask learners to complete the following sentence: I chose the new theme image showing … because …

Task 29 of 47

Sub-strand 6: Customising your browser

Content standard: B6.6.6.1. Show how to 
customise a browser.

Indicator: B6.6.6.1.3 Show how to customise the 
toolbar.

Performance indicator: 
ALL learners will be able to show how to customise 
a part of the toolbar.

SOME learners will be able to show how to 
customise the toolbar.

FEW learners will be able to show how to 
customise the toolbar.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: settings, customise, appearance, themes, toolbar

In this task: 
The teacher should illustrate how they have changed their toolbar’s appearance by changing the 
existing icons.

Learners should complete the worksheet.

Resources required� Learner’s Book page 107

Downloadable content
•	 Worksheet Task 29_B6.6.6.1.3 Show how to customise the toolbar.pdf

Phase 1: Start of task
Learners do Task 29.1 on Worksheet Task 29_B6.6.6.1.3 Show how to customise the toolbar.pdf.

Phase 2: Main
Learners work through the remaining tasks on the worksheet.

Phase 3: End of task
Give learners the chance to explain any difficulties they may have experienced in customising their browser’s 
toolbar. Other learners can offer ideas on how they can address their difficulties.

Task 30 of 47

Sub-strand 6: Customising your browser

Content standard: B6.6.6.1 Show how to 
customise a browser.

Indicator: B6.6.6.1.4. Set bookmarks.
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Performance indicator: 
ALL learners will be able to demonstrate the 
meaning of bookmarks .

SOME learners will be able to demonstrate the 
meaning of bookmarks.

FEW learners will be able to demonstrate the 
meaning of bookmarks.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: bookmark, favourites, browser tabs

In this task: 
The teacher should explain the concept of bookmarks to the learners and demonstrate how to 
bookmark a website. 

Learners should use Worksheet Task 30_B6.6.6.1.4 Show how to set bookmarks.pdf and demonstrate 
their ability to set bookmarks. After bookmarking a website, let the learners close the tab and then use 
the bookmark to visit the site again.

Resources required� Learner’s Book page 107

Downloadable content
•	 Worksheet Task 30_B6.6.6.1.4 Show how to set bookmarks.pdf

Phase 1: Start of task
Learners should do Task 30.1 on the worksheet.

Phase 2: Main
Learners complete the tasks on Worksheet Task 30_B6.6.6.1.4 Show how to set bookmarks.pdf.

Phase 3: End of task
Learners can work in small groups and share their answers to Task 30.3 on Worksheet Task 30_B6.6.6.1.4 
Show how to set bookmarks.pdf.

Task 31 of 47

Sub-strand 6: Customising your browser

Content standard: B6.6.6.1. Show how to 
customise a browser.

Indicator: B6.6.6.1.5 Show how to set cookies and 
demonstrate the steps in turning on cookies in a 
browser.

Performance indicator: 
ALL learners will be able to set cookies.

SOME learners will be able to show how to set 
cookies and demonstrate some of the steps in 
turning on cookies in a browser.

FEW learners will be able to show how to set 
cookies and demonstrate the steps in turning on 
cookies in a browser.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy
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Key words: cookies, toolbar, browser, bookmarks, themes, customise, favourites

In this task: 
The teacher should illustrate how they have changed the cookies already set in their browser and to 
show how to turn on cookies in a browser.

Learners should complete the worksheet.

Resources required� Learner’s Book page 108

Downloadable content
•	 Worksheet Task 31_B6.6.6.1.5 Set cookies and turn on in a browser.pdf

Phase 1: Start of task
Play the game ‘Hot seat’ with the key words. Ask for a volunteer to sit in the hot seat at the front of the class, 
facing the learners but with their back to the board. The teacher writes the key word on the board so the hot 
seat learner cannot see the word. Learners must explain what the word means but cannot mention the word 
or spell it. Once the correct word is guessed, a new volunteer should have a turn to sit in the hot seat and a 
new word goes on the board.

Phase 2: Main
Learners work through Worksheet Task 31_B6.6.6.1.5 Set cookies and turn on in a browser.pdf.

Phase 3: End of task
Ask learners to complete the sentence in Task 31.2 on the worksheet and to compare their answers with a 
partner’s.

Sub-strand 7: Electronic mail

Task 32 of 47

Sub-strand 7: Electronic mail

Content standard: B6.6.7.1 Demonstrate the use 
of electronic mail.

Indicator: B6.6.7.1.1 Show how to create and 
access email messages.

Performance indicator: 
ALL learners will be able to create an email 
account.

SOME learners will be able to create an email 
account and access some email messages.

FEW learners will be able to create an email 
account and access all their email messages. 

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: username, password, email address, email account, access, cc
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In this task: 
The teacher should assist learners to create email accounts and to send introductory messages to a 
classmate and to reply to their classmate’s email. They should cc those messages to the teacher.

Learners should create email accounts, send introductory messages to a classmate, and reply to the 
email message that they receive. They should cc those messages to their teacher.

Resources required� Learner’s Book page 109

Phase 1: Start of task
Ensure all learners can access the Google email new account sign-up page. Explain to learners that they need 
to have a username and a password ready and to ensure that they can remember both.

Phase 2: Main
•	 Allow learners to follow the online instructions to create the email account. Support those who are 

struggling and ask learners who have finished setting up an email account to assist others who may need 
more support.

•	 Ask learners to send one email to a classmate, just a polite message introducing themselves. They must all 
reply to the email they receive. Remind them to cc you into the emails. 

Phase 3: End of task
Ask learners to say what they found difficult in this task. Let their classmates suggest what they can do next 
time make the task easier.

Refer learners to Activity 6.4 in the Learner’s Book for more practice and guidance on how to create an 
email account in Google.

Extension activity

Answers to Activity 6.4 Set up a Gmail account� Learner's Book page 114

Learners should all have a new email account with Gmail. They should be able to remember their own 
email address and password and should have selected a theme.

Task 33 of 47

Sub-strand 7: Electronic mail

Content standard: B6.6.7.1 Demonstrate the 
use of electronic mail.

Indicator: B6.6.7.1.2 Illustrate how to reply to and 
forward received messages.
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Performance indicator: 
ALL learners will be able to illustrate how to 
reply to received messages.

SOME learners will be able to illustrate how to 
reply to and forward received some messages.

FEW learners will be able to illustrate how to 
reply to and forward received messages.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: compose email, format text, create email, reply, forward, cc, bcc

In this task: 
The teacher should send the attachment Dear Learner_Attachment.pdf found in the downloadable 
content to all the learners and ensure that they have managed to open it to get the instruction to 
complete the worksheet for the day’s task.

Learners should open the email attachment sent to them by their teacher and work through the 
instructions in the attachment and the worksheet in this task.

Resources required� Learner’s Book pages 110–111

Downloadable content
•	 Dear Learner_Attachment.pdf

Phase 1: Start of task
Send an email message with an attachment to all the learners, with the instructions about how to reply to 
and forward received email messages.

Phase 2: Main
Ensure all learners can open their emails and the attachment you sent to them so that they can do the 
exercises in the worksheet.

Phase 3: End of task
Learners complete the tasks set out in the attachment. 

Refer learners to Activity 6.5 in the Learner’s Book for more practice and guidance on sending emails.

Extension activity

Task 34 of 47

Sub-strand 7: Electronic mail

Content standard: B6.6.7.1 Demonstrate the use 
of electronic mail.

Indicator: B6.6.7.1.2 Demonstrate how to delete 
messages.
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Performance indicator: 
ALL learners will be able to demonstrate how to 
delete messages.

SOME learners will be able to demonstrate how to 
delete messages.

FEW learners will be able to demonstrate how to 
delete messages.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: delete email, format text, create email, reply, forward, cc, bcc, inbox

In this task: 
The teacher should explain that learners should record videos on how to delete messages. 

Learners should record how to delete messages and then email a copy to the teacher as in the Phase 2 
instructions. 

Resources required� Learner’s Book page 110

Downloadable content
•	 Video_Deleting emails.mp4

Phase 1: Start of task
Show learners how to delete emails from their inboxes in Video_Deleting emails.mp4.

Phase 2: Main
•	 Ask learners to open the inbox and delete emails. They should do a screen capture, using the shortcut Windows 

key + G on the keyboard. This will enable them to do the screen capture and record voice, if possible.
•	 Once they have completed their screen captures, they should send a copy to you and attach the .mp4 file 

with their name on it. 

Phase 3: End of task
Learners should also send their video to a classmate. They then pair up to discuss each other’s videos and to 
give constructive feedback.

Task 35 of 47

Sub-strand 7: Electronic mail

Content standard: B6.6.7.1 Demonstrate the use 
of electronic mail.

Indicator: B6.6.7.1.4 Illustrate filing of email 
messages.

Performance indicator: 
ALL learners will be able to illustrate filing of email 
messages.

SOME learners will be able to illustrate filing of 
email messages.

FEW learners will be able to illustrate filing of 
email messages.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy
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Key words: inbox, sent box, sort, folders, label new folders, move emails

In this task: 
The teacher should speak about sorting emails in the inbox into appropriately labelled folders. Use the 
video screen capture showing how to create a new folder and then move emails from the inbox into the 
new folder.

Learners should open the inbox and sort their emails into suitably labelled folders. They do a screen 
capture showing how they managed to create new folders and then move the emails into those folders 
from the inbox.

Resources required� Learner’s Book page 111

Downloadable content
•	 Video_Filing emails.mp4

Phase 1: Start of task
Show learners how to file and sort emails from their inboxes into suitably labelled folders. Use Video_Filing 
emails.mp4.

Phase 2: Main
•	 Ask learners to open the inbox and sort their emails into suitably labelled folders. They should do a screen 

capture using the shortcut Windows key + G on the keyboard. This will enable them to do the screen 
capture and record voice, if possible, about how to file emails and sort them into appropriate folders.

•	 Once they have completed their screen captures, they should send a copy to you and attach the .mp4 file 
with their name on it. 

Phase 3: End of task
Learners should also send their video to a classmate. They then pair up to discuss each other’s videos and to 
give constructive feedback.

Task 36 of 47

Sub-strand 7: Electronic mail

Content standard: B6.6.7.1 Demonstrate the use 
of electronic mail.

Indicator: B6.6.7.1.5 Create address list.

Performance indicator: 
ALL learners will be able to create an address list.

SOME learners will be able to create an address 
list.

FEW learners will be able to create an address list.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: address list, inbox, sent box, sort, folders, label new folders, move emails
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In this task: 
The teacher should speak about creating an address list. Use the screen capture to demonstrate how to 
carry out the steps to create an address list.

Learners should open the inbox and create an address list with some of their classmates in it. They do 
a screen capture showing how they managed to create new folders and then move the emails into those 
folders from the inbox.

Resources required� Learner’s Book page 112

Downloadable content
•	 Video_Address list.mp4

Phase 1: Start of task
Show learners how to create an address list. Use Video_Address list.mp4.

Phase 2: Main
•	 Ask learners to create an email address list of some of their classmates and then to do a screen capture 

by using the shortcut Windows key + G on the keyboard. This will open into the window to do the screen 
capture and record voice, if possible.

•	 Once they have completed their screen captures, they should send a copy to you and attach the .mp4 file 
with their name on it. 

Phase 3: End of task
Learners should also send their video to a classmate. They then pair up to discuss each other’s videos and to 
give constructive feedback.

Task 37 of 47

Sub-strand 7: Electronic mail

Content standard: B6.6.7.1 Demonstrate the use 
of electronic mail.

Indicator: B6.6.7.1.6 Demonstrate attaching files 
to email messages.

Performance indicator: 
ALL learners will be able to demonstrate attaching 
some files to email messages.

SOME learners will be able to demonstrate 
attaching many files to email messages. 

FEW learners will be able to demonstrate 
attaching files to email messages.

Core competencies:
Creativity and innovation
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: attachments, address list, inbox, sent box, sort, folders, label new folders, move emails

In this task: 
The teacher should speak about attaching files to email messages. Use the screen capture to 
demonstrate how to carry out the steps of attaching files to email messages.

Learners should open the inbox and attach files to an email message. Do a screen capture showing how 
they managed to attach files to an email message.
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Resources required� Learner’s Book page 113

Downloadable content
•	 Worksheet Task 37_B6.6.7.1.6 Attach files.pdf

Phase 1: Start of task
Show learners the video about how to attach files.

Phase 2: Main
•	 Ask learners to attach files to an email message and then to do a screen capture using the shortcut 

Windows key + G on the keyboard. This will open into the window to do the screen capture and record 
voice, if possible.

•	 Once they have completed their screen captures, they should send a copy to you and attach the .mp4 file 
with their name on it. 

Phase 3: End of task
Learners should also send their video to a classmate. They then pair up to discuss each other’s videos and to 
give constructive feedback.

Task 38 of 47

Sub-strand 7: Electronic mail

Content standard: B6.6.7.1 Demonstrate the use 
of electronic mail.

Indicator: B6.6.7.1.7 Demonstrate some email 
tips.

Performance indicator: 
ALL learners will be able to demonstrate email tips.

SOME learners will be able to demonstrate some 
email tips. 

FEW learners will be able to demonstrate some 
email tips.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: attachments, address list, inbox, sent box, sort, folders, label new folders, move emails, 
netiquette

In this task: 
The teacher should work through the worksheet and refer to the Learner’s Book section on internet 
etiquette for more information about emailing tips.

Learners should attempt to do all the tasks on the worksheet.

Resources required� Learner’s Book pages 109–116

Downloadable content
•	 Worksheet Task 38_B6.6.7.1.7 Email etiquette tips.pdf

Phase 1: Start of task
Learners work in small groups to do Task 38.1 of Worksheet Task 38_B6.6.7.1.7 Email etiquette tips.pdf. 
You can have a plenary session to listen to all the tips. 
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Phase 2: Main
Ask learners to refer to the Learner’s Book section on internet etiquette and then work through all the tasks 
on Worksheet Task 38_B6.6.7.1.7 Email etiquette tips.pdf.

Phase 3: End of task
Ask learners to share any email etiquette rules that are not mentioned in the Learner’s Book. 

Answers to Task 38 worksheet
Answers will vary.

Sub-strand 8: Internet of Things (IoT)

Task 39 of 47

Sub-strand 8: Internet of Things (IoT)

Content standard: B6.6.8.1 Demonstrate the use 
of Internet of Things (IoT).

Indicator: B6.6.8.1.1 Describe the hardware used 
in the Internet of Things (IoT).

Performance indicator: 
ALL learners will be able to describe the hardware 
used in the Internet of Things.

SOME learners will be able to describe the 
hardware used in the Internet of Things.

FEW learners will be able to describe the hardware 
used in the Internet of Things.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: sensors, thermostat, remote controller, drone, robot, micro-processor, tracker, antenna

In this task: 
The teacher should assign various IoT scenarios to groups of learners for them to analyse all the 
hardware related to their scenario. 

Learners should work in groups to analyse the hardware related to the IoT scenario they are assigned. 
They should create posters for the classroom display boards.

Resources required� Learner’s Book pages 117

Downloadable content
•	 Worksheet Task 39_B6.6.8.1.1 Hardware used in the IoT.pdf

Phase 1: Start of task
Play the ‘Hot seat’ game using the key words. Select a learner to sit facing the other learners with their 
back to the board, where you write the key words for learners to describe what the word means or does; the 
learner in the hot seat has to guess what the word is. Repeat for all the key words.

Phase 2: Main
•	 Divide learners into small groups and assign a scenario to each group. Learners should create clearly 

labelled posters showing all the hardware used in their IoT scenario. Hardware must be clearly labelled.
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•	 Scenarios:
	- Driverless cars
	- Smart homes
	- Drones on farms
	- Robots milking cows 
	- Hydroponics 
	- Greenhouse farming
	- Food delivery 
	- Monitoring medical conditions in patients 
	- Robots in manufacturing

•	 Learners could refer to the websites given in the worksheet for their scenarios. They should take note of the 
evaluation criteria when creating their posters.

Phase 3: End of task
Learners evaluate all the posters, using the evaluation criteria in Worksheet Task 39_B6.6.8.1.1 Hardware 
used in the IoT.pdf.

Arrange learners into mixed ability groups so they can work through Activity 6.6 in the Learner’s Book.

Extension activity

Answers to Activity 6.5 Send and receive email� Learner's Book page 116

Learners practise sending, receiving and deleting email. 

Answers to Activity 6.6 The Internet of Things� Learner's Book page 120

Give learners time to watch the videos at least once, preferably twice. The video material would prove a 
good subject for a whole class discussion.

Task 40 of 47

Sub-strand 8: Internet of Things (IoT)

Content standard: B6.6.8.1 Demonstrate the use 
of Internet of Things (IoT).

Indicator: B6.6.8.1.2 Give more examples of IoT 
with a consumer part and an industrial/business 
segment.

Performance indicator: 
ALL learners will be able to give some examples 
of IoT with a consumer part and an industrial/
business segment.

SOME learners will be able to give more examples 
of IoT with a consumer part and an industrial/
business segment.

FEW learners will be able to give many examples 
of IoT with a consumer part and an industrial/
business segment.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy
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Key words: sensors, thermostat, remote controller, drone, robot, micro-processor, tracker, antenna

In this task: 
The teacher should continue to develop the ideas from the previous task to include more examples of IoT 
with a consumer part and an industrial/business segment. 

Learners should work in groups to continue to develop the ideas from the previous task to include more 
examples of IoT with a consumer part and an industrial/business segment.

Resources required� Learner’s Book pages 117–118

Downloadable content
•	 Worksheet Task 39_B6.6.8.1.1 Hardware used in the IoT.pdf 

Phase 1: Start of task
Continue from the previous task where learners were divided into small groups. They should now extend their 
work by developing their ideas from the previous task to include more examples of IoT with a consumer part 
and an industrial/business segment.

Phase 2: Main
Learners could refer to the ideas given in Worksheet Task 39_B6.6.8.1.1 Hardware used in the IoT.pdf for 
their scenarios and make summary notes to continue developing the ideas from the previous task to include 
more examples of IoT with a consumer part and an industrial/business segment. 

Phase 3: End of task
Learners should imagine a future scenario using some of the ideas developed in the Internet of Things.

Task 41 of 47

Sub-strand 8: Internet of Things (IoT)

Content standard: B6.6.8.1 Demonstrate the use 
of Internet of Things (IoT).

Indicator: B6.6.8.1.3 Mention five more terms and 
acronyms of IoT.

Performance indicator: 
ALL learners will be able to mention three more 
terms and acronyms of IoT.

SOME learners will be able to mention four more 
terms and acronyms of IoT.

FEW learners will be able to mention five more 
terms and acronyms of IoT.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: sensors, thermostat, remote controller, drone, robot, micro-processor, tracker, antenna

In this task: 
The teacher should allow each group to explore new terms and acronyms related to their scenario of IoT. 
They should create a rap song of at least ten lines using all their new terms and acronyms.

Learners should work in groups to create a rap song of at least ten lines using all their new terms and 
acronyms related to their group’s scenario.
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Resources required� Learner’s Book page 119

Downloadable content
•	 Worksheet Task 39_B6.6.8.1.1 Hardware used in the IoT.pdf

Phase 1: Start of task
Allow learners to work in their groups assigned in the two previous tasks and explain that they need to create 
a rap song of at least ten lines using all their new terms and acronyms.

Phase 2: Main
The rap song must:
•	 have at least ten lines
•	 explain the meanings of each term or acronym
•	 be fun
•	 include all group members. 

Phase 3: End of task
Groups present their rap song to the class and they vote for the best rap song. The class must give reasons for 
their selection.

Sub-strand 9: Digital literacy

Task 42 of 47

Sub-strand 9: Digital literacy

Content standard: B6.6.9.1 Demonstrate 
proficiency in digital literacy.

Indicator: B6.6.9.1.1 Demonstrate how to handle 
private and personal information.

Performance indicator: 
ALL learners will be able to demonstrate how to 
handle private information.

SOME learners will be able to demonstrate how to 
handle personal information.

FEW learners will be able to demonstrate how to 
handle private and personal information.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: private information, personal information

In this task: 
The teacher should refer learners to the Learner’s Book to summarise the points on how to handle 
private and personal information. 

Learners should work in pairs and carry out the tasks as given by the teacher in Phases 1, 2 and 3 of 
this task. They could refer to the section in their Learner’s Book on how to handle personal and private 
information.
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Resources required� Learner’s Book pages 121–122

Phase 1: Start of task
Ask learners to write ten pieces of information about themselves, such as address, names, contact details, 
medical history, financial status, hobbies, family information, etc. and then categorise the information into 
two groups: Personal and Private.

Phase 2: Main
Learners work in pairs and do the following:
•	 Compare their lists and discuss why they placed certain pieces of information in each category.
•	 Decide on which category they should place information that they had categorised differently.
•	 Suggest reasons why:

a)	 some types of information should not be made public, giving examples
b)	 some types of information should only be private, giving examples.

Phase 3: End of task
Learners complete these statements: 
•	 A reasonably good definition of personal information is …
•	 A reasonably good definition of private information is …

Refer learners to Activity 6.7 and ask them to work in pairs for peer-reviewing and more detailed 
discussions on the topic.

Extension activity

Answers to Activity 6.7 Personal data� Learner's Book page 121

Ask learners how many words they found and allow others to help those who found fewer words.
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Task 43 of 47

Sub-strand 9: Digital literacy

Content standard: B6.6.9.1 Demonstrate 
proficiency in digital literacy.

Indicator: B6.6.9.1.2 Devise various techniques on 
how to protect oneself from online identity theft.

Performance indicator: 
ALL learners will be able to devise a technique to 
protect themselves from online identity theft.

SOME learners will be able to devise some 
techniques to protect themselves from online 
identity theft.

FEW learners will be able to devise various 
techniques to protect themselves from online 
identity theft.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: private information, personal information

In this task: 
The teacher should present the advice given in the posters found in the downloadable content and 
ask learners to create an advice leaflet for learners in Basic 5 on how to protect themselves from online 
identity theft.

Learners should create an advice leaflet for learners in the level below them on how to protect 
themselves from online identity theft.

Resources required� Learner’s Book pages 122–123

Downloadable content
•	 Poster_10 Facts about identity theft.pdf
•	 Poster_Safety from identity theft.pdf

Phase 1: Start of task
Show learners the posters which are available for download from Cambridge GO to use as inspiration and for 
ideas about what to place in their advice leaflets.

Phase 2: Main
•	 Learners work in pairs to create an advice leaflet for learners in Basic 5 on how to protect themselves from 

online identity theft.
•	 Give them the evaluation criteria before they begin the task. 

Evaluation criteria: Advice leaflet

Evaluation criteria Achieved Still needs to be done

Content is accurate and correct

Two columns on the page
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Clear title

Uses some images, pictures, drawings or sketches

Clear explanations 

Overall quality (smiley face)

Phase 3: End of task
Let learners complete the sentence: The most important thing to keep safe from online identity theft is …

Task 44 of 47

Sub-strand 9: Digital literacy

Content standard: B6.6.9.1 Demonstrate 
proficiency in digital literacy.

Indicator: B6.6.9.1.3 Differentiate between spam and 
solicited messages.

Performance indicator: 
ALL learners will be able to differentiate 
between spam and solicited messages.

SOME learners will be able to differentiate 
between spam and solicited messages.

FEW learners will be able to differentiate 
between spam and solicited messages.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: spam, solicited messages, unsolicited messages

In this task: 
The teacher should discuss with the class the differences between spam, solicited messages and 
unsolicited messages. The class should then debate if all spam and unsolicited messages are bad or not.

Learners should participate in a debate on whether all spam and unsolicited messages are bad or not. 

Resources required� Learner’s Book pages 123–124

Phase 1: Start of task
As a class, discuss the meanings of what spam is, what solicited messages are and also what unsolicited 
messages are.

Phase 2: Main
Divide the class into two groups for a debate on this topic: All spam and unsolicited messages are bad. They 
should either AGREE or DISAGREE with the statement.

Phase 3: End of task
Learners completed these sentences:
1.	 A reasonably good definition of spam is …
2.	 A reasonably good definition of a solicited message is …
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Task 45 of 47

Sub-strand 9: Digital literacy

Content standard: B6.6.9.1 Demonstrate 
proficiency in digital literacy.

Indicator: B6.6.9.1.4 Differentiate between virtual 
friends and real friends.

Performance indicator: 
ALL learners will be able to differentiate between 
virtual friends and real friends.

SOME learners will be able to differentiate 
between virtual friends and real friends.

FEW learners will be able to differentiate between 
virtual friends and real friends.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: virtual friends, real friends

In this task: 
The teacher should explore the notion of virtual friends versus real friends in the form of a discussion and 
drawing up a list that differentiates the two.

Learners should participate in the discussion and then compile a list of virtual and real friends.

Resources required� Learner’s Book pages 124

Phase 1: Start of task
Ask learners to compile a list of all their friends and family, both online and those they have met and/or 
known all their lives. There should be at least 10 to 15 names. 

Phase 2: Main
•	 Let learners work in pairs. They should discuss whether they have actually met each person or whether 

they only know of them. Learners then place the names into these two categories, according to whether 
they have met them in person or not (i.e. they only know them from TV, online games, or from what others 
have said about them).

Met in person Not met in person

•	 They then draw up another list and place the names from their initial list in these categories. 

Those I can trust Those I cannot trust

•	 They then compare the lists they complied in questions 1 and 2. Are there any differences?

Phase 3: End of task
Learners completed these sentences:
1.	 A reasonably good definition of a virtual friend is …
2.	 A reasonably good definition of a real friend is …
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Sub-strand 10: Internet etiquette

Task 46 of 47

Sub-stand 10: Internet etiquette

Content standard: B6.6.10.1 Demonstrate the 
application of internet etiquette.

Indicator: B6.6.10.1.1 Explain internet etiquette 
and how to deal with it.

Performance indicator: 
ALL learners will be able to explain internet 
etiquette and how to deal with it

SOME learners will be able to explain internet 
etiquette and how to deal with it

FEW learners will be able to explain internet 
etiquette and how to deal with it

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: internet etiquette, netiquette

In this task: 
The teacher should refer learners to the Learner’s Book section on internet etiquette and allow them to 
make summary notes.

Learners should make summary notes on internet etiquette.

Resources required� Learner’s Book pages 125–126

Phase 1: Start of task
Allow learners to watch one of these short videos first.
•	 https://www.youtube.com/watch?v=-tiUDjn7-as
•	 https://www.youtube.com/watch?v=b9GmCoMGYlE

Phase 2: Main
Learners should make summary notes from the Learner’s Book section on internet etiquette on page 125.

Phase 3: End of task
Ask learners to complete the sentence below:
The most important thing I learnt about internet etiquette today is . . .

Task 47 of 47

Sub-stand 10: Internet etiquette

Content standard: B6.6.10.1 Demonstrate the 
application of internet etiquette.

Indicator: B6.6.10.1.1 Investigate the responsible 
use of computers.
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Performance indicator: 
ALL learners will be able to investigate the 
responsible use of computers, e.g. information 
privacy.

SOME learners will be able to investigate the 
responsible use of computers, e.g. information 
privacy, copyright, etc.

FEW learners will be able to investigate the 
responsible use of computers, e.g. information 
privacy, copyright, hardware, software and 
information theft, etc.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: internet etiquette, netiquette, copyright, information theft, information privacy

In this task: 
The teacher should refer learners to the section in the Learner’s Book on the responsible use of 
computers, e.g. information privacy, copyright, hardware, software information theft, etc.

Learners should make summary notes that investigate the responsible use of computers, e.g. 
information privacy, copyright, hardware, software information theft, etc.
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Resources required� Learner’s Book page 126

Phase 1: Start of task
Allow learners to watch one of these short videos first.
•	 Copyright: https://www.youtube.com/watch?v=qp_IWVZoZhQ
•	 Information privacy: https://www.youtube.com/watch?v=ZNEPaGFApX4

Phase 2: Main
Learners should make summary notes from the section on responsible use of computers in the Learner’s Book 
on pages 126–127, e.g. information privacy, copyright, hardware, software and information theft, etc.

Phase 3: End of task
Ask learners to complete the sentence below:
The most important thing I learnt about the responsible use of computers related to information privacy, 
copyright, hardware, software, and information theft, etc. today is …
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1.	 A protocol is a set of rules about the way that something has to be done.
2.	 It is the main part of an internet address that identifies the website.
3.	 Answers will vary.
4.	 It is a device that that allows one computer to send information to another over telephone wires.
5.	 a)	 IoT: Internet of Things

b)	 IIoT Industrial Internet of Things
c)	 MIoT Mobile IoT 

6.	 It is regarded as rude and shouting.

Check your progress
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Introduction
In this strand, learners can expect to identify some major health hazards associated with the use of ICT 
tools and how to maintain the correct sitting posture. The topic of health and safety when using ICT is 
highly relevant in today’s world. 

Sub-strand 1: Health and safety in using ICT tools

Task 1 of 2

Sub-strand 1: Health and safety in using ICT tools

Content standard: B6.7.1.1 Demonstrate the 
application of health and safety measures in using 
ICT tools.

Indicator: B6.7.1.1.1 Identify five major health 
hazards associated with using ICT tools.

Performance indicator: 
ALL learners will be able to identify a few health 
hazards associated with using ICT tools.

SOME learners will be able to identify most health 
hazards associated with using ICT tools.

FEW learners will be able identify the major health 
hazards associated with using ICT tools.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: repetitive strain injury (RSI), eye strain, back problems, circulation problems

In this task: 
The teacher should start with a quick quiz about health and safety when using ICT Tools. Create a role 
play where learners should pose on their chairs and pretend they are sitting on a sofa or couch, relaxing 
reading a book or sitting in an office or at a dinner table or in a car. Let other learners describe the 
differences in the postures of each role play. Let learners answer the questions on the worksheet.

Learners should complete Worksheet Task 1_B6.7.1.1.1 Major health hazards in using ICT tools.pdf.

Resources required� Learner’s Book pages 131–132

Downloadable content
•	 Worksheet Task 1_B6.7.1.1.1 Major health hazards in using ICT tools.pdf

Phase 1: Start of task
Give learners this quick quiz:
1.	 If you had to work for eight hours a day inputting data into a computer, how many miles would your 

fingers be travelling? (Answer: 8 miles or almost 13 kilometres)
2.	 TRUE or FALSE: A computer screen should be kept at least 30–32 inches (approximately 75–80 

centimetres) away from your eyes for safety. (Answer: FALSE)
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3.	 Is a cheap computer a health hazard? (Answer: No, not if it works properly.)

Phase 2: Main
•	 Ask different learners to come to the front of the class and role play one of the following poses. The other 

learners must describe the differences in the postures of each role play. 
•	 Learners role play that they are sitting: 

	- on a sofa or couch relaxing reading a book 
	- in an office at a desk
	- at a dinner table 
	- in a car as a passenger
	- in a car as the driver. 

•	 Let learners answer the questions on Worksheet Task 1_B6.7.1.1.1 Major health hazards in using ICT 
tools.pdf. Learners should refer to the relevant Learner’s Book section on health and safety to complete 
the worksheet.

Phase 3: End of task
Ask learners to swap their answers and then go over the correct answers with the whole class for peer-
assessment.

Arrange learners into small groups of mixed ability to attempt Activity 7.1 in the Learner’s Book.

Extension activity

Answers to Task 1 worksheet
Task 1.1 
1.	 back and neck strain
2.	 eye irritation
3.	 wrist pain
4.	 eye fatigue
5.	 eye strain 

Task 1.2 
•	 Eye strain is when you struggle to read your screen because the background light or reflections make it 

difficult for your eyes to see the output on your screen.
•	 Eye irritation is when your eyes become scratchy and sore from the extreme brightness or the glare from 

your screen.
•	 Eye fatigue is when you develop red eyes from straining your eyes too much by spending too long in front 

of a computer monitor or screen.

Task 1.3
•	 Eye strain can be prevented by using proper background lighting and ensuring that there are no 

reflections causing you to strain your eyes.
•	 Eye irritation can be prevented by adjusting the brightness to suit the different times of the day and by 

using an anti-glare screen.
•	 Eye fatigue can be prevented by looking away from the monitor on a regular basis to give your eyes a 

break.

Task 1.4
•	 Backache from sitting on chairs that are uncomfortable and/or the wrong height 
•	 Repetitive strain injury from repeating keyboard actions for long periods of time
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•	 Eye problems
•	 Circulation problems from sitting too long in the same position

Answers to Activity 7.1 Discuss health risks� Learner's Book page 133

1.	 Any two from: backache / neck ache / sleep disorders / eye problems 
2.	 a)	 mouse

b)	 keyboard

Task 2 of 2

Sub-strand 1: Health and safety in using ICT tools

Content standard: B6.7.1.1 Demonstrate the 
application of health and safety measures in using 
ICT tools.

Indicator: B6.7.1.1.2 Demonstrate solutions for 
the health related problems in ICT.

Performance indicator: 
ALL learners will be able to identify a few solutions 
to health hazards associated with using ICT tools.

SOME learners will be able to identify most solutions 
to health hazards associated with using ICT tools. 

FEW learners will be able identify the solutions to 
major health hazards associated with using ICT 
tools, including proper sitting posture.

Core competencies:
1.	 Creativity and innovation
2.	 Communication and collaboration
3.	 Cultural identity and global citizenship
4.	 Personal development and leadership
5.	 Digital literacy

Key words: repetitive strain injury (RSI), eye strain, back problems, circulation problems

In this task: 
The teacher should use the video link and refer learners to the relevant section in the Learner’s Book on 
health and safety in ICT. 

Learners should complete Worksheet Task 2_Solutions for health Issues in ICT.pdf

Resources required� Learner’s Book pages 133–135

Downloadable content
•	 Worksheet Task 2_B6.7.1.1.2 Solutions for health issues in ICT.pdf

Phase 1: Start of task
Play the ‘Hot seat’ game using the key words. Select a learner to sit facing the other learners with their back 
to the board, where you write the key words for learners to describe what the word means or does and the 
learner in the Hot seat has to guess what the word is. Repeat for all the key words.

Phase 2: Main
•	 Allow learners to watch this short video on health and safety.  

https://www.youtube.com/watch?v=T8qGO7XQ0Uw
•	 Then let learners complete Worksheet Task 2_B6.7.1.1.2 Solutions for health issues in ICT.pdf.
•	 Learners should refer to the relevant Learner’s Book section on health and safety to complete the worksheet 
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Phase 3: End of task
Ask learners to swap their answers and then go over the correct answers with the whole class for peer-
assessment.

Arrange learners into small groups of mixed ability to attempt activities 7.2, 7.3 and 7.4 in the Learner’s 
Book.

Extension activity

Answers to Task 2 worksheet
Task 2.1
Sitting in a relaxed position requires unsupported structures, such as a couch or sofa. Sitting in a formal 
setting, such as at a dinner table or in school or a working environment requires a supportive structure, such 
as a chair that is adjustable in height or position.

Task 2.3
An adjustable chair will allow you to raise or lower the chair so that your eyes are in line with the top line of 
your monitor. This will ensure that you do not suffer from neck or back pain.

Answers to Activity 7.2 Discuss RSI and eye problems� Learner's Book page 134

1.	 Any 2 from: take regular breaks / use a mouse pad with a wrist rest / use an ergonomic keyboard / 
use an ergonomic mouse / sit with correct posture / arrange workspace ergonomically.

2.	 a)	 Eye strain caused by too much background light, or reflections on the screen that make it 
difficult to read the screen.

b)	 Eye irritation caused by having the screen brightness turned up too high. Glare could also come 
from the desk, depending on what it is made from.

c)	 Eye fatigue caused by spending much time in front of a computer screen without a rest.

Answers to Activity 7.3 Visit a relevant website� Learner's Book page 135

Learners should do this revision exercise by listening to videos on computing health and safety.

Answers to Activity 7.4 Safety in the computer room� Learner's Book page 136

The posters created will vary a lot. They should be relevant to 10–14-year olds and have at least one 
aspect of health and safety in the computer room covered correctly.
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1.	 Repetitive strain injury
2.	 Ergonomics is about arranging the things that people use so that they can carry out their work 

and daily life efficiently and safely. The term applies to the positioning of a computer workstation 
and the design of the equipment used. 

3.	 Keyboard, mouse, chair 

Check your progress
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Computing

 Computing is an exciting, learner-centred 
course specifically developed in accordance with 
the new Standards-based curriculum by the National 
Council for Curriculum and Assessment (NaCCA). The 
course provides a solid foundation for the development 
of Computing skills in everyday life. This prepares 
learners to be active and successful citizens in the 
workplace, once they leave school.

 Computing Primary provides a broad 
perspective on the necessary knowledge and practical 
skills related to using a variety of technologies in 
everyday life. The book guides development in areas 
such as Information Communication Skills (ICT) 
literacy, effective communication using digital tools, 
internet usage, ethical use of ICT tools and basic 
programming and database skills. 

Avai lable 
digi ta l ly !

Each Learner’s Book 
comes with a FREE 
digital edition of the 
book. The code for the 
digital edition appears on 
the inside front cover of 
the book and provides 
access for one year.

 

Important features of  Computing Primary 6 
Learner’s Book:
•	 Careful development of theoretical and practical 

activities in the use of a computer for 
	 -	 presentation
	 -	 word processing
•	 Clear screenshots and step-by-step instructions on 

how to complete computing tasks 
•	 Complete coverage of the core curriculum 

competencies such as problem-solving, innovation, 
collaboration, global citizenship, personal 
development and digital literacy

•	 Plenty of activities so that learners can apply the 
skills they have acquired

•	 Regular assessments, with marks, that can be done 
on a weekly, fortnightly or monthly basis.

Features of  Computing Primary 6 
Teacher’s Guide:
•	 Clear teaching guidelines, including planning notes, 

for all the content in the curriculum
•	 Downloadable content with all the files needed for 

learners to complete the activities available from 
Cambridge GO at https://www.cambridge.org/go/, 
plus

	 -	 additional PowerPoint files introducing topics 
	 -	 printable worksheets for enrichment activities 
•	 Memoranda for activities that can be used  

for continuous assessment during the year
•	 Extension activities to challenge learners who have 

quickly grasped the skills taught in each topic
•	 Guidance for teachers in low-resourced schools.

, your guarantee of success!
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